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Introduction 
 

This library contains Release Notes for Simphony 1.6 and 1.6 maintenance releases. These 
Release Notes are PDF versions of articles originally published on the MICROS 
Members or Wiki pages. They reflect the MICROS branding associated to the product 
for that release. PDF renderings may cause some distortion in the content. 



Simphony Version 1.6
General Release

Simphony 1.6 MR 1
Simphony 1.6 MR 2
Simphony 1.6 MR 4
Simphony 1.6 MR 5
Simphony 1.6 MR 6
Simphony 1.6 MR 7

Simphony 1.6 Maintenance Release 10

Copyright Information 

This article is a quick reference guide to features, enhancements, and revisions for Simphony 1.6 Maintenance 

Release 10. 

Contents

◾ 1 Copyright Information
◾ 2 Prerequisite Knowledge
◾ 3 Document Overview 

◾ 3.1 Terminology
◾ 4 Obtaining/Installing the Software
◾ 5 New Features
◾ 6 Enhancements
◾ 7 Revisions
◾ 8 See also

Prerequisite Knowledge 

This document assumes the reader has the following knowledge or expertise: 

◾ Understanding of basic network concepts 
◾ Experience with Microsoft Windows platforms and terminology 
◾ Familiarity with this product line and its hardware, software, and peripherals 

Document Overview 

For the printable collection for this version, see 1.6 Collection

This document includes the following sections: 

What's New
This section describes new features in this software release. A new 
feature is one that provides capabilities that were not available in 
previous versions. 

What's Enhanced
This section describes enhancements in this software release. An 
enhancement is a change made to improve or extend an existing 
feature, under the following criteria: 
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Simphony 1.6 MR 8
Simphony 1.6 MR 9

Simphony 1.6 MR 10

Previous Version Next Version 
Simphony 1.5 Simphony 2.6 

◾ The basic feature or functionality already exists in the 
previous release. 

◾ The change adds to or expands on the current process — it 
does not replace it. This differs from a revision that corrects a 
problem. 

What's Revised
This section describes issues that have been corrected. A revision is a correction made to an existing form, 
feature, or function, using the following criteria: 

◾ The item must be part of the previous version. 
◾ The change must replace the current item or remove it from the application. 

Terminology 

◾ A Fix ID is an internal tracking number used by R&D. This ID is primarily used by R&D personnel; it is 
helpful for mapping fixes to documented items. 

◾ A CR# is a "Change Request ID" that is generated during the escalations process. When a case is started at 
the Support Center and the issue is determined to be an application defect, a Change Request is created, 
informing R&D that an issue needs to be fixed. 

New Features 

There are no new features in this version.

Enhancements 

Fix ID Enhancement CR #

mymicros.net

75511 Upgrades to mymicros.net v8.4.1 are supported on Simphony v1.6 MR10

Validation for upgrading the v1.6 mymicros.net database to v8.4.1 has been 
completed. Simphony v1.6 MR10’s default mymicros.net version is v8.4.1. 
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Revisions 

There are no revisions in this version.
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Simphony Version 1.6
General Release

Simphony 1.6 MR 1
Simphony 1.6 MR 2
Simphony 1.6 MR 4
Simphony 1.6 MR 5
Simphony 1.6 MR 6
Simphony 1.6 MR 7
Simphony 1.6 MR 8
Simphony 1.6 MR 9
Simphony 1.6 MR 10

Previous Version Next Version 
Simphony 1.5 Simphony 2.6 

Simphony 1.6 Maintenance Release 9

This article is a quick reference guide to features, enhancements, and revisions for Simphony 1.6 Maintenance Release 9. 

Contents

◾ 1 Prerequisite Knowledge
◾ 2 Document Overview 

◾ 2.1 Terminology
◾ 3 Obtaining/Installing the Software
◾ 4 New Features
◾ 5 Enhancements
◾ 6 Revisions
◾ 7 See also

Prerequisite Knowledge 

This document assumes the reader has the following knowledge or expertise: 

◾ Understanding of basic network concepts 
◾ Experience with Microsoft Windows platforms and terminology 
◾ Familiarity with this product line and its hardware, software, and peripherals 

Document Overview 

For the printable collection for this version, see 1.6 Collection

This document includes the following sections: 

What's New
This section describes new features in this software release. A new feature is one that provides capabilities 
that were not available in previous versions. 

What's Enhanced
This section describes enhancements in this software release. An enhancement is a change made to improve or 
extend an existing feature, under the following criteria: 

◾ The basic feature or functionality already exists in the previous release. 
◾ The change adds to or expands on the current process — it does not replace it. This differs from a 

revision that corrects a problem. 

What's Revised
This section describes issues that have been corrected. A revision is a correction made to an existing form, 
feature, or function, using the following criteria: 

◾ The item must be part of the previous version. 
◾ The change must replace the current item or remove it from the application. 

Terminology 

◾ A Fix ID is an internal tracking number used by R&D. This ID is primarily used by R&D personnel; it is helpful for mapping fixes to documented 
items. 

◾ A CR# is a "Change Request ID" that is generated during the escalations process. When a case is started at the Support Center and the issue is 
determined to be an application defect, a Change Request is created, informing R&D that an issue needs to be fixed. 

Obtaining/Installing the Software 

The installation file is named Simphony_1.6_MR9.iso; it can be downloaded from 
http://downloads.micros.com/micros/simphony/Simphony_1.6_MR9.iso 
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New Features 

Fix ID Feature CR #

Peripherals

69014 The mTablet E Series 8” workstation supports the VeriFone e231 Sleeve that includes a Barcode scanner and 
Magnetic Card Reader

mTablet E Series workstations shipped by MICROS have the Microsoft Windows 8.1 Embedded Industry 
Standard Operating System installed, including the required OPOS Drivers to utilize the VeriFone Sleeve. 
Tablets running Microsoft Windows 8.1 Standard Edition will need to manually install the OPOS drivers that 
are available from the MICROS Hardware Group. 

See the 1.x mTablet E Series article for more information 

73571 Support for the MagTek uDynamo Audio Jack Mag Stripe Reader (MSR) has been introduced

Support for the MagTek uDynamo Audio Jack MSR has been added for the mTablet E Series workstations. To 
configure this MSR, follow the steps outlined below: 

1. Navigate to the EMC-> Workstations module-> Select the mTablet E Series workstation record-> Devices
tab-> Peripheral Device Configuration section.

2. Click the Add link. From the 'Add Device' window’s Select Peripheral Device Type field, select Audio Jack
Mag Stripe Reader.

3. Click OK.
4. Save all changes.

Once configured, whenever Ops or the mTablet E Series workstations are started, users will receive the following 
prompt: 

The MagTek uDynamo Audio Mag Stripe Reader (MSR) can be temporarily disabled using the EMC-> Page Design 
module-> Non-Sales Operations-> [910 - Toggle MagTek uDynamo Audio Mag Stripe Reader] function key. 
When pressed, the key toggles the MSR between ENABLE and DISABLE modes allowing the operators to eject the 
MSR without emitting a loud tone noise. 

See the 1.x mTablet E Series article for more information 

Workstation Clients

50681 Simphony 1.6 MR9 now supports the mWorkstation. This workstation runs the Windows 8.1 operating system

Additionally, the following limitations and requirements exist: 

◾ The feature that detects when the cash drawer cables are swapped does not function. This issue is only a 
concern in environments where 2 drawers are used on a single workstation. 

◾ Prior to deploying a CAL Package to the mWorkstation, the Internet Information Services (IIS) must be 
manually installed and enabled on the device. Failure to follow this step will result in a silent CAL failure 
and the Simphony client will not install correctly. 

◾ Modify the power saving settings on the mWorkstation to prevent suspend or hibernation modes. These modes 
will cause issues with communications, and check sharing operations. The hardware may hang when you try to 
resume from either of these states, and you may need to perform a full reboot to resume operations. 

See the Workstation Comparison Chart article for more information. 

54757, 
58766, 
58724 

Simphony 1.6 MR9 now supports the mTablet E Series workstation

MICROS introduces its latest Point-of-Sale workstations. They are: 
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◾ mTablet E Series 8 inch 
◾ mTablet E Series 11 inch 

These workstations are supported as Ops clients and are shipped by MICROS with the Microsoft Windows 8.1 
Embedded Industry Standard Operating System. If tablets are acquired running Microsoft Windows 8.1 Standard 
Edition, they’ll run Ops, but some peripheral devices will need to have OPOS Drivers installed manually. 

The mTablet E Series 8" workstation is compatible with a VeriFone e231 Sleeve that includes a Barcode scanner and 
Magnetic Card Reader. 

Both workstations are compatible with the 'Mag Tek uDynamo Audio Jack Reader' for reading Magnetic Cards. 
See the MICROS Hardware Group SharePoint for mTablet E Series accessory and specification documentation. 
Login credentials are required to access the web site. 

See the 1.x mTablet E Series article for more information 

Enhancements 

Fix ID Enhancement CR #

CAL

60351 CAL v128A has been added to the Simphony installation package to standardize the supported version of CAL 
for all clients; including those running Microsoft Windows 8.1 (32-bit)

With this release, the installation of the Simphony software includes the installation of CAL v128A for all 
device CAL Packages. This includes the mTablet E Series Workstations that run Microsoft Windows 8.1 (32-
bit). 

SIM

73912 SIM System Variable DTL_IS_COND has been added to identify if rung up Menu Items (MI) are condiments

SIM System Variable DTL_IS_COND has been added to allow users to configure Interface Scripting 
Language (ISL) scripts to determine if a Guest Check MI is a condiment or regular MI. When the script is 
executed, users receive a message prompt on the Ops client indicating that a rung up item is a condiment or 
regular MI. The new System Variable and their Field/Parameter description is listed in the table shown below: 

Variable Name and 
Syntax Field/Parameter

@DTL_IS_COND[i] Determines if a Guest Check Menu Item is a 
Condiment 

See the updated Simphony SIM Manual for more information. To download this manual, click here 
(http://downloads.micros.com/micros/simphony/Wiki/Docs/WhitePapers/Simphony_SIM_Manual.pdf) . 

Revisions 

Fix 
ID Revision CR #

CAL

59861 Issue: Certain commands in the setup.dat file for mStation E-Series tablets running Windows 8.1 Pro caused the CAL package 
installation to fail 

Resolution: CAL Package installation on mTablet E-Series workstations running the Windows 8.1 Pro operating system now proceeds 
without failing. The Setup.dat file for mStation E Series tablets running Windows 8.1 Pro has been modified to 
accommodate Windows 8.1 Pro. 

Credit Card Batch Process

68187 Issue: Interrupted credit card settlements left the batch stuck in ‘Batch Transferring’ status 35452 

Resolution: A batch that fails to transfer because of an interruption is now marked with a ‘Batch Transfer Failed’ status so that it can be 
settled later. Previously, if a settlement was interrupted, the batch status remained at ‘Batch Transferring’ and all subsequent 
attempts to settle failed. 

Files modified: ECCServer.dll 
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Credit Card Driver

64746 Issue: When a credit card was processed through the Property Management System (PMS), the unmasked card number was posted 
to the EGateway log 

Resolution: Processing a credit card through a PMS no longer posts the unmasked credit card number to the EGateway log. 

Files modified: TIFPmsComms.dll, TIFPmsComms64.dll 

DB Download

24143 Issue: The EGateway transferred all Print Logos for the entire Enterprise to each Workstation client causing DB Download to fail 

Resolution: The EGateway now only transfers Print Logos to the assigned Workstation client in a Revenue Center (RVC). 

Files modified: EMC.exe, EMCHandler.dll, DbDownloadHandler.dll 

Direct Posting Service

36794 Issue: Sales and tips from a Team Service Check were posted only to the check owner in the mymicros.net Employee Tip Report 34506 

Resolution: The mymicros.net Employee Tip Report now equally divides sales and tips from a Team Service Check between the team 
member assigned to the check at the time of its closing. 

Files modified: SarOpsWin32.exe, EGatewayHandlers.dll 

EMC

55110 Issue: Context Sensitive Help (CSH) for the Override Property Start of Day Times section-> [Enable Override] option included 
incorrect information 

Resolution: The CSH for the [Enable Override] option now reads as follows: 

Enable this box to allow this Revenue Center to have its Start of Day run at different times than the times set for the 
property. This option is normally not enabled unless a site has a specific need in a specific Revenue Center (such as a 
shift change) to have different Start of Day times.

Previously, the CSH incorrectly mentioned that “Note that if this field is used, the Start of Day times should be set to times 
prior to the property's Start of Day times.” 

Files modified: EMCText.xml 

55136 Issue: Key Manager module [Change Transmission Key] function did not include a Context Sensitive Help (CSH) 

Resolution: The CSH for the [Change Transmission Key] now reads as follows: 

A transmission key is used for encryption of traffic between a workstation and the data center. When the transmission 
key is rotated, the data center generates a new key; when a client communicates with the data center, it is given a new 
key for all subsequent communications to be encrypted.

Files modified: EMCText.xml 

62993 Issue: RVC Descriptors -> Guest Information Names did not have Context Sensitive Help (CSH) text 

Resolution: The following CSH text has been added to the Guest Information Lines: 

◾ Guest Information Names

Guest Information Names is the optional group of category prompts that will appear on a workstation during the 
creation of a Party Check or when the Enter Guest Info key is used. If a field is not populated, the workstation will not 
prompt for that information.

◾ ID

Enter the text for the Guest Check ID prompt that will appear on the workstation. Enter up to 16 alphanumeric 
characters.

◾ First Name

Enter the text for the First Name prompt that will appear on the workstation.. Enter up to 8 alphanumeric characters.

◾ Last Name

Enter the text for the Last Name prompt that will appear on the workstation. Enter up to 16 alphanumeric characters

◾ Address 1-3
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Enter the text for the Address prompts that will appear on the workstation. Enter up to 44 alphanumeric characters 
per line.

◾ Phone Number

Enter the text for the Phone Number prompt that will appear on the workstation. Enter up to 16 alphanumeric 
characters.

◾ User Defined 1-3

Enter the text for the User Defined prompts that will appear on the workstation (comments, special instructions, etc.). 
Enter up to 44 alphanumeric characters per line.

Additionally, the CSH text for the following have been updated, 

◾ [Authorize/Add Guest Information to Check]

Enable this option to allow employees with this Role to enter/edit guest information, and authorize non-privileged 
employees to do so as well, when creating a Party Check or using the Enter Guest Info key.

◾ [Enter Guest Info]

This key is used by authorized employees to add/edit the Guest Info lines of a Party Check or Guest Check after the 
check has been started.

Files modified: EMCText.xml 

63303 Issue: Simphony allowed special characters in workstation names 

Resolution: Simphony no longer allows using special characters in Workstation names. Previously, CAL failed to change the 
workstation’s Computer Name in Windows to match that of EMC because Windows restricts the use of special characters in 
the Computer Name. 

Files modified: EMC.exe, EMCText.dll 

64170 Issue: Dynamic Order Mode (DOM) related options in the Order Devices module did not have Context Sensitive Help (CSH) texts 

Resolution: The CSH text for DOM related options now read as follows: 

◾ [9 - Display Subtotal]

Select this option to display the subtotal on the KDS. Once the check is paid in full, the word “Subtotal” changes to 
“Paid” and the screen colors reverse.

◾ [10 - Do Not Display Voids]

Select this option to delete any voided items or orders from the KDS. Voids will not display on the KDS station. If this 
option is disabled, the voided items show on the KDS in red with a red “V” on the right.

◾ [11 - Display Menu Item Count]

Select this option to display a menu item count in an order on the KDS. The menu item count displays after the 
suborder on the KDS, or at the bottom of a requisition chit on a local or remote printer. This option works in 
conjunction with the Availability/Out of Menu Items option Check Menu Item Availability and the Count Available 
number in Menu Item Maintenance.

◾ [12 - No Expo Done Before Paid]

Select this option to prevent the Expo station user from bumping an order before it is paid on the POS station. An 
order must first be paid before marking it as done and bumping it. If this option is enabled, the error message “Order 
has not been paid” displays and the order cannot be bumped until it is paid.

Files modified: EMCText.xml 

66031 Issue: Context Sensitive Help (CSH) text for RVC Parameters option [18 - ON = Use 5-digit Table #; OFF = Use 4-digit 
Character Table ID] has been updated to include the Table File records limitation 

Resolution: The CSH text now reads as follows: 

This option bit controls what should be entered when a user is prompted for Table Number on the workstation. Select 
this option to use the 5-character table numbers programmed in the Tables module. Disable this option to use the 
4-character Table ID entered in the Table Module. This option must be disabled when International LDS is used. 
When 5-digit table numbers are used, the programmer must limit the record numbers in the Table File to the range 1 - 
99,999.
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Files modified: EMCText.xml 

68032 Issue: Enterprise level Employee Maintenance module crashed when users with Property-Level Security attempted to search for 
employees 

35449 

Resolution: Users with Property-Level Security can now search for employees from the Enterprise level Employee Maintenance module 
without an error. 

Files modified: EMCData.dll, EMCClient.dll 

68726 Issue: Property Parameters option [35 - Extended Event Data] did not have a Context Sensitive Help (CSH) text defined 

Resolution: The following CSH text has been added for option [35 - Extended Event Data] in the EMC: 

When the Property Parameters option, [35 - Extended Data] is enabled, extra data is sent from the client to the VSS 
Host. This option controls the format of the data that are sent with different VSS Event Types. Some general 
information included when this option is enabled: a.)The first name is added to the Clock In/Out event. b.) The final 
tender event will display information about auto discounts, change due, tax due and total due. c.) A check is always 
identified by check number regardless of how the check was started. d.) When an employee clocks in to one Revenue 
Center on a Workstation in a different Revenue Center, the Revenue Center the employee is clocking into is sent to the 
VSS Host.

Files modified: EMCText.xml 

71647 Issue: Performance Metric purge job renamed and Context Sensitive Help (CSH) text added 

Resolution: Purge job ‘Purge Data’ has been renamed to ‘Performance Metric Data’, and the CSH text for purge jobs now includes the 
following line: 

Performance Metric Data 30-90 days

Files modified: EMC.exe 

71947 Issue: Workstation option [39 - Floating Tablet] had no effect on mTablet E-Series workstations as it only worked with 
workstation Type [6 – Tablet Client]

Resolution: The following label changes have been made to distinguish between the mTablet E-Series and mTablet R-Series devices: 

◾ Workstation type [2 - Workstation Client] and [6 – Tablet Client] have been renamed to [2 – 
Workstation/mTablet E-series Client] and [6 – mtablet R-Series client] respectively. 

◾ Platform Types [50 – Win32 Client] and [68 – m Tablet] in the CAL Packages module have been renamed to [50 – 
Win32 Client/mTablet E-Series Cleint] and [6 – mtablet R-Series] respectively. 

Files modified: EMCText.xml 

73939 Issue: The CAL_PACKAGES_INSTALL_STATUS table in the Transaction database was not being purged 

Resolution: A new purge job named "CAL Package Install Status Data" has been added to the Enterprise Parameters-> Purge History
tab to purge CAL_PACKAGES_INSTALL_STATUS table entries that are older than 90 days (default) unless they are the 
last records for a particular WorkstationID/CALPackageID pair. Previously, the NewDTS did not purge the 
CAL_PACKAGES_INSTALL_STATUS table. As a result, in large enterprises, the size of the 
CAL_PACKAGES_INSTALL_STATUS table grew large. 

The Context Sensitive Help (CSH) for the Enterprise Parameters-> Purge History tab-> Purge Jobs now mentions the 
MICROS recommended “Days to Keep” value (7 - 180 days) for the "CAL Package Install Status Data" purge job. 

Files modified: NewDTS.exe, EMC.exe 

Install

19100 Issue: The CAL client failed to install on PCWS 2015 Workstations running Windows 7 if User Account Controls (UAC) were 
running 

Resolution: The CAL client can now be successfully installed on PCWS 2015 Workstations running Microsoft Windows 7 while UAC 
are running. Previously, users had to disable the Workstation UAC to install CAL. 

Files modified: Setup.dat 

Interfaces

68731 Issue: Incorrect void details were sent to the Video Surveillance System (VSS) interface 35475 

Resolution: The correct void item details are now sent to the VSS interface. Previously, when an item was voided in the current round, it 
was reported that the last item on the check had been voided to the VSS interface instead of the actual item that was voided. 
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Files modified: SarOpsXXX.exe 

LPS (Labor Posting Service)

67129 Issue: When employees were not qualified for overtime, LPS (Labor Posting Service) posted Overtime values 35422 

Resolution: The LPS now does not post Overtime values to the database when an employee has worked fewer hours than the hours 
required to qualify for Overtime. 

NewDTS

7256 Issue: NewDTS Promotions purge job failed due to an Integrity Constraint violation 30081 

Resolution: NewDTS has been fixed and now purges Promotions without any error. Additionally, Discount purging now purges tax 
class, RVC group, and menu item group records separately if they are not being referenced in other records. 

Files modified: NewDTS.exe 

62171 Issue: The ‘SIMPURGE’ job timed out while removing a large number of promotions 

Resolution: The ‘SIMPURGE’ job now removes large numbers of promotion records without a failure. Previously, the NewDTS 
‘SIMPURGE’ job failed and threw an error in the NewDTS EGateway log while removing a large number of promotions. 
This issue reduced the frequency of the ‘SIMPURGE’ job and, as a result, caused the Database to grow unprecedentedly. 

Files modified: NewDTS.exe 

62444 Issue: The CAL_PACKAGES_INSTALL_STATUS table in the Transaction database was not getting purged 

Resolution: A new purge job named CAL Package Install Status Data has been added to the Enterprise Parameters-> Purge History 
tab-> Purge Jobs section tab to purge CAL_PACKAGES_INSTALL_STATUS table entries that are older than 90 days 
(default) unless they are the last records for a particular WorkstationID/CALPackageID pair. Previously, the NewDTS did 
not purge the CAL_PACKAGES_INSTALL_STATUS table. As a result, in large Enterprises, the size of the 
CAL_PACKAGES_INSTALL_STATUS table grew very large. 

The context sensitive help (CSH) for the Purge Jobs area now mentions the Micros recommended “Days to Keep” value (7 
- 180 days) for the "CAL Package Install Status Data" purge job. 

Files modified: NewDTS.exe, EMC.exe 

64591 Issue: Journal Purging is now separated from Totals Purging 

Resolution: With this release, the purging of Checks, Journals and Totals have been separated. Each now have their own specific purge 
job, i.e., CHECKSPURGE, JOURNALPURGE, and TOTALSPURGE respectively. Previously, the SIMPURGE job 
handled the all purging jobs. 
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Files modified: NewDTS.exe 

66706 Issue: NewDTS did not purge Performance Metric tables 

Resolution: A new purge job, which is configurable in EMC, has been added to DTS Jobs to purge the performance metric tables in the 
database. Micros recommends storing between 30-90 days’ worth of performance metric data. 

Files modified: DbUpgrade.exe, EMC.exe, NewDTS.exe 

Ops

6722, 
6723 

Issue: Swiping a credit card during a reference entry for a service charge or a discount fully unmasked the Credit Card number 35414, 
35412Resolution: Primary Account Number (PAN) is now partially masked when a credit card is swiped during a reference entry for a service 

charge or a discount. 

Files modified: SarOpsWin32.exe 

36789 Issue: Pickup Guest Check Screen Look Up (SLU) did not differentiate the Banquet Team Checks 

Resolution: Previously, Pickup Guest Check SLU did not differentiate the Banquet Team Checks with double asterisk (**) marks. This 
has been corrected. Currently, Pickup Guest Check SLU denotes Banquet Team Checks with double asterisk (**) marks. 

Files modified: TotalPosting.dll, SarOpsWin32.exe 

36790 Issue: Option [41 - Print Team Member Names on Guest Check] did not function as expected 

Resolution: Enabling Revenue Center (RVC) Parameters option [41 - Print Team Member Names on Guest Check] now prints all the 
names of the currently assigned team members on the guest check. Previously, only the name of the check owner was 
printed. 

Files modified: SarOpsWin32.exe 

57059 Issue: Picking up transaction services checks using the [402 - Pickup by Number] displayed the "Check Not Found" error 35167 

Resolution: This issue is not reproducible in the current release. 

64140 Issue: Revenue Centers (RVC) with Dynamic Order Mode (DOM) ‘Fire on the Fly’ experienced performance delays when the 
KDS Controller was restarted while forced offline 

35352 

Resolution: Operators no longer experience a 10 second delay between every menu item rung in when the KDS Controller is restarted. 

Files modified: PosToKdsHandlerWS.dll 

67656 Issue: Currencies programmed with 'Zero Digits After Decimal' were rounded incorrectly 35435 

Resolution: Checks tendered through a Currency programmed with 'Zero Digits After Decimal' are now rounded correctly. 

Files modified: SarOpsXXX.exe 

67862 Issue: Aborting Add/Transfer Check function during authorization altered the Last Workstation ID prematurely, and as a result 
prevented users from picking up the check 

35447 
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Resolution: Aborting Add/Transfer Check function during authorization no longer alters the Last Workstation ID. 

Files modified: SarOps.exe 

69352 Issue: The Check Detail Area showed voided optional condiments from the previous round prompting operators to void the same 
item several times and caused incorrect Journals and Reports 

35497 

Resolution: The Check Detail Area has been fixed to not show voided optional condiments from the previous round. Previously, 
operators had to void the parent item and then add it back to the check sans the condiments to remove the condiments from 
the Check Detail Area. 

Files modified: SarOpsXXX.exe 

69544 Issue: Check Detail Watermark did not display on workstation screen 

Resolution: The assigned Check Detail Watermark is now displayed on the Check Detail Area of the workstation screen. 

Files modified: SAROps.exe 

71199 Issue: SarOps crashed after multiple failed attempts to communicate with workstations in the same RVC 

Resolution: SarOps no longer crashes when it fails to communicate with workstations in the same RVC. 

Files modified: EGatewayClientWin32CPP.dll, EGatewayClientWinCECPP.dll 

72410 Issue: Check replay failed when the Offline Transaction File (OTF) pending message count is negative 35652 

Resolution: Now, if the total number of records is less than total number of processed records, the pending message count posts ‘0’. 

Files modified: SarOpsXXX.exe 

Peripherals

67859 Issue: DT430 HHT inbuilt barcode reader did not recognize 2D-barcodes (QR codes) 

Resolution: A new logic has been added to DT430 scanners to the enable the scanning of QR Codes. DT430 HHT inbuilt barcode 
readers now read 2D-barcodes and show the QR code on screen. 

Files modified: MicrosDevices.dll 

PMC Reports

73096 Issue: R-Series mTablets did not show scroll bars when viewing PMC reports in full-screen mode 

Resolution: R-Series mTablet users may scroll PMC reports in full-screen mode using the pan/flick gestures. Internet Explorer in 
Windows Embedded Compact 7 does not support scroll bars in full-screen mode. 

Printing

72526 Issue: Bluetooth Select Printer function only worked on Windows 32 mTablet E-Series workstations 

Resolution: The Bluetooth Select Printer function now works on all mobile workstations with Bluetooth capability. 

Files modified: MicrosDevices.dll, SarOps*.exe 

System

67635 Issue: EGateway threw exception errors and could not handle authentication requests when a large number of workstations were 
restarted after upgrading the database 

35434 

Resolution: EGateway now handles authentication requests when a large number of workstations are restarted simultaneously after 
upgrading the database. Additional logging has been added to record database deadlocks. 

Files modified: EGatewayService.dll 
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Simphony Version 1.6
General Release

Simphony 1.6 MR 1
Simphony 1.6 MR 2
Simphony 1.6 MR 4
Simphony 1.6 MR 5
Simphony 1.6 MR 6
Simphony 1.6 MR 7
Simphony 1.6 MR 8
Simphony 1.6 MR 9

Simphony 1.6 MR 10

Previous Version Next Version 
Simphony 1.5 Simphony 2.6 

Simphony 1.6 Maintenance Release 8

This article is a quick reference guide to features, enhancements, and revisions for Simphony 1.6 Maintenance 

Release 8. 

Contents

◾ 1 Prerequisite Knowledge
◾ 2 Document Overview 

◾ 2.1 Terminology
◾ 3 Obtaining/Installing the Software
◾ 4 New Features
◾ 5 Enhancements
◾ 6 Revisions
◾ 7 See also

Prerequisite Knowledge 

This document assumes the reader has the following knowledge or expertise: 

◾ Understanding of basic network concepts 
◾ Experience with Microsoft Windows platforms and terminology 
◾ Familiarity with this product line and its hardware, software, and peripherals 

Document Overview 

For the printable collection for this version, see 1.6 Collection

This document includes the following sections: 

What's New
This section describes new features in this software release. A new feature is one that provides 
capabilities that were not available in previous versions. 

What's Enhanced
This section describes enhancements in this software release. An enhancement is a change made to 
improve or extend an existing feature, under the following criteria: 

◾ The basic feature or functionality already exists in the previous release. 
◾ The change adds to or expands on the current process — it does not replace it. This differs from a 

revision that corrects a problem. 

What's Revised
This section describes issues that have been corrected. A revision is a correction made to an existing form, 
feature, or function, using the following criteria: 

◾ The item must be part of the previous version. 
◾ The change must replace the current item or remove it from the application. 

Terminology 

◾ A Fix ID is an internal tracking number used by R&D. This ID is primarily used by R&D personnel; it is helpful for mapping fixes to documented 
items. 

◾ A CR# is a "Change Request ID" that is generated during the escalations process. When a case is started at the Support Center and the issue is 
determined to be an application defect, a Change Request is created, informing R&D that an issue needs to be fixed. 

Obtaining/Installing the Software 
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New Features 

There are no new features in this version.

Enhancements 

Fix 
ID Enhancement CR 

#

EMC

44195 Additional fields have been added to the Menu Item Definition module to allow for configuring and displaying longer Menu Item 
descriptions and images to be utilized via POS API (Transaction Services) clients

Two new fields named , Image Locator and Description have been added to the EMC-> <Property / Revenue Center level>-> 
Menu Items-> Menu Item Maintenance-> Menu Item Definition-> Other Properties section. When configured, these fields will 
not be utilized by SarOps and therefore will not update Workstations via the DBDownload function. These fields are meant to be 
utilized on systems using POS API clients. 

◾ The Image Locator field can be used to designate an URL for accessing and displaying an image. In order for an integrated 
system to utilize this additional Menu Item data, it has been made available for use through the Transaction Services POS API. 

The Context Sensitive Help (CSH) text for this field reads as follows: 

This field provides 512 characters for the URL of an image file associated with the menu item. It will be used by custom 
applications via Transaction Services.

◾ The Description field is meant to allow for a longer text entry that might be used on a menu board or online ordering site to 
describe an item with more detail than what was previously available. 

The CSH text for this field reads as follows: 

This field provides 1024 characters to describe the menu item. It will be used by custom applications via Transaction Services.
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In retail heavy environments, Menu Item programming may be performed using 3rd party retail management systems that are able to 
push their programming to the Simphony application. To ensure that user’s only require a single point of entry for any given item, the 
newly added ‘Description’ and ‘Image Locator’ configuration fields have also now been made available for import or export via the Data 
Access Utility. For more information, see the Data Access Utility and DA:Menu Item articles. 

Peripherals

25084 Support for the 'mTablet Imager Module’ has been introduced

A combination Magnetic Card Reader (MCR), Barcode Scanner and RFID Reader end cap unit named the 'mTablet Imager 
Module' has been introduced. The end cap unit is connected to the mTablet and powered via a USB port. This device will 
correctly scan standard as well as 2D Quick Response Code (QR) Barcodes and can successfully export them via SIM scripts to 
3rd party applications. The RFID Reader functionality has yet to be implemented at the time of this release. 

To configure this device, follow the steps listed below: 

1. For an mTablet docked with an mStation base, access the EMC-> Property-> Property Hardware-> Workstations-> Devices
tab-> Peripheral Device Configuration section. Press the 'Add' link.

2. An 'Add Device' window displays. From the 'Select Peripheral Device Type' dropdown menu, select the [Generic Barcode
Reader] device and press the 'OK' button.

3. From the COM Port Settings section, users must select the [COM10] setting from the dropdown menu.
4. Under the Options tab, select the Hardware/Cash Drawer sub-tab and enable the following options:

◾ [22 - Enable Mag Card Reader]
◾ [23 - Enable RFID Reader] - NOT supported at the time of this release. 
◾ [30 - Enable Barcode Pass-through mode]

5. All other settings can remain at the default settings. Press the 'OK' button and Save all changes.

If configuring this device for a Floating mTablet (no mStation base unit attached), follow the steps listed below: 

1. Access the EMC-> Property-> Property Hardware-> Workstations-> Options tab-> Offline/Misc tab-> Miscellaneous Options
section-> [39 - Floating tablet] option and ensure that this option is enabled and Save.

2. All of the remaining configuration steps are the same as for the docked mTablet (including using the [COM10] setting).
3. When the 'Add Device' window displays and then the subsequent 'Select Peripheral Device Type' dropdown menu, only the

[Generic Barcode Reader] device will display and therefore must be selected.
4. Save all changes.

See the 1.x mTablet Imager Module article for more information. 

SIM

52401 Several SIM System Variables were added to generate a list of Open Checks and corresponding check detail for a Revenue 
Center (RVC)

Several SIM System Variables have been added to allow users to configure Interface Scripting Language (ISL) scripts to generate 
a list of Open Checks and additional associated check detail for a RVC. The new 'System Variables' and their 'Field/Parameter' 
descriptions are listed in the table shown below: 

Variable Name and 
Syntax Field/Parameter

@NUMOPNCHK The count of Open Checks per Revenue Center 

@OPNCHK_EMPOWNER Object Number of the employee that owns the Open Check 

@OPNCHK_GUID Open Check GUID (unique identifier) 

@OPNCHK_NUMBER Open Check Number 

@OPNCHK_OPENTIME Open Check Date and Time that the check was begun 

@OPNCHK_ORDERTYPE Open Check Order Type ID number 

@OPNCHK_TOTAL Open Check Total Amount 

@OPNCHK_WSOWNER Object Number of the Workstation that currently owns the Open
Check 

Note: The @NUMOPNCHK System Variable must be called first to return data when using any of the other @OPNCHK_* 
System Variables. 
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An example of the data output when a script is executed using all of the new System Variables is shown below. 

See the updated Simphony SIM Manual for more information. To download this manual, click here 
(http://downloads.micros.com/micros/simphony/Wiki/Docs/WhitePapers/Simphony_SIM_Manual.pdf) . 

Revisions 

Fix ID Revision CR #

Auto Sequencer

25974 Issue: A (RVC) (SOD) override set to run after the Property SOD did not work as expected 33917 

Resolution: Previously, if the SOD for a Property was overridden at the RVC level and the RVC SOD time was 
configured after the Property SOD time, the RVC SOD did not function correctly and would fail the 
second day’s run, and each run thereafter was one day behind. 

File(s) modified: AutoseqHandler.dll, EMCHandler.dll, EMCData.dll, SequencerEngine.dll and 
SequencerService.exe files. 

25975 Issue: A Revenue Center (RVC) Start of Day (SOD) override incorrectly wrote the StartTime and EndTime in 
the Transaction database PERIOD_INSTANCE table 

33918 

Resolution: Previously, when the RVC SOD was configured to override the Property SOD, the StartTime and 
EndTime times were written to the PERIOD_INSTANCE table in the 24 Hour Format 12 hours later 
instead of being written in UTC (GMT) time. This caused the SOD to fail the second reset and each 
reset thereafter was one day behind. 

File(s) modified: AutoseqHandler.dll, EMCHandler.dll, EMCData.dll, SequencerEngine.dll and 
SequencerService.exe files. 

Credit Card Batch Process

55707 Issue: Successfully transferred Credit Card (CC) Batches were displayed as 'Failed' in the Create Report 
module 

35140 

Resolution: Previously, although a CC Batch was successfully transferred and settled, the Transfer Status of that 
batch displayed as 'Transfer Failed' in the EMC-> Property Level-> Credit Card Batching-> Create 
Report- > Select Batch Range dialog when users selected Saved Batches to run the report. This had 
been corrected. 

File(s) modified: ECCServer.dll file 

54986 Issue: Running a manual Start of Day (SOD) was not working as expected for individual Revenue Centers 
(RVC) 

Resolution: Previously, when users attempted to run a manual SOD for a RVC, users would receive a message 
indicating that the Property wasn’t configured to manually increment the Business Date. Currently, a 
manual SOD can now be configured and executed for RVC‘s outside of their associated Property’s SOD 
configuration. 

File(s) modified: SequencerEngine.dll, EMC.exe and SequencerService.exe files 

Database

23773 Issue: Workstations (WS) became unusable if the Transaction database ran out of room to post data 

Resolution: Previously, if the Tablespace of the Transaction database was full in an Oracle® environment, the WS 
would report an 'Undefined Error from the Gateway' message when attempting to Service Total or 
close the check. The WS became unusable as users could not leave the Tender screen and were unable 
to cancel the transaction and would be forced to reboot. Currently, when the Tablespace of the 
Transaction database runs out of space, the client goes Offline without throwing an error. 
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File(s) modified: NewDTS.exe, EGatewayHandlerUtils.dll and EGatewayService.dll files 

49776 Issue: Discounts were not being recorded in the Transaction database TOTALS table TTLTYPE column, 
when Menu Item Classes option [55 - Auto Discounts Apply to Priced Condiments (parent items 
only)] was enabled 

35042 

Resolution: Previously, when Menu Item Classes option [55 - Auto Discounts Apply to Priced Condiments 
(parent items only)] was enabled via the EMC-> <Enterprise/Property/ Revenue Center>-> Menu 
Items-> Menu Item Classes-> Options tab, Discounts (Total Type 16) were not recorded in the Totals 
table of the Transaction database. 

File(s) modified: Poslib.dll 

Documentation

63167 Issue: The article reviewing Simphony 1.x Services has been updated on the Simphony Wiki 

Resolution: See the List of Simphony 1.x Services article for more information. 

EGateway

59550 Issue: The EGateway SimphonyCALHandler logging was not detailed enough to help resolve Service Host 
issues 

Resolution: Previously, EGateway SimphonyCALHandler logging was not detailed enough to troubleshoot 
Service Host issues. Currently, the EGateway log writes appropriate messages for each handler at 
different verbosity levels and records the Service Host IDs linked to the following Service types. 

◾ Credit Card 
◾ Offline Labor Cache (OLC) 
◾ System Interface Module (SIM) 
◾ Interface 

File(s) modified: SimphonyCALHandler.dll 

EMC

22821 Issue: Overriding the Start of Day (SOD) at the Revenue Center (RVC) created PCAseq_schedules without a 
TZIndex 

33664 

Resolution: Previously, if the SOD for a Property was overridden at the RVC level, the PCAseq_schedules were 
created in the Transaction database without a TZIndex causing the autosequence to fail. This has been 
corrected. 

File(s) modified: AutoseqHandler.dll, EMCHandler.dll, EMCData.dll, SequencerEngine.dll and 
SequencerService.exe files 

36785 Issue: The number of definition sequences were incorrectly displayed in the Menu Item Maintenance module 

Resolution: Previously, when multiple Menu Item Definitions were configured across several Revenue Centers 
(RVC), the number of definition sequences were not being filtered by RVC which caused the Definition 
Sequence # drop-down menu in the EMC-> RVC level-> Menu Item-> Menu Item Maintenance
module to exceed the definition limit of 64 and populate sequence numbers that could not be selected. 
This has been corrected. 
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File(s) modified: EMC.exe 

57721 Issue: The Context Sensitive Help (CSH) text for the [@/for] function key did not properly convey its use 

Resolution: The CSH text for the [@/for] function key was not descriptive and did not make any reference to its use 
with Number Lookup (NLU) Items or Open Priced Items. This has been corrected. The CSH text for the 
[@/for] function key now reads as follows: 

This key is used to post sales of multiple NLU or open-priced Menu Items. It is also used to post 
sales of split-priced items (e.g., 10 bagels priced $6.00/dozen).

File(s) modified: EMCText.xml 

57939 Issue: When attempting to filter a search of the Employee Maintenance module by Job Code, the pop up 
window’s title bar was named incorrectly 

Resolution: Previously, when users accessed the EMC-> Property level-> Personnel-> Employee Maintenance
module and tried to filter a search by Job Code by clicking on the adjacent ellipsis (…), the pop up 
window’s title bar displayed 'Select LookupNames.JobCode'. With this release, the pop up window’s 
title bar reads 'Select Job Codes' as expected. 
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File(s) modified: EMC.exe 

57944 Issue: When running a Credit Card (CC) Batch Report and the user selected the report filter to display a range 
of Revenue Centers, the pop up window’s title bar was named incorrectly 

Resolution: Previously, when users accessed the EMC-> Property level-> Credit Card Batching-> Create CC 
Report tab and tried to generate a CC Batch Report filtered by a range of Revenue Centers, the pop up 
window’s title bar displayed 'BatchReport.SelectRvRange'. With this release, the pop up window’s 
title bar reads 'Select Revenue Center Range' as expected. 

File(s) modified: EMC.exe 

58381 Issue: The Context Sensitive Help (CSH) for the Credit Card (CC) 'Maximum Batch Size' field was not 
correct 

Resolution: Previously, the Context Sensitive Help (CSH) for the EMC-> Enterprise level-> Credit Card Drivers 
module-> Maximum Batch Size field was misleading as it described the functionality relevant to legacy 
MICROS F&B products. The erroneous CSH text stated, "When the field is set to 0, all records will be 
processed in the same batch". This text could have led to incorrect configuration, resulting in CC Batch 
Transfer failures. 

This has been corrected by modifying this field's CSH text to read as follows: 
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Enter the maximum number of records to send to the credit card processor in one group. When 
the total number of records to be sent is greater than this value, the batch will be broken into 
smaller groups for transfer. Most processors have a limit of 999 records that can be accepted in 
one group.

File(s) modified: EMCText.xml 

59870 Issue: Merchant Group column was still being displayed on the Workstations module Table View 

Resolution: Previously, the 'Merchant Group' field which was removed from the EMC-> Property level-> 
Property Hardware-> Workstations module, was still visible in the Workstations module Table View, 
between the 'Report Timeout' and 'Cash Drawers' columns. The Merchant Group field was not seen 
in the Form View as expected. This has been corrected. Currently, the Workstations module does not 
show the 'Merchant Group' column in the Table View. 

File(s) modified: EMC.exe and EMCText.xml 

60427 Issue: Remote Distribution process window displayed the old EMC icon on the Taskbar 

Resolution: Previously, the 'Remote Distribution' process window which opened when cloning a Property displayed 
the old EMC icon on the Taskbar. This has been corrected. Currently, when initiated, the 'Remote 
Distribution' process window displays the new EMC icon. 

File(s) modified: EMC.exe and EMCFramework.dll 

63569 Issue: The 'Day' (of the week) selection under Effectivity settings for 'Start Date' and 'End Date'
configuration was not working as expected 

Resolution: Previously, users were unable to change or toggle the 'Day' field associated with Effectivity dates 
located in the following EMC modules: 

◾ EMC-> Property level-> Property Hardware -> Kitchen Theme Period
◾ EMC-> Property level-> Sales-> Discounts-> Effectivity tab-> Start Date' and 'End Date fields 

This has been corrected by modifying the EMC to no longer display the 'Day' of the week selection 
choices. Choosing and setting the correct 'Start Date' and 'End Date' fields for the desired Date(s) 
should suffice when configuring these module’s Effectivity settings. 

File(s) modified: EMC.exe 

Ops

37301 Issue: mTablets, when Offline, would display an "Offline" status message every time a new check was begun 
or picked up and would subsequently prompt users to “Work Offline?”

35175 

Resolution: Previously, mTablets were using a version of SarOps utilized for Mobile MICROS handhelds. Mobile 
MICROS handhelds have smaller display screens than other Workstations and therefore required the 
"Offline" status message and “Work Offline?” prompt to display for users. This is not the case for 
mTablets, since the display is large enough to accommodate the display of the conventional “Offline” 
status in either the ‘Check Detail’ section or the status section of the 'Sign In' screen. Currently, the 
"Offline" status message and subsequent “Work Offline?” prompt no longer displays each time users 
begin or pick up checks. 

File(s) modified: SarOps*.exe. 

41094 Issue: The Opera SIM dialog box font size on mTablets was too small to read 35064 

Resolution: Previously, in ENH_PMS version 157, the font size of the SIM dialog box was too small making the 
text difficult to read. This has been corrected by increasing the mTablets ‘FixedTextWindows’ font size 
from 12 to 16. 

File(s) modified: SarOps*.exe 

50326 Issue: When an Automatic Service Charge (configured to be non-taxed) was applied as well as Discounted, 
taxes were still being forgiven 

35047 

Resolution: Previously, when the EMC-> Property level-> Sales-> Discounts-> General tab-> Options-> [1 - ON 
= Open; OFF = Preset], [11 - Affects Auto Service Charge (Only Subtotal Discounts)] and [17 - 
Item is Shareable] were enabled , when an Automatic Service Charge (configured to be non-taxed) was 
applied as well as Discounted, taxes were still being forgiven. This resulted in incorrect totals getting 
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posted. This has been corrected. Currently, Automatic Service Charges that are set to be non-taxed are 
no longer forgiving taxes. 

File(s) modified: Poslib.dll 

53793 Issue: Barcodes and QR codes with more than 120 characters were getting truncated 35112 

Resolution: Previously, barcodes and QR codes with more than 120 characters were getting truncated to 82 
characters. The input from the Barcode scanner was getting routed through the Keyboard buffer. The 
Keyboard buffer had a limit of 120 characters and as a result, the QR codes and barcodes were getting 
truncated. This has been corrected by adding a new SIM Command named 'ScanBarcode' to handle 
barcodes and QR codes with more than 120 characters. 

File(s) modified: PosLib.dll and SarOps*.exe 

See the updated Simphony SIM Manual for more information. To download this manual, click here 
(http://downloads.micros.com/micros/simphony/Wiki/Docs/WhitePapers/Simphony_SIM_Manual.pdf) . 

54960 Issue: The DPS could not post Split Checks to the Reporting database when a Currency configured without 
using a decimal point was used and an Add-On tax was applied to the order 

Resolution: Previously, when an Add-On tax was applied to an order and when a Currency configured without using 
a decimal point (e.g., the Won in Korea or the Krona in Iceland) was used and then the check was Split, 
the Direct Posting Service (DPS) could not post to the Reporting database. This was because the 
Currency was missing a decimal point which caused the 'TaxCalculated' value to exceed the allowable 
number of characters for this database column. This has been corrected. 

File(s) modified: SarOps*.exe 

57732 Issue: When any of the Order Device options to 'Print Guest Check Info Lines' were enabled, it caused 
SarOps to crash on Workstations 

35190 

Resolution: Previously, when Order Device options pertaining to 'Print Guest Check Info Lines' located in the 
EMC-> Revenue Center level-> Revenue Center Information-> Order Devices-> Options section were 
enabled, SarOps would crash on Workstations when an order was sent to the configured Order Device. 
Specifically, SarOps crashed when any of the following Order Device options were enabled: 

◾ [13 - Print Guest Check Info Lines Before Header on Order Device]

Select this option to print guest check information lines before the order device header. If this 
option is disabled, these lines will be suppressed.

◾ [14 - Print Guest Check Info Lines After Header on Order Device]

Select this option to print guest check information lines after the order device header. If this 
option is disabled, these lines will be suppressed.

◾ [15 - Print Guest Check Info Lines After Trailer on Order Device]

Select this option to print guest check information lines after the order device trailer. If this 
option is disabled, these lines will be suppressed.

There are several other ‘Guest Check Info Lines’ options that are located in the EMC-> Revenue Center 
level-> Revenue Center Information-> RVC Parameters-> Format tab-> Format Options section that 
control the location of the printing of the ‘Guest Check Info Lines’ on Guest Checks and Customer 
Receipts. They are as follows: 

◾ [26 - Print Guest Check Info Lines Before Header on Guest Checks]

Select this option to print guest check information detail lines before the guest check header. To 
suppress printing of the detail lines, do not select this option.

◾ [27 - Print Guest Check Info Lines After Header on Guest Checks]

Select this option to print guest check information detail lines after the guest check header. To 
suppress printing of the detail lines, do not select this option.

◾ [28 - Print Guest Check Info Lines After Trailer on Guest Checks]

Select this option to print guest check information detail lines after the guest check trailer. To 
suppress printing of the detail lines, do not select this option.
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It’s been determined that the code that was supposed to support Order Device 'Guest Check Info Lines'
options was missing. This was the root cause of SarOps crashing. With this release, enabling Order 
Device options for ‘Guest Check Info Lines’ no longer cause SarOps to crash. 

File(s) modified: SarOps*.exe 

58627 Issue: If a Workstation (WS) had Offline Transaction Files (OTF) spanning more than one day, if the WS was 
rebooted prior to going back Online, only the current Business Date’s records would replay 

Resolution: Previously, there was a defect in the code sorting function which had the newest OTF file replay first, 
thereby skipping the replay of the older OTF files. 

File(s) modified: SarOps*.exe 

62024 Issue: mTablet Screen Look Up (SLU) items did not fit to the screen and were not selectable on the Speed Pad 
template 

35269 

Resolution: Previously, when an SLU was added to the mTablet in a Speed Pad Touchscreen Template, SLU items 
were not displayed properly on the screen. When added, mTablet partially truncated the SLU items from 
the mTablet screen, making them un-selectable. This has been corrected. Currently, SLUs are displayed 
properly on Speed Pad templates. 

File(s) modified: OpsDisplaySys.cfg 

New DTS

58315 Issue: The MMDaily Move History Stored Procedure could be interrupted causing data loss 35224 

Resolution: Previously, the New Data Transfer Service (DTS) called the MMDaily Move History stored procedure 
without a Database Transaction. As a result, the NewDTS could not roll back the Database if there were 
any failures or changes such as insertions and deletions, etc. This has been corrected. Currently, the 
MMDaily Move History procedure works as expected. 

File(s) modified: NewDTS.exe 

62282 Issue: Deadlocks occurred when multiple NewDTS jobs were configured in a Microsoft SQL Server® 
environment 

35280 

Resolution: Previously, in a Microsoft SQL Server environment, if more than one NewDTS job was configured to 
run between intervals, the jobs would interfere with one another and cause deadlocks each time a job 
tried to read the DTS_JOBS table. As a result, some jobs would not clear out the server entry, causing 
any subsequent attempt to run that job to fail as it appeared that it is already being run. This has been 
corrected. 

File(s) modified: NewDTS.exe 

Totals Posting

58557 Issue: A table lock occurred in the PLAYBACK_WS table causing all Workstations in the Enterprise to go 
Offline 

Resolution: Previously, in a large environment, when Properties were being brought back Online from an Offline 
state, the PLAYBACK_WS table in the Transaction database would get locked. In order to recover from 
the table lock, all Workstations in the Enterprise were forced Offline and then slowly brought back, 
resulting in a long wait time. This has been corrected. 

File(s) modified: TotalPosting.dll 
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Simphony 1.6 Maintenance Release 7 

IMPORTANT NOTICE
Prior to Simphony 1.6 MR7 the following internal preambles were checked when the CAPMS Credit Card Driver 
Configuration Option 'Enable Card Number Validation' was enabled. 

◾ Visa 4* Length 16 
◾ Mastercard 5* Length 16 
◾ Amex 34*, 37* Length 15 
◾ Discover 6011*, 644*-649*, 65* Length 16 
◾ EnRoute 2015*, 2149* Length 15 
◾ Diners Club 36* (Processed as Mastercard) Length 14 
◾ Diners Club 300*-305*, 3095*, 38*, 39* Length 16 
◾ Carte Blanche 389* Length 14 
◾ JAL 1800*, 2131* Length 15 
◾ JBC 3* Length 16 
◾ Maestro 6304*, 6759*, 5020*, 5038* 

Because of ever changing credit card preambles, these internal preambles have been eliminated and the option bit has been 
removed. 

Customers using CAPMS for their credit card driver should validate and update the credit card preamble configuration in 
EMC under Tender Media 

This article is a quick reference guide to features, enhancements, and revisions for Simphony 1.6 Maintenance Release 7. 

Contents

◾ 1 Prerequisite Knowledge
◾ 2 Document Overview 

◾ 2.1 Terminology
◾ 3 Obtaining/Installing the Software
◾ 4 New Features
◾ 5 Enhancements
◾ 6 Revisions
◾ 7 See also

Prerequisite Knowledge 

This document assumes the reader has the following knowledge or expertise: 

◾ Understanding of basic network concepts 
◾ Experience with Microsoft Windows platforms and terminology 
◾ Familiarity with this product line and its hardware, software, and peripherals 

Document Overview 

For the printable collection for this version, see 1.6 Collection

This document includes the following sections: 

What's New
This section describes new features in this software release. A new feature is one that provides capabilities that 
were not available in previous versions. 

What's Enhanced
This section describes enhancements in this software release. An enhancement is a change made to improve or 
extend an existing feature, under the following criteria: 

◾ The basic feature or functionality already exists in the previous release. 
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Simphony 1.6 MR 9
Simphony 1.6 MR 10

Previous Version Next Version 
Simphony 1.5 Simphony 2.6 

◾ The change adds to or expands on the current process — it does not replace it. This differs from a revision 
that corrects a problem. 

What's Revised
This section describes issues that have been corrected. A revision is a correction made to an existing form, feature, 
or function, using the following criteria: 

◾ The item must be part of the previous version. 
◾ The change must replace the current item or remove it from the application. 

Terminology 

◾ A Fix ID is an internal tracking number used by R&D. This ID is primarily used by R&D personnel; it is helpful for mapping fixes to documented items. 
◾ A CR# is a "Change Request ID" that is generated during the escalations process. When a case is started at the Support Center and the issue is determined 

to be an application defect, a Change Request is created, informing R&D that an issue needs to be fixed. 

New Features 

There are no new features in this version.

Enhancements 

Fix ID Enhancement CR #

Credit Card Driver

20097 The configuration and use of the Demo Credit Card (CC) driver (DEMOCA) has been enhanced

Formerly, when the DEMOCA driver was used for pre-live testing, it was possible to continue using it after going 
“live”, which could have resulted in checks, which were closed using the DEMOCA driver, of not being capable of 
being settled to an actual CC Processor. The DEMOCA driver has had additional configuration options added in 
order to ensure that it no longer cause potential CC Settlement issues for customers. 

The enhancements to the DEMOCA driver are: 

1. When the DEMOCA driver is in use, Operators on Workstations will receive the following message when a CC
transaction is authorized: 'Warning: DEMOCA driver in use. This is a training authorization' This should help
notify users to assign their preferred CC Driver(s) prior to going 'live'.

2. An Effectivity Date and Time setting can now be configured in the EMC to control and limit the use of the
DEMOCA driver.

3. When the configured Effectivity Date and Time threshold has expired, Operators on Workstations will receive the
following message: 'No active credit card driver' - Additionally, Demo CC Authorizations will no longer be
allowed.

4. When the DEMOCA driver is in use, the CC Authorization validation chit that prints will display a message
indicating that the DEMOCA driver is in use.

5. When the DEMOCA driver is in use, CC Authorization rounds will display the same message on Journals and
PMC Journal Reports as the printed CC Authorization validation chit. These are not optional settings, and will be
in effect anytime the DEMOCA driver is in use.

6. All EMC changes performed within the Credit Card Driver module will be tracked by Audit Trail.
7. When the Effectivity Date and Time threshold has expired, on the Enterprise level, EMC users will receive a

message (listing each affected Property) that 'No active credit card driver' is currently in use and that credit
authorizations will not be allowed at the displayed Property(s).

See the DEMOCA Credit Card Driver article for more information. 

34878 

Ops

29304, 
41890 

A new Offline Transaction File (OTF) file handling and playback method has been introduced

The handling of OTF files and their replay has been enhanced to improve troubleshooting and supportability. 
SarOps clients have a new directory structure to store OTF files that are created when Workstations lose 
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communication with the Enterprise application server. Each Workstation currently has an OTF folder. Within the 
OTF folder, three additional folders will be created. The folders and their purpose are listed below: 

◾ OTF_CURRENT folder – This folder will store the Offline transaction files. One OTF file is created for each day 
at Midnight based on the systems UTC Time Zone settings. The file’s naming convention will resemble the 
following syntax: OTF_YYYYMMDD.bin

So, for example, if a Workstation is in an Offline state for three days, there will be three separate OTF files created (one 
for each day). This should help prevent OTF files from becoming too large. 

◾ Once communication to the Enterprise application server has been re-established, replay of the Offline transactions 
will begin automatically. Users will see the percentage of completion during the replay of Offline transactions on 
the Workstation’s display. If for some reason a transaction fails to replay successfully, the system will move on to 
replay the next transaction until its finished replaying all of the records. Any failed replay records will be moved to 
the OTF_REPLAY folder and the successfully replayed contents of the OTF_CURRENT folder will be deleted. 

◾ OTF_REPLAY folder – This folder is where failed replay records from the OTF_CURRENT folder will be 
stored. Once the Ops client is brought Online, the failed OTF file will try to replay again. If that attempt fails, the 
records will be moved to the OTF_ERROR folder. 

◾ OTF_ERROR folder – If the records fail to replay from the OTF_CURRENT folder, the files will be sent to the 
Enterprise. Large files will be broken into small data blocks (so that network resources are not overly taxed) and 
sent to the Enterprise. 

◾ Any pre-existing (legacy version) OTF.bin files will be moved to the OTF_CURRENT folder after performing an 
upgrade of the SarOps client to this version. OTFMsg.Err files will be left in place for manual replay, review or 
removal. 

◾ When a check is being picked up on an Offline (Yellow mode) Workstation, all associated records (stated as 
below) will be marked as 'DRH_PICKEDUP' in the original OTF.bin file. Then they will be added to the 
OTF.bin file of the Workstation that actually picks up the check. 
◾ CSMD_POST_SALE_WRITE_CHECK
◾ CSMD_WRITE_CHECK
◾ CSMD_CANCEL_TRANS

Replay will skip the records marked as 'DRH_PICKEDUP'. 

A module to assist in troubleshooting failed OTF Playback records has been added to the EMC and can be located by 
accessing the EMC-> Enterprise level-> Enterprise Information-> Playback Exceptions module. This module will 
allow privileged users to search for and save OTF records that failed to replay. Once found, these records can be 
downloaded to a user’s Remote EMC computer and may be reviewed using the OTFEdit.exe tool. The OTFEdit.exe tool 
has been enhanced to display the newly added ‘DRH_PICKEDUP’ status. Once a record has been reviewed, users can 
mark records as having been reviewed and in doing so, flag the records to be purged from the database via a new 'Purge 
Job' named 'Playback Exception Data' that has been added to the system. 

See the Offline Transaction File (OTF) Handling article for more detail. 

46438 MICROS logos and Simphony graphics have been updated

With this release, MICROS logos and Simphony graphics have been redesigned with a new look and feel. 

50511 Support for the mStation Scanner has been added

A Barcode scanner has been introduced for use with the mStation. The mStation Scanner supports Bluetooth 
technology. The mStation Scanner dock is connected to the mStation and powered via a USB port. The mStation 
Scanner will correctly scan standard as well as 2D Quick Response Code (QR) barcodes and can successfully 
export them via a SIM script to 3rd party applications. 

Note: mStations are required to be running Platform Version 1.3 in order to support the mStation 
Scanner. 

See the Barcode Scanner article for more information. 

Revisions 

Fix ID Revision CR #

Auto Sequencer

22522 Issue: During a Start-of-Day (SOD) Autosequence, the CARRIED_TOTALS table in the Transaction database was not getting purged 
which caused the SOD Report query to run too long 

33630 

Resolution: Previously, part of the SOD logic involved reading and inserting data to the CARRIED_TOTALS table in the Transaction 
database. This table is used when running Shift reports in order to get accurate 'Carried Over Totals' information. However, this 
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table was never purged, which caused the query against it to use excessive resources on systems that had been running for a long 
period of time. This has been corrected by modifying the EMC.exe. A Purge Job for 'Carried Totals Data' has been added to 
the EMC. To view the ‘Carried Totals Data’ purge job, access the EMC-> Enterprise-> Enterprise Information-> Enterprise 
Parameters-> Purge History tab-> Purge Jobs-> Carried Totals Data. This purge job is enabled by default to maintain 60 days 
of data. MICROS recommends maintaining anywhere from 30 to 90 days of ‘Carried Totals Data’. 

Credit Card Batch Process

6881 Issue: Credit Card default Maximum Batch Size increased to 950 29463 

Resolution: Previously, when adding a new Credit Card Driver via the EMC-> Enterprise level-> Hardware/Interfaces-> Credit Cards-> 
Credit Card Drivers module, the default Maximum Batch Size was set to “0”. When the Maximum Batch Size is zero, a batch 
with more than 950 records would fail to settle as many Credit Card Processors are unable to handle more than 999 records in a 
single batch. Therefore, the default value of the Maximum Batch Size has been increased to 950 by modifying the EMC.exe 
file. 

7264 Issue: By default, the Host Timeout and the Maximum Batch Size was set to '0' when creating a VisaD driver 31740 

Resolution: Previously, when creating a new VisaD driver via the EMC-> Enterprise level-> Hardware/Interfaces-> Credit Card Drivers 
module, by default the Host Timeout and the Maximum Batch Size was set to '0'. This has been corrected by modifying the 
EMC.exe file. As setting the Host Timeout to '0' or a low value would result in the batch timing out quite often and lead to 
double postings, now the Host Timeout defined in the EMC-> Enterprise level-> Hardware/Interfaces-> Credit Card Drivers-> 
Internet tab defaults to 600 seconds. In addition, the Maximum Batch Size defined in the EMC-> Enterprise level-> 
Hardware/Interfaces-> Credit Card Drivers-> General tab, now defaults to 950 when creating a VisaD driver. 

15240 Issue: Applying a Charge Tip and Service Totalling a Check from a Workstation other than the Workstation that authorized the Credit 
Card made two entries in the Credit Card Batch Report 

32846 

Resolution: Previously if a Credit Card was authorized from one Workstation and the Operator uses another Workstation to apply a Charge 
Tip and Service Total the Check, the Credit Card Batch Report incorrectly displayed two records; one for the correct amount and 
another record with a 0.00 amount. This was not reproducible in the current release. 

17704, 
18009 

Issue: When settling a Credit Card (CC) Batch using the VisaD CC Driver, if an individual CC record failed to settle, the entire batch 
failed without providing enough detail about the failed CC transaction 

33119 

Resolution: Previously, when settling a CC Batch with VisaD, when a group of records were transferred to a CC Processor, either all of the 
CC records settled or all failed as a group. The EMC (and CC Service Host EGateway log) did not return any indication of the 
individual record, only that the CC batch failed. All of the records in that group were marked as rejected, and the EGateway log 
(as shown below) only showed that it failed to mark records in the database, but did not provide enough detail or disclose which 
ones: 

08/19/12 07:41:49, 3, 3,LoadHandlers, 17,Message handler processing msg type 
MSG_UPDATE_BATCH_DTL_REQ, 
08/19/12 07:41:49, 3,-3,LoadHandlers, 8,CCDrvInst[62]: CCS ERROR! Could not mark 
records to Process in DB: error GW_EC_FAIL, 
08/19/12 07:41:49, 3,-3,LoadHandlers, 8,CCDrvInst[62]: Settle Batch failed with 
Return Code [GW_EC_FAIL], 
08/19/12 07:41:49, 3, 0,LoadHandlers, 8,CCS: Call to HandleSettleBatchRequest for 
CCDI [62] (visad.dll) returned CGwErrorCode  :[GW_EC_FAIL],

This has been corrected by modifying the ECCServer.dll and VisaD.dll files. Currently, the failed CC Batch Transfer report 
displays each check number that was rejected. The user is capable of pinpointing the exact location of the rejected check number 
from the EMC-> Transfer CC Batch tab and in the CC Service Host EGateway log file. 

31804 Issue: The Edit Batch module did not display the “Omitted” state in the table view of a batch 

Resolution:

Page 4 of 9Simphony 1.6 Maintenance Release 7



Previously, when a record of a Credit Card Batch was omitted in the Form view, the 'Edit Batch' module did not display the 
“Omitted” state in the table view — the Settle State column was set to “Not Settled”. This prevented users from easily locating 
records that have been omitted. 

This has been corrected by modifying the EMC.exe and EMCHandler.dll files. A new column named Omitted has been added to 
the table view of the EMC-> Property level-> Credit Card Batching-> Edit Batch module. If a record is omitted, the Omitted 
column of the record will be set to “Yes” 

40541, 
52585 

Issue: Manually editing the Auth Code or the Expiration Date of a Credit Card (CC) Batch via the Edit Batch module caused errors 34707 

Resolution: Previously, when a user manually Authorized a CC using the [Manual Authorize] function key and later modified the Auth 
Code via the EMC-> Property level-> Credit Card Batching-> Edit Batch > Edit Record tab-> Auth Code field, the CC Batch 
failed to transfer. Additionally, if the Auth Code was saved with an empty value, the batch failed to transfer as expected, yet the 
EMC would not reopen the batch so that the Auth Code may be modified. 

Similarly, when a CC Batch was manually authorized and the Expiration Date of a CC Batch was modified via the EMC-> 
Property level-> Credit Card Batching-> Edit Batch > Edit Record tab-> Expiration Date drop-down menu, saving the new 
Expiration Date returned the following error: 

EMCHandler failed: Index was outside the bounds of the array

This has been corrected by modifying the EMC.exe file. 

50691 Issue: A transaction with a negative Credit Card (CC) Authorization closed to a positive amount was still settled as a Refund 35051 

Resolution: Previously, when a negative check was created and a CC Auth was performed for the negative amount in order to give a refund, 
if additional Items were added to the check and the check was closed to the same CC for the positive amount, it was processed as 
a Refund and the amount that the check was closed to was credited to the card instead. This has been corrected by modifying the 
CAPMS.dll file. 

55707 Issue: Successfully transferred Credit Card (CC) Batches were displayed as “Failed” in the Transfer Batch module 35140 

Resolution: Previously, although a CC Batch was successfully transferred, the Transfer Status of that batch displayed as “Settle Batch 
Failed” in the EMC-> Property level-> Credit Card Batching-> Transfer Batch-> Transfer Status as well as in the EMC-> 
Property Level-> Credit Card Batching-> Create Report- > Select Batch Range. This issue was not reproducible in the current 
release. 

Credit Card Driver

6514 Issue: If two Credit Cards were authorized, one for the full amount of the check and another for a zero amount, payments could not be 
made using the second Credit Card 

32424 

Resolution: Previously, if two Credit Cards were authorized, one for the full amount of the check and another for a zero amount, when 
attempting to pay for the remainder of the check using the second Credit Card, the following error message was returned: "Must 
print voucher". This has been corrected by modifying the SarOpsXXX.exe file. Currently, if two Credit Cards are authorized, 
one for the full amount of the check and another for a zero amount, when attempting to make a payment using the second Credit 
Card the following error message will be displayed: 

You must authorize this credit card with a non-zero amount to complete this transaction. 

6815 Issue: Enabling the CAPMS Credit Card Driver [Enable Card Number Validation] option caused valid Mod-10 Credit Card numbers 
with preambles to consistently fail 

31068 

Resolution:
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Previously, enabling the CAPMS Credit Card Driver option [Enable Card Number Validation] via the EMC-> Enterprise 
level-> Hardware/Interfaces-> Credit Card Driver-> General tab-> Configuration, caused valid Mod-10 Credit Card numbers 
with preambles defined in the Tender/Media module to fail and return the following error message: 

Host PC rejected message because of invalid argument

This has been corrected by removing the [Enable Card Number Validation] option from the Credit Card Driver module and 
modifying the CAPMS handlers to not validate card number during authorization. These changes have been implemented by 
modifying the EMC.exe and CAPMS.dll files 

Users using the CAPMS Credit Card Driver may validate the Credit Card preambles by enabling option [27 - Credit Card 
Validity Test] via the EMC-> Enterprise/Property level-> Sales-> Tender/Media-> Options tab-> Credit Card options. 

Users using the CAPMS Credit Card Driver should validate and update the Credit Card preamble configuration in the 
EMC-> Enterprise/Property level-> Sales-> Tender/Media -> Options tab-> Credit Card options, prior to upgrading to 
Simphony v1.6 MR7. As a general best practice, Credit Card preamble configuration should be reviewed with the Credit 
Card processor at regular intervals. 

6910 Issue: When a Credit Card Driver was linked to multiple Properties, CAPMS occasionally returned a message with incorrect 
information 

31275 

Resolution: Previously, When a Credit Card Driver was linked to multiple Properties, CAPMS returned a message (MessageID: CA_RSP) 
displaying authorization code and other discretionary data incorrectly. It was reported that CAPMS messages used the 
Workstation Number, which is unique within a Property, but not unique within the Enterprise unlike the Workstation ID. This 
has been corrected by modifying the SarOpsXXX.exe file. CAPMS messages now use the Workstation ID instead of the 
Workstation Number. 

Database

25196 Issue: The EMC failed to connect to the database when the Microsoft SQL Server Analysis Service was running 33872 

Resolution: Previously, if the EMC was installed on a machine running the Microsoft SQL Server Analysis Service, the application failed as 
it was unable to connect to the Transaction database and caused multiple issues. However, if the Microsoft SQL Server Analysis 
Service was stopped, the EMC would launch successfully. This issue was not reproducible in the current release. 

Data Transfer Service

20791 Issue: In a hosted environment, every Simphony Application Server's Data Transfer Service (DTS) via the MMDAILY job was 
aggregating every organization in the Reporting database 

33399 

Resolution: Previously, in a hosted environment, every Simphony Application Server's Data Transfer Service (DTS) via the MMDAILY job 
was aggregating every organization in the Reporting database, not just the organization that the Application Server was 
responsible for. This has been corrected by modifying the NewDTS.exe file. Now, the DTS first queries the 
NETVUPOINT_CONFIG table and then filters the SPOS_COMPLETED_BUS_DAY list to restrict the aggregation to only the 
locations that the Application Server is pointing to. 

DB Download

53191 Issue: Ops failed during DbDownload if the HierStrucID of a Property was greater than 32 kilobytes 

Resolution: Previously, if the HierStrucID of a Property was greater than 32 kilobytes, the SarOps DBDownload failed and prevented all 
Workstations at that Property from starting as it was attempting to save the HierStrucID value to a 16-bit integer. This has been 
correct by modifying the DbDownloadHandler.dll file. 

Direct Posting Service

26194 Issue: The Posting of checks that have been Reopened or Adjusted in large databases may fail due to DPS having to run a full table 
scan of checks table. 

33964 

Resolution: Previously, when processing Reopened or Adjusted Checks, DPS could possibly timeout as it was running a full table scan 
against the CHECKS table, resulting in very costly and long-running queries. This issue was more likely to occur in large multi-
organizational environments. This has been corrected by modifying the NewDTS.exe and DirectPostingService.exe files. 
Currently, the cost of queries that are run when processing Reopened/Adjusted Checks has been optimized. 

30123 Issue: When the Direct Posting Service (DPS) was left untouched for an extended period, the SPOS_COMPLETED_BUS_DAY table 
was not updated at the Start of Day (SOD) 

34234 

Resolution: Previously, when the Direct Posting Service (DPS) was left untouched for an extended period of time, the 
SPOS_COMPLETED_BUS_DAY table was not updated at the Start of Day (SOD) as expected. This has been corrected by 
modifying the DirectPostingService.exe file. Currently, DPS does not depend on the SOD to update the 
SPOS_COMPLETED_BUS_DAY table. 

EMC

41728 Issue: The standard loopback address of 127.0.0.1 caused problems 

Resolution: Previously, entering the standard loopback address of 127.0.0.1 as the Host Name caused problems. This has been corrected by 
modifying the EMC.exe file. Currently, the standard loopback address,127.0.0.1 is prevented from being entered in to any 
computer name/IP field in the entire EMC. 

45426 Issue: The Context Sensitive Help (CSH) text for the Credit Card Merchant Group module-> Batch Number field was inaccurate 
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The CSH text for the Batch Number field located in the EMC-> Enterprise level-> Credit Card Merchant Group-> 
Locale/Settlement tab was inaccurate. The CSH text for this field has been updated to read as follows: 

In this field, enter a value that is used to indicate the next sequence number. This number increments by one each time a 
new batch is transferred (if the number of records in the batch are less than the Max Batch Value setting for the associated 
driver) or the next batch segment transferred (where the number of records in the batch are greater than the CC Driver 
Max Batch Value). It is used by the CC processor to detect duplicate batches. This value for this field is provided by the 
bank or processor; the value range is 1-999, and it resets automatically to "1" after "999" has been reached.

45759 Issue: Context Sensitive Help (CSH) for the Credit Card Driver option [Reverse Unused Authorizations] needed clarification 34909 

Resolution: Previously, the CSH text for option [Reverse Unused Authorizations] in the EMC-> Enterprise level-> Setup tab-> 
Hardware/Interfaces-> Credit Cards-> Credit Card Drivers-> General tab-> Configuration section did not caution the user 
that enabling the [Reverse Unused Authorizations] option when the CAPMS Credit Card Driver does not support reversal 
authorizations could cause a batch transfer failure. This has been corrected. The CSH text for option [Reverse Unused 
Authorizations] now reads as follows: 

This processor specific option will use the zero-payment records to submit a reversal authorization. This reverses any hold 
amount the bank may have placed on the card due to the previous authorization. Turning this option on will automatically 
enable Include $0.00 Payment Records. This option should only be enabled when the processor supports reversal 
authorizations. If a reversal authorization is sent to a processor that does not support reversals, a batch transfer failure 
may result.

49394 Issue: The About Simphony EMC information box displayed the incorrect version number 

Resolution: Previously, the About Simphony EMC information box displayed the version number of EMCFramework.dll and not the 
version number of EMC.exe. This has been corrected by modifying the EMCFramework.dll file. 

Install

51318 Issue: DbUpgrade logged an unhelpful message to the SimphonyInstall.log file when upgrading a 9700 database with schema version 
88 to Simphony 

35055 

Resolution: Previously, when upgrading a 9700 database with schema version 88 to Simphony, the DbUpgrade logged an unhelpful message 
to the SimphonyInstall.log file. This did not prevent users from completing the installation. However, it left the system in a non-
functional state. This has been corrected by modifying the dbupgrade.exe file. Currently, the following error message is 
displayed if the DbUpgrade encounters a 9700 database outside the scope of the current DbUpgrade: 

Cannot upgrade a 9700 database newer than version X. This 9700 database is version Y

For example: “Cannot upgrade a 9700 database newer than version 88. This 9700 database is version 89". 

KDS

48450 Issue: Voiding all Menu Items of a Check caused the Order Chit to display at the top of the KDS Display when Dynamic Order Mode 
(DOM) was enabled 

34998 

Resolution: Previously, when DOM was enabled, if all Menu Items of a Check were voided, the Order Chit was sorted to the top of the KDS 
Display. This behavior is by design. Any Order Chit that contains all voids is sorted to the top in List Mode, and to the front in 
Chit Mode of the KDS Display regardless of whether DOM is enabled 

49396 Issue: The Kitchen Display System (KDS) did not receive Orders when a Workstation 4 LX (WS4LX) was configured as a KDS 
Controller and Display 

Resolution: Previously, when a WS4LX was configured to be a KDS Controller and Display, the Workstation did not receive the KDS 
Orders. Additionally, a KDS error appeared on the client attempting to send the KDS Order. It was determined that under certain 
circumstances the application would not handle an error condition when attempting to delete the current KDS log file. This 
condition would cause the KDS controller to not complete its normal start up sequence nor process. This has been corrected by 
modifying the EGatewayDefs.dll and SystemServices.dll files. 

NewDTS

26905 Issue: Needed Simphony to populate additional columns in the Reporting database MENU_ITEM table to align with mymicros.net 
Interactive Reports 

34127 

Resolution: Previously, mymicros.net added a few new columns to the MENU_ITEM table to allow some Menu Item reports to run without 
having to join to a bunch of different tables. Simphony was not populating these columns, causing the reports to display 
incorrectly. This has been corrected by modifying the NewDTS.exe. NewDTS will now correctly populate the 
familyGroupNameMaster, majorGroupNameMaster, familyGroupReportID, and majorGroupReportID columns. 

Note: Simphony will populate those columns when new Menu Items are created, or when the Name, Report Group, 
Major Group, or Family Group of an existing group are modified in the EMC. 

29559 Issue: During Remote Distribution, NewDTS posted duplicate Menu Item entries to mymicros.net 34190 

Resolution: Previously, during Remote Distribution, NewDTS posted duplicate entries in mymicros.net EMS_MENU_ITEM, MENU_ITEM 
and MENU_ITEM_PRICE tables. The inaccurate posting occurred as the NewDTS did not prevent multiple copies of the 
Definitions job from running parallelly on different application servers. As a result, under certain circumstances, such as when 
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there is a large number of changes (distribute) combined with a large number of application servers, two instances of NewDTS 
posted duplicate Menu Items. 

This has been corrected by enhancing the Definitions job to allow multithreading of the Definition job itself, rather than running 
multiple instances of the Definitions job. The change was implemented by modifying the NewDTS.exe file. 

Ops

27125 Issue: Running services on more than one port caused issues on Windows CE Workstations 34023 

Resolution: Previously, when multiple services were running on more than one port of a Windows CE Workstation, the Web Server did not 
launch properly and one of the services failed. This issue was not reproducible in the current release. 

35643 Issue: SarOps crashed while running the Pickup Check SIM script 

Resolution: Previously, when running a Pickup Check SIM on a Win32 client, which also served as the OLC/OTC, SarOps intermittently 
crashed. This has been corrected by modifying the EGatewayClientXXXCpp.dll. 

43761 Issue: The mTablet froze and became unusable after recovering from a brief power interruption to the mStation 34836 

Resolution: Previously, in certain occasions, after recovering from a brief power interruption to the mStation, the mTablet took several 
minutes to recover or did not recover at all, making the mTablet unusable. The devices had to be restarted after leaving them 
undocked and powered off for several minutes to bring them to a functional state. This issue was not reproducible in the current 
release. 

43862 Issue: Undocking an mTablet configured as a permanently docked Workstation did not prevent stay down users from ringing in checks 34840 

Resolution: Previously, undocking an mTablet configured as a permanently docked Workstation either by disconnecting it from the base or a 
power loss to the base, did not prevent stay down users who were not at the sign in screen from ringing additional checks. The 
mTablet went offline and allowed transactions to continue with a "Work Offline" prompt every time a check was created. This 
has been corrected by modifying SarOpsMM.exe file. Currently, an mTablet configured as a permanently docked tablet cannot 
begin checks while in an undocked state. 

46486 Issue: SarOps on Win32 clients could crash when the EMC-> Workstation Status/Control -> Live Status option was enabled at the 
same time a client with peripherals such as a Cash Drawer was undergoing a DBDownload 

34916 

Resolution: When EMC-> Workstation Status/Control -> Live Status option is enabled, it queries the Workstations to get the status of the 
peripherals. When changes are made in the EMC, they are sent to the WS in either a background DBDownload or a forced 
DBDownload. When a DBDownload occurs, it also re-initializes all of the peripherals. When these two operations occurred at 
the same time on a Win32 machine running SarOps that also had a Cash Drawer connected, SarOps could crash. This has been 
corrected by modifying the SarOps*.exe. 

48631 Issue: In certain instances, check Replay resulted in missing journal entries in mymicros.net 

Resolution: Previously, when a check was created and updated across three Offline Workstations a journal entry was not posted to 
mymicros.net. A journal from when the check was created and tendered were produced, however, an entry from when Menu 
Items were added were not displayed in the mymicros.net Audit and Analysis Report. It was determined that this error occurred 
due to an issue with the New Data Transfer Service (NewDTS). When the NewDTS moved journal entries from Simphony to 
mymicros.net, if it could not locate a Revenue Center for the entry (Revenue Center ID was '0') it did not move the journal entry 
to mymicros.net, yet would still mark the MoveFlag of the entry to True. This has been corrected by modifying the SarOps.exe 
file. 

52403 Issue: An mStation's Serial number was not written correctly to the POS_JOURNAL_LOG table 

Resolution: Previously, the Serial number of the mStation was incorrectly written to the POS_JOURNAL_LOG table when the mTablet was 
undocked from the mStation. However, the Serial number of the mStation was correctly written to the SarOps log. This has been 
corrected by modifying the SarOps*.exe file. 

PMC Reports

42841 Issue: On Win32 Workstations (WS), when Operators attempted to view PMC Reports and the WS’s Internet Explorer (IE) security 
settings were set to the Medium level, an IE security error message was received 

Resolution: Previously, after a PMC Report was generated on a Win32 WS and the Operator clicked on the "Full Screen" viewing option, an 
about:security_SarOpsWin32.exe IE error message was displayed. At this point, the Operator has the option to close the 
window by clicking on the 'Close' button or to click on the 'Add' button. MICROS recommends to click the 'Add' button so that 
'SarOpsWin32.exe' is added to the WS’s list of IE 'Trusted sites' zones. Once completed, PMC Reports will display as 
expected. In this instance, no code changes were required since this is an IE security configuration issue. 
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Printing

50275 Issue: The mStation Mini Printer returned an error after the mStation recovered from a power loss 

Resolution: Previously, when the mStation recovered from a power loss, the first print job sent to the mStation Mini Printer returned a 
"Printer Failure" error message even though the printer was printing successfully. In addition, the print job was sent to the 
backup printer resulting in printing the same job twice. This has been corrected by modifying the SarOpsMM.exe file. 
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Simphony 1.6 Maintenance Release 6

This article is a quick reference guide to features, enhancements, and revisions for Simphony 1.6 Maintenance Release 6. 
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◾ 2 Document Overview 

◾ 2.1 Terminology
◾ 3 Obtaining/Installing the Software
◾ 4 New Features
◾ 5 Enhancements
◾ 6 Revisions
◾ 7 See also

Prerequisite Knowledge 

This document assumes the reader has the following knowledge or expertise: 

◾ Understanding of basic network concepts 
◾ Experience with Microsoft Windows platforms and terminology 
◾ Familiarity with this product line and its hardware, software, and peripherals 

Document Overview 

For the printable collection for this version, see 1.6 Collection

This document includes the following sections: 

What's New
This section describes new features in this software release. A new feature is one that provides capabilities 
that were not available in previous versions. 

What's Enhanced
This section describes enhancements in this software release. An enhancement is a change made to improve or 
extend an existing feature, under the following criteria: 

◾ The basic feature or functionality already exists in the previous release. 
◾ The change adds to or expands on the current process — it does not replace it. This differs from a 

revision that corrects a problem. 

What's Revised
This section describes issues that have been corrected. A revision is a correction made to an existing form, 
feature, or function, using the following criteria: 

◾ The item must be part of the previous version. 
◾ The change must replace the current item or remove it from the application. 

Terminology 

◾ A Fix ID is an internal tracking number used by R&D. This ID is primarily used by R&D personnel; it is helpful for mapping fixes to documented 
items. 

◾ A CR# is a "Change Request ID" that is generated during the escalations process. When a case is started at the Support Center and the issue is 
determined to be an application defect, a Change Request is created, informing R&D that an issue needs to be fixed. 
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New Features 

There are no new features in this version.

Enhancements 

Fix ID Enhancement CR #

CAL

43947 CAL v123 has been added to the Simphony Installation package to standardize the supported version of CAL for all 
clients

With this release, the installation of the Simphony software includes the installation of CAL v123 for all device CAL 
packages. This change has been accomplished by modifying the CAL Packages and Simphony Installer. 

Documentation

40452 The article reviewing Simphony 1.x PC Autosequences has been updated on the Simphony Wiki

See the Simphony 1.x PC Autosequence article for more information. 

41929 Troubleshooting tips for mTablets and mStations (R Series) have been provided

It was requested to provide some troubleshooting tips for Simphony installations utilizing MTablet and mStation. These 
troubleshooting steps are also available in Clarify and were written as Clarify Solutions. Please see the MTablet and 
mStation Troubleshooting Tips article for more information. Additionally, the same article has a link provided for a 
downloadable .PDF version of the article's contents. 

Ops

25531 Support for the use of scales using ounces as a unit of measure has been added. Additionally, support for the use of scales 
has been added for mStations

Formerly, when configuring weighed Menu Items (MI) in the EMC, users had the choice to use either Pounds (Lbs.) or 
Kilograms (Kg.). When weighed MI’s were rung up on an ounce scale (using the Lb. setting) the Ops display screen and 
Guest Checks and Customer Receipts would display the weight as decimal fractions and not ounces. This made it more 
difficult for customers to understand when they received their Guest Checks and Customer Receipts. The models that will 
be supported at this time are the Mettler Toledo-VIVA and Mettler Toledo 8217 scales. Only Serially connected scales 
are supported at this time. With this release, the Mettler Toledo scales identified above are also now supported on 
mStations. 

Note: The following additional control measures have been added: 

◾ Use of the [Item Weight] function key will not be allowed if the scale is not first zeroed. 
◾ Posting non-weighed MI’s will be allowed when the scale is not zeroed. 
◾ Workstations will detect if a different scale has been connected (e.g., Pound to Ounce) and will display an error message to 

users. 

Depending on the configured unit of measurement (Ounces, Pounds or Kilograms), the weighed MI’s weights will display and 
print as shown below: 

Oz. = 0.1
Lb. = 0.01
Kg. = 0.001

See the Scale and Scale Configuration for Simphony Clients article for more information. 

Peripherals

24764 Support for the MICROS Mini Printer has been added

The MICROS Mini Printer is a 32 column printer (the paper is 2 inches in width) that can attach to the side of an mStation 
(right side only). The printer can be configured to perform the following print tasks (among others): 

◾ Customer Receipts 
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◾ Guest Checks 
◾ KDS Runner Chits 
◾ Order Device Output 
◾ Workstation PMC Reports 

Note: This printer does not have Auto-cut capabilities and cannot be attached to a Sales Recording Module (SRM) 
device. Additionally, the EMC-> Property level-> Property Parameters-> Options-> [38-Enable Sales Recording 
Module] option must be disabled. 

See the MICROS Mini Printer Setup article for more information. 

40817 National Type Evaluation Program (NTEP) Certification of Scales is now supported

When a scale is attached to a Workstation and the PMC Diagnostics utility is accessed, a new Certifications tab displays 
"Weights and Measures Information" that includes the version of software that's running on the client and the NTEP 
Certificate number that displays adjacent to the "NTEP CC:" field. NTEP Certificate numbers will vary based on the 
model of Workstation that's using the PMC Diagnostics utility. 

See the Scale, Scale Configuration for Simphony Clients and PMC Diagnostics articles for more information. 

Printing

32538 Support for the Bixolon-SPP-R200II Bluetooth printer for the mTablet and Mobile MICROS devices has been added

The Bixolon-SPP-R200II Bluetooth printer is now supported for both versions of Simphony (v1.x and v2.x) and for all 
supported Mobile MICROS handhelds. The device is also supported on mTablets. See the Bluetooth Printer Bixolon-SPP-
R200II Setup article for more information. 

Revisions 

Fix 
ID Revision CR #

Auto Sequencer

26294 Issue: PC Autosequence Parameter(s) that were configured for a "Called Autosequence" were being ignored 33962 

Resolution: Previously, a "Property Number Parameter" that was configured in the EMC-> Enterprise-> Tasks-> PC Autosequences-> 
General tab would be adhered to when that Autosequence was run individually, but would be ignored when that 
Autosequence was Called by another Autosequence. This has been corrected by modifying the AutoSeq.exe and 
SequencerEngine.dll files. With this release, configured PC Autosequence Parameters are being recognized and adhered to 
when a Called Autosequence is run. 

26480 Issue: Credit Card (CC) Batch and CC Settlement Autosequence steps weren’t efficient and could cause the Autosequence to take 
longer than expected to complete 

33968 

Resolution: Previously, when an Autosequence contained multiple calls to other Autosequences that had create Credit Card Batch and a 
CC Settlement steps configured, the first Autosequence that was called created the CC Batch correctly per Property 
(assuming a "Step Parameter" had been added). The first CC Settlement Autosequence would settle correctly. The 
subsequent Autosequence that was called would again create the CC Batch for the specified Property, but the second CC 
Settlement Autosequence would attempt to settle the CC Batch from the first step before proceeding to the second step. 
Since the first CC Batch was already settled, it would not settle again, but the process of rechecking every record increased 
the amount of time it took to complete each step. After about 15 such Autosequence calls, there were 15 CC Batches trying 
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to be settled, and the Autosequence would time out and eventually stop. Any remaining Autosequence steps were not 
performed. This has been corrected by modifying the AutoseqHandler.dll and SequencerEngine.dll files. No changes to 
configuring Autosequences in the EMC are required. Currently, called CC Batch and CC Settlement Autosequence steps 
perform as expected. 

CAL

31957 Issue: Client Application Loader (CAL) version 123 has been added to the Simphony Installation package to standardize the 
supported version of CAL for all clients 

Resolution: With this release, the installation of the Simphony software includes the installation of CAL v123 for all device CAL 
Packages. This change has been accomplished by modifying the CAL Packages and Simphony Installer. 

35886 Issue: When CAL’ing a Workstation (WS) and when an Application Server had been selected, if users cancelled CAL before a 
Workstation was selected, the Workstation would then attempt to install the WSKDS package 

34819 

Resolution: Previously, when CAL was cancelled after an Application Server had been selected, the WS would attempt to install the WS 
Kitchen Display System (KDS) package (even if the WSKDS package didn’t exist for that platform type). This has been 
corrected by updating to CAL v122 or higher. With this release, CAL v123 will be included with the installation software. 

36216 Issue: The Client Application Loader (CAL) on MICROS PCWS 2015’s did not update the Time Zone setting defined in the EMC 

Resolution: Previously, CAL on MICROS PC Workstation 2015 did not set/update the Time Zone setting defined in the EMC. CAL 
v123 packaged with the Simphony 1.6 Maintenance Release 6 corrects this issue. CAL v123 will also monitor the Time 
Zone settings and automatically rectify any Time Zone discrepancies. 

Credit Card Batch Process

9618 Issue: The Credit Card Report did not align the Authorization columns properly 32664 

Resolution: Previously, the Credit Card Report did not align the Authorization columns, (e.g., # and Auth) correctly as the primary 
authorization did not lineup with the secondary authorizations which were aligned with the header as expected. This has 
been corrected by modifying the ECCServer.dll and EMC.exe files. 

26500 Issue: The BatchStatus column located in the CCBATCH_HEADER table in the Transactional database was not getting updated 
correctly during the Credit Card Settlement process 

33969 

Resolution: Previously, when a CC Settlement was taking place, only two out of ten possible Batch Statuses were being used to populate 
the CCBATCH_HEADER. BatchStatus column in the Transactional database (Statuses 1 and 2). This could possibly cause 
two processes or users to attempt to settle the same CC Batch at the same time. This has been corrected by modifying the 
ECCServer.dll, EMCHandler.dll and EMC.exe files. All of the possible Batch Creation Statuses are listed below: 

Batch Creation Status List

BATCH_UNKNOWN = 0; 
BATCH_CREATING = 1; 
BATCH_CREATED = 2; 
BATCH_CREATE_FAILED = 3; 
BATCH_REPORT_CREATING = 4; 
BATCH_REPORT_CREATED = 5; 
BATCH_REPORT_CREATE_FAILED = 6; 
BATCH_TRANSFERRING = 7; 
BATCH_TRANSFERRED = 8; 
BATCH_TRANSFER_FAILED = 9; 

Database

25228 Issue: Training Checks that were closed with a Credit Card (CC) payment were not getting Batched (as expected) but their 
"Closed" status was not getting updated in the Transactional database 

33875 

Resolution: Previously, Training Checks closed with a CC were not having their “Closed” status updated in the Transactional database. 
This resulted in the items rung up on those checks to always display as having been on a check opened during the “Current” 
business day and they could not be deleted. This has been corrected by modifying SarOps.exe. 

25257 Issue: Credit Card (CC) Batch creation sometimes failed on checks that were heavily manipulated (Split, Added-to, Transferred) 33876 

Resolution: Previously, CC Batch creation failed on checks that were Split and Added-to or Transferred because during the CC Batch 
process there was a deadlock where one process had a Read lock on the checks database rows while another was attempting 
to write an updated status which caused a timeout. This has been corrected by modifying the ECCServer.dll. 

26123 Issue: Credit Card (CC) Batch creation sometimes failed on checks that were heavily manipulated (Split, Added-to, Transferred) 33937 

Resolution: Previously, when multiple Check manipulations (Split, Added-to, Transferred) were performed on a check that originally 
had a Credit Authorization (Auth) associated with it, the subsequently generated checks would erroneously be tagged as 
having an outstanding CC Auth associated with them, but since no CC Auth was present on them, the CC Batch failed. This 
has been corrected by modifying the ECCServer.dll. 

Documentation

42240 Issue: More detail needed to be provided for the setup of the Online/Offline Heuristic Algorithm Operation Timeout module and 
Heuristic Algorithm Report introduced in Simphony 1.6 Maintenance Release 5 

34785 

Resolution: See the SarOps Online/Offline Heuristic Algorithm Setup article for more information. 
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EGateway

14664 Issue: When running Simphony on an All-in-one Server, Workstations (WS) would Begin checks and Service Total them, but 
threw 'Undefined error code received from gateway' errors when trying to Tender or Cancel those checks. 

32788 

Resolution: Previously, when running Simphony on a Server that was running both the Simphony application and Database, the WS 
would Begin checks and Service Total them, but would throw an 'Undefined error code received from gateway' error 
when trying to Tender or Cancel those checks. This has been corrected by modifying the TotalPostingHandler.dll file. 

EMC

6744 Issue: When confirming the “Search results were limited by Max Records to Show parameter: [value]” message, the 
Window's focus switched to an External application 

30927 

Resolution: Previously, confirming the “Search results were limited by Max Records to Show parameter: [value]” message caused 
the Window's focus to switch to the most recently opened External application which was running in the background. This 
has been corrected by modifying the EMC.exe file. 

30526 Issue: The Context Sensitive Help (CSH) for the EMC-> RVC Parameters-> Mobile Micros-> [6-Use Numeric Screen for Ref 
Entry with Credit Card Store Key] option was incomplete 

Resolution: Previously, the CSH text was unclear for the [6-Use Numeric Screen for Ref Entry with Credit Card Store Key] option 
and required editing. This has been corrected by modifying the EMCText.xml. The updated CSH text now reads as follows: 

If set, the Revenue Center assigned Numeric Entry Screen is used for Reference Entry with the Credit Card Story Key 
Function. If not set, the Revenue Center assigned Alpha Entry Screen is used. The Numeric screen uses larger keys 
than the Alpha screen and is therefore easier to use when entering numbers such as a credit card account number on 
a Mobile MICROS device.

31168 Issue: When new Discounts were added, all of the available Transaction and Item check boxes were preselected by default on the 
“Exclusivity” tab 

Resolution: Previously, when adding new Discounts by accessing the EMC-> Property-> Sales-> Discounts module, all of the available 
Transaction and Item check boxes were already selected by default on the “Exclusivity” tab. This default setting disallowed 
the new Discount to interact with any other Discounts. This has been corrected by modifying the EMCData.dll. With this 
release, all of the check boxes within the Exclusivity tab are not selected by default. 

38355 Issue: Audit Trail function in the Menu Item Maintenance module caused timeouts and communication errors 34630 

Resolution: Previously, using the “Audit This Record” link in the Menu Item Maintenance module produced timeouts and 
communications errors making the EMC unresponsive. These errors occurred when the Audit Trail function attempted to 
access sufficiently large databases. This has been corrected by modifying the EMCData.dll and EMCClient.dll files. With 
this release, Audit Trail search results are generated without a delay. 

40245 Issue: Any names entered into the “Media File” and “Idle Media File” fields in the EMC-> RVC-> User Interface-> 
Workstation-> Touch Screen Design module were not saved when using the Touchscreen tab in the Touchscreen Design 
module 

34688 

Resolution: Previously, when using the Touchscreen tab in the Touchscreen Design module, any file name that was typed within the 
“Media File” and “Idle Media File” fields caused the 'Save' button to activate. The Touchscreen could be saved, but when 
the module was reopened, the "Media File" field names remained blank. This has been corrected by modifying 
EMCData.dll. 

42836 Issue: EMC allowed to enable two different Item Weight types within a Property 

Resolution: Previously, when selecting either [4 - Use Item Weight in Kilos] or [42 - Use Item weight in Ounces] options from the 
EMC-> Property-> Property Parameters-> Options tab, the EMC did not disable the other parallel option as expected. This 
has been corrected by modifying the EMC.exe. Currently, when a user enables one of the Item Weight options, the EMC 
disables the alternate Item Weight option. 

45910 Issue: The Heuristics Operations Timeout module Online/Offline sliders did not change the “Average” and “Maximum” Second 
values until the changes were “Saved” in the EMC 

Resolution: Previously, when adjusting the 'Heuristics Operations Timeout' module Online/Offline sliders, the “Average” and 
“Maximum” Second values did not change until they were “Saved” in the EMC. This has been corrected by modifying the 
EMC.exe and EMCText.xml files. With this release, the Online/Offline sliders may now be adjusted from either “Data 
Collection” or “Decision Making” mode and the “Average” and “Maximum” Second values will immediately increment as 
the sliders are adjusted. 

EMS

31386 Issue: The EMS Batch Service log file was not being maintained as expected 

Resolution: Previously, the EMS Batch Service log was not rotated and continued to grow as entries were logged. This produced a large 
log file which would use excessive disk space. The large size of the log file also affected performance of the EMS Batch 
Service. This has been corrected by modifying the EMSBatchService.exe file. The EMS Batch Service was modified to 
rotate the log file so that entries are properly maintained. 

31389 Issue: The EMS Batch Service log files were written in 12 hour format and did not display an AM/PM time designation 

Resolution:
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Previously, the EMS Batch log files were posting in 12 hour format without any AM/PM designations. This resulted in 
confusing readers as to what the time really was. This has been corrected by modifying the EMSBatchService.exe file. 
Currently, the EMS Batch Service log file displays time in 24-Hour format, thus eliminating the need for AM/PM 
designations. 

KDS

7011 Issue: When Dynamic Order Mode (DOM) was enabled, cancelled transactions were not getting updated on KDS Displays 31419 

Resolution: Previously, when DOM was enabled in the EMC-> Order Devices-> KDS tab-> Dynamic Order Mode section, cancelled 
orders were not getting modified on KDS Displays to inform employees that the order no longer needed to be prepared and 
delivered. This has been corrected with the integration of a newer version of KDS and various KDS enhancements. 
Currently, cancelled transactions will display a large red “X” on the cancelled check that displays on the KDS system. 

KDS

42657 Issue: Kitchen Display System (KDS) Controller database files were not versionable 

Resolution: Previously, the Kitchen Display System (KDS) database files were not versionable, which could cause issues when Schema 
changes are made to the database. This has been corrected by adding a new registry key to the KDS Controller so that the 
PosToKdsHander.dll and KdsToPosServ.dll files can identify the correct database file version. The change was 
implemented by modifying the DbDownloadHandler.dll and KdsToPosServ.dll files. 

45429 Issue: Kitchen Display System (KDS) posting did not post all information to the Simphony database 34894 

Resolution: Previously, KDS posting did not post all the information to the Transaction database’s KDS_DETAIL table. When sending 
suborders to the KDS Controller, Ops sent the device index instead of the device ID. The reported issue occurred when the 
Order Device Index was different from the Order Device ID. This has been corrected by enhancing the database lookups that 
determines the Order Device Index. The change was implemented by modifying the TotalPosting.dll file. 

mymicros.net

22555 Issue: The Serving Period Financial report incorrectly added tips to the Tender Media Report section 33642 

Resolution: Previously, the Serving Period Financial Report incorrectly added tips to the Tender Media Report section, and as a result, 
overstated the actual Tender/Media amount. This issue created an inconsistency between the Serving Period Financial report 
and the Revenue Center Financial Report totals. This has been corrected in this release. Currently, Serving Period Financial 
Report calculates tips in the "Bank Due" section of the report. 

OLC/OTC

42938 Issue: Workstations did not allow Operators to Sign In after transitioning to Yellow Mode 34804 

Resolution: Previously, when attempting to Sign in on a Workstation that was transitioned to Yellow Mode, Ops threw a “Must Clock 
In to ^” message and the Operator was prevented from Signing In. It was reported that the Employee’s current Revenue 
Center (RVC) and the RVC assigned by the Job Code module did not Sync properly while in Yellow Mode. This has been 
corrected by modifying SarOps.exe. 

Ops

22227 Issue: Voiding a Menu Item that was added to a Check using the '@/For' key did not void the attached VAT values 33600 

Resolution: Previously, when several Menu Items were added using the '@/For' key and a Menu Item was voided, Ops did not void the 
VAT values attached to the voided Menu Item. This caused Ops to calculate the Guest Check totals incorrectly. The same 
issue occurred when Menu Items were added using the numeric keys. This has been corrected by modifying the SarOps.exe 
file. 

23473 Issue: When using MICROS Suites Management v3.0, Voids performed on checks picked up through a SIM script rewrote Credit 
card (CC) Authorization details 

33721 

Resolution: Previously, CC Auth data was rewritten under certain circumstances (when using Suites v3.0), such as picking up check a 
through SIM and then Voiding all of the items from the check. This had a large impact on Suites customers as Check 
Regeneration (Regen) could not be successfully run once bad data was entered on a check. Check Regen is the main report 
used by most accounting departments to reconcile events. Other times when CC Auth data was rewritten (especially the 
CHECK_DETAIL table’s detailtype 8, which is PMS Discretionary data) the CC Batch Settlement failed due to the 
rewritten (incorrect) data. This reported issue also caused the failure of any further Check Regeneration, a Suites process 
whereby the details of the event's checks were moved from the Transactional database to the Suites database. The Check 
Regen would fail with a Transaction Services log error as shown here: 

1/17/2013 9:58:52 AM - INFO - Transaction Services experienced an error and 
cannot continue to process this request. Reason: Check details from server 
arrived in an unexpected order. Error Code: InternalProcessingError

This has been corrected by modifying the SarOps*.exe. 

27703 Issue: The rounded Tare Weight value was incorrectly displayed on Workstations and Guest Checks when the weight was 
calculated in pounds (lbs.) 

34056 

Resolution: The 'Tare Weight' field allows weighed Menu Items to be configured in thousandths (0.0000) of a Lb. from the Menu Item 
Maintenance-> Menu Item Definition module. Previously, Workstations and Guest Checks incorrectly displayed the 
rounded Tare Weight in tenths or hundredths. It was reported that even though the rounded Tare Weight was incorrectly 
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displayed, the Workstation calculated the Tare Weight as expected. This has been corrected by modifying the SarOps.exe. 
Currently, the value for Weighed Menu Items displays in the correct format. 

29764 Issue: Intermittently, the WebServer would crash when a new ServiceHost.xml file was generated and deployed 34204 

Resolution: Previously, the WebServer would sometimes crash when a new ServiceHost.xml file was deployed. This has been corrected 
by modifying the PosToKdsHandler.dll along with fixes that were implemented with the release of Simphony v1.6 MR4. 

31123 Issue: Security option [12 - Mag Card Entry Required for Employee ID] was not enforced for Authorization tasks when enabled 34297 

Resolution: Previously, if the EMC-> Property-> Property Hardware-> Workstations-> Options-> Display/Security-> Security option-> 
[12 - Mag Card Entry Required for Employee ID] was enabled, Operators could only Sign in on a Workstation using 
their Mag Card as expected. However, any Manager Authorization task would still accept a manual entry of their Employee 
ID number. This has been corrected by modifying the Ops.exe. 

35457 Issue: Offline rounds fail to replay when multiple Workstations (WSs) were in mixed Offline states 34501 

Resolution: Previously, a WS would only broadcast a change of check ownership on a Tender/Service Total function. This caused 
duplicate Round numbers on WSs in mixed Offline states. These duplicate Rounds resulted in a failure to replay checks. 
Now, when a different WS picks up a check owned by another WS, a broadcast is sent to the owning WS that it no longer 
owns the check. This enables Operators to override the check owned by a different WS in the event of mixed offline states 
(Red Mode = disconnected from everything, Yellow Mode = disconnected from the Application server but able to 
communicate with other WSs). 

This has been corrected by modifying the SarOps*.exe file. 

41378 Issue: The phrase 'Manually Weighed' was required to be renamed to 'Manual Weight'

Resolution: National Type Evaluation Program (NTEP) compliance required that the phrase 'Manually Weighed' had to read as 'Manual 
Weight' on the Check Detail Area on Ops and on Customer Receipts and Guest Checks. This has been corrected by 
modifying the Ops.dll. 

41698 Issue: Unable to Authorize Credit Cards (CC) when the 'RevCtrID' was very large 34765 

Resolution: Previously, when a Revenue Center (RVC) was created with a large 'RevCtrID' (Object) number, it functioned normally 
except when Authorizing CCs due to an allowed value was not handled correctly by Simphonyy. Currently, a RVC can be 
created with a large 'RevCtrID' number and can Authorize CCs now that allowed values are handled correctly by Simphony. 
This has been corrected by modifying the SarOPsXXX.exe file. 

42064 Issue: Sub-order messages from Ops to multiple KDS Controllers were missing the required reference information which could 
cause orders not to appear on the correct KDS Displays as expected 

34772 

Resolution: Previously, for sites that have multiple KDS Controllers, Ops sent Sub-order messages that contained only an Order Device 
ID number which wasn’t enough reference information to send the order to the correct KDS Display. The missing reference 
data is important in such cases because it's needed to determine which Revenue Center’s (RVC) Order Device the order was 
meant for. This has been corrected by modifying the SarOpsXXX.exe, KdsToPosServ.dll and DbDownloadHandler.dll files. 
Currently, the RVC HierStrucId number has been added to the Ops Sub-order message to alleviate KDS device output 
confusion. 

42102 Issue: Intermittently, Ops crashed after upgrading to Simphony v1.6 MR 5 

Resolution: Previously, when upgraded to Simphony v1.6 MR5, Ops clients crashed after displaying an error message. This issue 
occurred frequently on Windows 32 clients. This has been corrected by modifying the EGatewayClient.dll. 

42711 Issue: Windows 32 and mTablet Workstations displayed the time and price of checks together on the Open Check SLU 

Resolution: Previously, Windows 32 and mTablet Workstations displayed the time and the price elements of Guest Checks together and 
on the same line in the Open Check SLU. This has been corrected by modifying the SarOps.exe file. 

43927 Issue: When a mStation (base unit) had a loss of power, any printers connected to the unit failed to reinitialize, thus causing a 
failure to print 

3484 

Resolution: Previously, when an mStation's base unit lost power and then regained it, the mTablet would display an "Initializing 
Devices" message, but it would fail to reconnect to any printers that were connected to the mStation base unit. The only way 
to resolve the issue was to reboot the mTablet (or to close and reopen SarOps). This has been corrected by modifying the 
MicrosDevices.dll, PrintController and Printing.dll files. 

45229 Issue: Ops crashed when the [Manual Weight] function key was used 

Resolution: When the [Manual Weight] function key was pressed to manually enter the weight of a Menu Item, Ops crashed. 
Consequently, Ops threw an exception error in the log as the unit descriptor (e.g., Oz., Lb. and Kg.) was not set for Manual 
Weight and scale weight functions. This has been corrected by modifying the SarOps.exe file. 

45446 Issue: A user would receive a You are not clocked in message when attempting to Sign In on a Workstation after it 
transitioned from Online mode to Yellow mode 

34803 

Resolution: Previously, if an Offline Labor Cache (OLC) was configured and a user Clocked In on an Online Workstation and then that 
Workstation lost its connection with the Application server (Yellow Mode), when the user attempted to Sign In, they’d 
receive a You are not clocked in message. It was determined that the OLC wasn’t synchronizing with the time-keeping 
records in the database often enough. This has been corrected by modifying the SarOps*.exe. With this release, the OLC 
remains synchronized with the database when Workstations are Online. 
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45911 Issue: The [Manual Weight] function did not include the “Tare Weight” setting 

Resolution: When the Menu Item weight was manually entered using the [Manual Weight] function key, Ops did not include the “Tare 
Weight” setting from the Menu Item Definition record of the Weighed Menu Item. This has been corrected by modifying the 
SarOps.exe file. 

47063 Issue: Ops VAT totals were incorrect when multiple Menu Items were entered on the same Detail line had an Automatic Discount 
applied 

34946 

Resolution: Previously, when multiple Menu Items were entered on the same Detail line had an Automatic Discount applied, Ops VAT 
totals were incorrect. Currently, Ops VAT totals are correct when multiple Menu Items are entered on the same detail line 
that has an Auto discount applied. This has been corrected by modifying the PosLib.dll and SarOps*.exe file. 

47652 Issue: The Status bar on the Sign In screen kept flashing when the Workstation started in Offline mode 

Resolution: Previously, when the Workstation was started in Offline mode, the status bar on the Sign in screen kept flashing as the Ops 
checked for a connection with the EGateway in the background. This has been corrected by modifying the SarOps.exe file. 

47940 Issue: Using the [Transaction Void] function on Menu Items with Automatic Discounts and a Manual Discount applied to the 
Check miscalculated the Amount Due 

Resolution: Previously, when an Operator pressed the [Transaction Void] function key to void Menu Items bundled with an Automatic 
Discounts and then applied a Manual Discount, Ops did not calculate the Guest Check balance accurately. Ops incorrectly 
applied the Automatic Discount twice to the Guest Check; once with the Manual Discount and once without applying the 
Manual Discount, which lead to overstate the "Amount Due" to the customer. This has been corrected by modifying the 
SarOps.exe file. 

48138 Issue: Automatic Discounts were not calculated when Menu Items were voided using the [Transaction Void] function 

Resolution: Previously, when the [Transaction Void] function was used to Void Menu Items bundled with Automatic Discounts, Ops 
did not void the Automatic Discounts. As a result, the "Total Due" amount on the Guest Check was overstated. This has 
been corrected by modifying the SarOps.exe file. 

48141 Issue: Using the [Transaction Void] function on Menu Items with Automatic Discount showed a negative Automatic Discount 
amount 

Resolution: Previously, when the [Transaction Void] function key was used void Menu Items bundled with Automatic Discounts, Ops 
showed the Automatic Discount as a negative value. As a result, Ops did not calculate the Guest Check balance accurately. 
This has been corrected by modifying the SarOps.exe file. Currently, when the [Transaction Void] function is applied to 
Menu Items with Automatic Discounts, the Automatic Discount is shown as a positive value and the Guest Check balance is 
calculated correctly. 

48512 Issue: SarOps would crash with a Win32 KDS Controller and scheduled Kitchen Themes configured 

Resolution: Previously, SarOps would crash when Operators attempted to send orders to the KDS Display with active scheduled Kitchen 
Themes with Order Type routing configured. This has been corrected by modifying the EMCData.dll. The issue appeared to 
be caused when cloning a Property and the Order Type ID values. With this release, when cloning a Property, it no longer 
uses the Order Type ID, rather now it uses the Order Device Index values. 

PMC Reports

42841 Issue: On Win32 Workstations (WS), when Operators attempted to view PMC Reports and the WS’s Internet Explorer (IE) 
security settings were set to the Medium level, an IE security error message was received 

Resolution: Previously, after a PMC Report was generated on a Win32 WS and the Operator clicked on the "Full Screen" viewing 
option, an about:security_SarOpsWin32.exe IE error message was displayed. At this point, the Operator has the option to 
close the window by clicking on the 'Close' button or to click on the 'Add' button. MICROS recommends to click the 'Add'
button so that 'SarOpsWin32.exe' is added to the WS’s list of IE 'Trusted sites' zones. Once completed, PMC Reports will 
display as expected. In this instance, no code changes were required since this is an IE security configuration issue. 
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43870 Issue: Property Management Console (PMC) error messages did not render properly when the mTablet was on Portrait mode 

Resolution: Previously, when the mTablet was run on Portrait orientation, the PMC errors message windows did not adjust properly to 
the screen resolution. When the error message had a lengthy text, the dialog box failed to wrap the message within the 
screen resolution. This has been corrected by modifying SarOps.exe. 

NewDTS

22504 Issue: The Transactional database PCASEQ_LOG table was not being maintained 

Resolution: Previously, the 'PCASEQ_LOG' table located in the Transactional database was not being maintained and therefore would 
continue to grow in size. This has been corrected by modifying the DbUpgrade.exe, NewDTS.exe and EMC.exe files. A 
new database Purge Job was added to the EMC to manage the saved PC Autosequence log data and can be located by 
accessing the EMC-> Enterprise Parameters-> Purge History-> for the Purge Type-> PC Autosequence Log Data. 
MICROS recommends setting the 'Days To Keep' column to a value ranging from 30-180 days. 

27928 Issue: Multiple Menu Item (MI) Price Changes were not correctly updating the Reporting database for Microsoft SQL Server 
database users 

34074 
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Resolution: Previously, the “effectiveTo” column located in the Reporting database MENU_ITEM_PRICE table was not getting 
updated as expected when users added or changed MI Price Records. Each time a MI Price Record was edited or added an 
additional row in the Reporting database MENU_ITEM_PRICE table was inserted. This caused the MI Sales Reports to 
display extra entries for the same MI. This has been corrected by modifying the NewDTS.exe. 

31151 Issue: The “Effective To” Update logic updated the wrong record(s) in the MENU_ITEM_PRICE 

table located in the Reporting database 

34300 

Resolution: Previously, when a change was made to a particular Menu Item Price record in Simphony, a new record was inserted into 
the MENU_ITEM_PRICE table in the Reporting database, with the current time in the “effectiveFrom” column and a 
NULL value for the “effectiveTo” column. At the same time, the existing record was updated with the current time in the 
“effectiveTo” column. This worked fine the first time a user modified a price, but if a user made further modifications, 
NewDTS would continue to update the “effectiveTo” column of the very first price record, not the most recent one. This 
would lead to multiple records in the MENU_ITEM_PRICE table with a NULL value for the “effectiveTo” column, which 
caused the MI Sales Reports to display extra entries for the same MI. This has been corrected by modifying the 
NewDTS.exe. 

32244 Issue: The Transaction database SEC_AUTH_KEYS table was not getting purged 

Resolution: Previously, the Transaction database SEC_AUTH_KEYS table was not getting purged. This has been corrected by 
modifying the EGatewayService.dll, NewDts.exe, EMC.exe, EMCData.dll, DBUpgrade.xml and DbUPgrade.exe files. 
There is no available setting for purging the number of days in the EMC-> Enterprise Parameters-> Purge History-> Purge 
Type module for Security Authorization Keys. The number of days of Security Authorization Keys data that is retained 
equals the “Purge Job” setting for the Purge Type-> Checks multiplied by two. 

Transaction Services

34215 Issue: When a Check was handled by Transactions Services and Ops concurrently, the Workstation became unusable 34457 

Resolution: Previously, when a Guest Check was handled by an Ops client and Transaction Services concurrently, Ops displayed the 
“Another Workstation has posted another version of the Check” message and did not allow the Operator to Cancel the 
transaction. The Operator had to restart the Workstation to as there was no way to cancel the check. This has been corrected 
by modifying the SarOps.exe and GwCheckStruct.xml files. Currently, when picking up checks, Ops looks for the Check’s 
Round Number and Round GUID. If the version of the check is less than that of the Enterprise, the check is re-read and 
updated; if the round number is greater than that of the Enterprise, another Workstation will post the missing rounds and 
allow the Operator to Pick up the check and proceed. 
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Simphony 1.6 Maintenance Release 5

This article is a quick reference guide to features, enhancements, and revisions for Simphony 1.6 Maintenance Release 5. 
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Prerequisite Knowledge 

This document assumes the reader has the following knowledge or expertise: 

◾ Understanding of basic network concepts 
◾ Experience with Microsoft Windows platforms and terminology 
◾ Familiarity with this product line and its hardware, software, and peripherals 

Document Overview 

For the printable collection for this version, see 1.6 Collection

This document includes the following sections: 

What's New
This section describes new features in this software release. A new feature is one that provides capabilities that 
were not available in previous versions. 

What's Enhanced
This section describes enhancements in this software release. An enhancement is a change made to improve or 
extend an existing feature, under the following criteria: 

◾ The basic feature or functionality already exists in the previous release. 
◾ The change adds to or expands on the current process — it does not replace it. This differs from a revision 

that corrects a problem. 

What's Revised
This section describes issues that have been corrected. A revision is a correction made to an existing form, feature, 
or function, using the following criteria: 

◾ The item must be part of the previous version. 
◾ The change must replace the current item or remove it from the application. 

Terminology 

◾ A Fix ID is an internal tracking number used by R&D. This ID is primarily used by R&D personnel; it is helpful for mapping fixes to documented items. 
◾ A CR# is a "Change Request ID" that is generated during the escalations process. When a case is started at the Support Center and the issue is determined 

to be an application defect, a Change Request is created, informing R&D that an issue needs to be fixed. 
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to authenticate your credentials before downloading 
files. 

New Features 

Fix ID Feature CR #

EMC

30031, 
30652 

Added a new Online / Offline Heuristic Algorithm to determine when a Workstation is to be automatically taken 
Offline or Online

Previously, the Online status of SarOps clients was determined by an application ping between the SarOps client 
and the Enterprise Gateway. The default values that SarOps used were three bad pings at a seven second interval to 
go Offline and one good ping to go back Online, which were manually configurable in the Transactional database. 
The new Online/Offline Heuristic Algorithm will use statistical data collected from previous transactions or from 
background jobs to determine the optimal time for a Workstation to go Online of Offline. See the SarOps 
Online/Offline Heuristic Algorithm Setup article for more information. 

Enhancements 

Fix ID Enhancement CR #

Data Transfer Service

26601 Moved the FCR_* tables in the Transactional database to the Reporting database for the Latin American office

The FCR_CUSTOMER_DATA, FCR_INVOICE_CONTROL, FCR_INVOICE_DATA and 
FCR_TOTAL_DATA tables were moved from the Transactional database to the Reporting database. This was 
performed as a part of the Latin American Region's commitment to support fiscal reporting. 

EMC

24868 The maximum length limit of Barcodes has been increased from of 40 to 512 characters

Support for Pass-Through enabled Barcodes up to a maximum of '512' characters has been added. This has been 
developed for the use of 2D Barcodes used in conjunction with SIM scripts. This has been accomplished by 
modifying the MicrosDevices.dll, MicrosDevicesBridge.dll, PosManagedDevices.dll and SarOps.exe files. To 
enable this feature, perform the following steps: 

1. Edit or create a Barcode Format set that exceeds the former 40 character limit by accessing the EMC-> Property->
Barcode Format Sets

2. Add the 2D Barcode to the Workstation device listing by navigating to the EMC-> Property-> Workstations->
Devices tab.

3. Complete any necessary Barcode Scanner programming
4. Access the EMC-> Property-> Workstations-> Options-> Hardware/Cash Drawer-> [30 – Barcode Pass-Through

Mode] option and enable it and 'Save'.
5. Configure the SIM script accordingly and link it to a touchscreen button to make use of Pass-Through mode to

write to external application.

32713 

Install

23133 Las Vegas Gaming Reports have been removed from the Simphony installation media

Las Vegas Gaming Reports have been removed from the Simphony installation media in order to ensure 
compliance with regulations. This change ensures that upgrades do not overwrite the approved report versions and 
that only the approved versions are always installed. In future, the MICROS Las Vegas office will control the 
reports and the Vegas office should be contacted to obtain the currently approved reports as the reports can be 
modified or upgraded outside the Simphony installer application. 

mymicros.net

31770 Upgrades to mymicros.net v8.1.0 will be supported on Simphony v1.6 MR5

Validation for upgrading the v1.6 mymicros.net database to v8.1.0 has been completed. Simphony v1.6 MR5’s 
default mymicros.net version remains v7.2.0. 

Revisions 

Fix ID Revision CR #

Auto Sequencer
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27154 Issue: Running a manual Start-of-Day (SOD) wrote the incorrect Business date when the Application Server’s time setting was ahead 
of the Greenwich Mean Time (GMT) Time Zone 

34028 

Resolution: Previously, when the SOD was run manually for systems in a Time Zone behind the GMT, the Business date was written 
correctly. When the system’s Time Zone was ahead of the GMT, it wrote the Business date with the calendar date of the GMT, 
which caused it to display as one day behind. This prevented the correct Business date and associated totals from displaying on 
the Ops clients when running PMC Reports. This has been corrected by modifying the EGatewayHandlerUtils.dll. Currently, 
running a manual SOD will utilize the local systems Date/Time settings for the sake of consistency. Additionally, this fix 
changed the PMC reports labeling from "Today" and "Yesterday", to "Current Business Day" and "Previous Business Day". The 
system also determines whether a potential business day increment is required based on whether the SOD is run manually or 
automatically before deciding what the incremented business day should be. For manual SOD’s, running them before noon will 
be today’s business dates and after noon will be tomorrow. For an automatic SOD, the system will not increment the business 
date before the specified time. 

31173 Issue: During a Start-of-Day (SOD) Autosequence, the CARRIED_TOTALS table in the MCRSPOS database was not getting purged 
which caused the SOD Report query to run too long 

33630 

Resolution: Previously, part of the SOD logic involved reading and inserting data to the CARRIED_TOTALS table in the Transactional 
database. This table is used when running Shift reports in order to get accurate Carried Over totals information. However, this 
table was never purged, which caused the query against it to use excessive resources on systems that had been running for a long 
period time. This has been corrected by modifying the SequencerEngine.dll. Currently, the query is running in a more efficient 
manner while retrieving Carried Over totals data for financial reports. 

CAL

6611 Issue: There is a 'Show KDS' check box on the CAL configuration window for Win32 and WinCE Workstations, but when selected, it 
had no affect 

34026 

Resolution: Previously, selecting the 'Show KDS' check box on the CAL configuration window on Workstation s was not working as 
expected. This has been corrected by updating the version of the Client Application Loader (CAL). 

34298 Issue: Upgrading the Client Application Loader (CAL) in a 64-bit environment failed 

Resolution: If the CAL version installed on the service host [CAL 119] did not match the version on the EGateway 
(http://appserver:8080/egateway/download/CAL/win32/setup.exe) [CAL 117], an upgrade to CAL 119 was triggered when the 
Service Host was initialized. However, the upgrade failed because the setup.dat or the Registry settings were set incorrectly for 
the 64-bit environment. As a result, CAL did not start because the service's executable parameter was not set correctly. 

It was determined that in a 64-bit environment, there are two locations where program files are stored: 

1. C:\Program Files\ (which is for all 64-bit programs)
2. C:\Program Files (x86)\ (which is for any 32-bit programs running in the 64-bit environment)

However, the Micros CAL Service parameter for the executable was set to: C:\Program Files\Micros\MCRSCAL\mcrscal.exe, 
whereas the service needed to be pointed to: C:\Program Files (x86)\Micros\MCRSCAL\mcrscal.exe (as CAL is a 32-bit 
program). The prescribed method to work-around the error was to manually amend the “Path to executable:” parameter of the 
CAL service. This has been corrected by modifying the 32-bit and 64-bit CAL packages. Currently, CAL package downloads 
and installs/updates correctly in a 64-bit environment. 

34957 Issue: Offline Labor Cache (OLC) did not start on a Workstation unless it was configured to use port '8080' 34477 

Resolution: Previously, if an OLC was configured to run on any port other than port '8080', the information was not written to the 
ServiceHost.xml and the OLC did not start on the Workstation. It was determined that the SimphonyCALHandler did not update 
the ServiceHost.xml as expected as it only checked if the port number was not '8080' and then added a non-zero entry in the 
ServiceHost.xml. This was corrected by modifying the SimphonyCALHandler.dll to check if the port number is 12359, which is 
the port number for Ops. This is the only time that a '0' entry will be entered in the ServiceHost.xml for a configured OLC/OTC. 

Data Transfer Service

15716 Issue: Editing the Time Card punches containing Paid Breaks were recorded twice in the Reporting (mymicros.net) database would 
result in reporting and possible payroll issues 

32895 

Resolution: Previously, when a manager modified a Time Card which contained a Paid Break, the time record was posted twice in the 
Reporting database. This has been corrected by modifying the NVPDBWriter.dll. Currently, edited Time Card records with Paid 
Breaks are no longer duplicated in the Reporting database dbo.Time_Card_Detail table. 

Database

31728 Issue: Workstation Report Users were created for Organization IDs outside of those that would actually run Workstation reports (e.g., 
download orgID or the MICROS orgID) in the Core_Db.Core_User table 

34353 

Resolution: Previously, when creating Workstation Report Users, the Simphony installer created Workstation Report Users for all 
Organizations, including for those that would not be running Workstation reports. It was identified that this issue was due to the 
Simphony installer creating Workstation Report Users for every Organization ID that is not equal to '0', as can be seen in the 
code below (found inside Install-> Installer-> DBIUtils.cs): 

[// Insert a new User
// TODO: What should the orgLevelID be?
// For now chose any of them
int orgLevelID = 0;
sql = @"select orgLevelID from CORE_ORG_LEVEL";

Page 3 of 9Simphony 1.6 Maintenance Release 5



using (IDataReader rs = dbCoreCon.ExecuteReaderSql( sql, trans ))]

This has been corrected by modifying the installer.exe file. Currently, the Simphony installer searches for valid organization IDs 
in the POS database and only then, will it add Workstation Report Users. 

DB Download

26463 Issue: CE Workstations configured as KDS Controllers would error out and subsequently, the Mag Stripe Reader (MSR) would no 
longer function as expected 

33967 

Resolution: Previously, when WinCE Workstations were configured to be KDS Controllers, upon performing background or full 
DBDownloads, it could result in an error on the Ops display that read: 

Error initializing Micros.Devices.dll
BarCode reader

The error message could be cleared, but the MSR would no longer function, preventing employees from Signing in or swiping 
any payment cards. This has been corrected by modifying the MobileWebServer.exe PosToKdsHandlerWS.dll files. 

Direct Posting Service

22024 Issue: Discounts applied and voided on the same check posted a count of '0' and the amount was equal to the original discount amount 
in the mymicros.net Discount report 

33582 

Resolution: Previously, if a discount was applied to a check and then voided, the Discount report in mymicros.net showed the count as '0'
along with the original discount amount. The expected result was that the count was '2' and the amount was '0.00'. It was 
determined that this was functioning as designed. 

23910 Issue: If a Shared Menu Item was voided, the value posted in the MENU_ITEM_DAILY_TOTAL table was incorrect 33793 

Resolution: Previously, when a Shared Menu Item was voided, half of the Menu Item value was posted in the 
MENU_ITEM_DAILY_TOTAL table when the actual value posted should have been 0.00. However, the correct amount was 
posted in the OPERATIONS_DAILY_TOTAL table (0.00). This has been corrected by modifying the DirectPostingService.exe. 

28789 Issue: The Taxable Sales value shown in mymicros.net Tax Reports was incorrect for Inclusive taxed Menu Items 34140 

Resolution: Previously, the Taxable Sales value in the mymicros.net Tax Report was incorrect for Inclusive taxed items. The value shown 
was the full item price instead of the amount that was being taxed. For example, if the Inclusive tax Menu Item was 110.00 with 
a 10% tax, then the Taxable Sales amount should display as 100.00. It was determined that though the TOTALS table in the 
Transactional database separated these numbers into individual rows, the Direct Posting Service (DPS) did not post the data 
correctly and instead used the full Menu Item price. This has been corrected by modifying the DirectPostingService.exe, 
SystemTaxSummary.xml, SystemTaxSummaryUWS.xml and the RevCtrTaxSummary.xml report template files. 

30601 Issue: Discount allocation records did not inherit Tax[1-8]PosRef from the Parent item which resulted in Menu Items being taxed on all 
tax rates that were active for Discounts, not solely the taxe rate(s) active for the Parent item 

Resolution: Previously, when the Subtotal Discount was allocated among all the discountable items, a Menu Item was taxed on all the taxes 
active for the Discount without inheriting the taxability rules of its Parent item. The Menu Item was taxed even if the Parent item 
was non-taxable. It was determined that the Direct Posting Service (DPS) ignored the taxPosRef taxability rules of the Parent 
item and added all of the taxes together when calculating the Discount taxes for Menu Items. This has been corrected by 
modifying Opsxxx.exe and DirectPostingService.exe files. 

31901 Issue: Ops could not be minimized to the Windows taskbar on an mTablet 

Resolution: Previously, it was reported that when a privileged employee pressed or clicked the [313 - Minimize Application] function key 
in Ops to access the desktop, a mTablet WinCE Workstation would not minimize Ops to the Windows taskbar. Instead, it 
brought up the Windows taskbar while Ops remained on the screen unlike Win32 based Workstations as well as (WS5s) and 
Workstation 5As that minimized Ops to the Windows taskbar exposing the desktop. It was determined that the mTablet 
Workstation was functioning as expected and had no impact on the functionality of the device as the user could still access the 
'Start' button in Windows. 

31987 Issue: mymicros.net Reports displayed incorrect totals when two different VAT taxes and a Discount was applied to a single Check 34380 

Resolution: Previously, it was reported that mymicros.net Reports displayed incorrect totals when a Check with two different VAT amounts 
was closed with a Discount. It was determined that this issue was due to discount totals that were posted via the Direct Posting 
Service (DPS) were being incorrectly calculated in the REPORTINCLTAXTOTAL and REPORTINCLTAXTOTALEXT 
columns of the GUEST_CHECK_LINE_ITEM table in the Reporting database. The algorithm that calculated the VAT for a 
discount across the Menu Items did not handle Menu Items being taxed at different VAT rates. This has been corrected by 
modifying the DirectPostingService.exe and SarOps.exe files. 

37617 Issue: If a Shared Menu Item was voided, the value posted for the Value Added Tax (VAT) in the MENU_ITEM_DAILY_TOTAL 
table was incorrect 

33793 

Resolution: Previously, when a Shared Menu Item was voided, an amount of 0.00 was posted under Sales in the 
MENU_ITEM_DAILY_TOTAL table but a non-zero value was posted under VAT, when the actual amount posted should have 
been 0.00. However, the correct amount (0.00) was posted in the OPERATIONS_DAILY_TOTAL table for both Sales and 
VAT. This has been corrected by modifying the DirectPostingService.exe. 

EGateway

32164 Issue:
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MICROS reviewed the setup steps for an Oracle® RAC Configuration in order to improve the database connection recovery 
time and to enable Load Balancing and automatic Transparent Application Failover (TAF) if and when TCP network timeouts 
occur 

Resolution: To review the recommended setup steps, read the Simphony 1.x Oracle Client Side Configuration for Load Balancing and 
Failover article for more information. 

EMC

32056 Issue: When adding a Kitchen Theme Period, the default values were inconsistent in the EMC's Table and Form views 

Resolution: Previously, when a new Kitchen Theme Period was added to the Table View from the EMC-> Kitchen Theme Period module, 
the values for the 'Start Date' and the 'End Date' were not shown in Table View, whereby they could be seen in Form View. 
This has been corrected by modifying the EMC.exe. 

35220 Issue: Users were unable to log in to the Reporting portal (mymicros.net v8.0) after being activated in the EMC 34494 

Resolution: Previously, after upgrading to mymicros.net v8.0, users were unable to log onto the Reporting portal if they were activated from 
the EMC-> Employee Maintenance-> Reporting tab-> Activate option. When an employee was activated and was viewed in the 
Employee Maintenance tab, the activated employee was grayed out. It was determined that when saving the information in EMC, 
the record was being written to the CORE_USER table with a NULL encryptedPassword value. Additionally, this allowed 
duplicate entries to be written to the CORE_USER table when resaving the employee configuration from the EMC. This issue 
occurred in Oracle® databases. A workaround for this issue is to look in the COREDB Database. The 
CORE_UID_GENERATOR table contains a row named 'portal', the NEXTVALUE column, which is used for new inserts, must 
be a number value greater than any previous USERID value in the CORE_USER table. If this value is too small, all inserts to the 
COREDB Database will fail. 

35497 Issue: The Context Sensitive Help (CSH) text for the Employee Roles option [Authorize Open Cash Drawer Using the [No Sale] 
Key] needed clarification 

Resolution: Previously, the CSH for the [Authorize Open Cash Drawer Using the No Sale Key] option located in the EMC-> Enterprise 
level-> Roles-> Operations-> Miscellaneous tab read as follows: 

Select this option to allow employees associated with this Role to open the cash drawer outside of a transaction using the 
[No Sale] key, and to authorize non-privileged employees to do so as well.

The CSH text was misleading as it did not mention that an employee had to be linked to the Cash Drawer in order to open it. 
This has been corrected by modifying this option's CSH to read as follows: 

Select this option to allow employees associated with this Role to open the cash drawer outside of a transaction using the 
[No Sale] key, and to authorize non-privileged employees to do so as well. The [No Sale] Key will only open the Cash 
Drawer if the Employee initiating the No Sale is linked or assigned to a Cash Drawer.

35890 Issue: Employee search queries took too long to return results 34513 

Resolution: Previously, when an Employee search was performed from the Employee Maintenance module in the EMC, it took a long time 
to return results, which sometimes resulted in RC_COMM issues. It was determined that the Transactional database's 
STRING_TABLE was queried multiple times and on larger systems, it resulted in full table scans on the STRING_TABLE 
which led to the delay. This has been corrected by modifying the queries to use indexes and removing unnecessary calls when 
searching for Employees. The EMCData.dll and EMCHandler.dll files were modified to affect this change. 

37136 Issue: The Stored Value Cards module took a long time to open if there were no Stored Value Cards records in the Revenue Center 
(RVC) 

34588 

Resolution: Previously, the Stored Value Card module took a long time to open if the RVC did not have any Stored Value Cards (SVC) 
records. However, if the RVC contained SVC records, the SVC module opened within the expected time. It was determined that 
the EMC continued to query the String_Table when there were no Stored Value Cards records present. This has been corrected 
by modifying the EMCData.dll. 

39922 Issue: The Context Sensitive Help (CSH) for Purge jobs needed updating with Heuristic info 

Resolution: The CSH for purge jobs located in EMC-> Enterprise Parameters-> Purge History-> Purge Jobs section had to be updated with 
information on two new Heuristic fields: User Experience Data (90 days) and Heuristics Algorithm Data (90 days). This has 
been corrected by updating the CSH. Additionally, information on the 'Purge Type' named, KDS detail Data must, was 
modified to remove the unnecessary word must. Currently, the new CSH text for these Purge Types reads as follows: 

◾ User Experience Data - 30-90 days
◾ Heuristics Algorithm Data - 30-90 days
◾ KDS detail Data - 30-65 days

KDS

19849 Issue: KDS Service Host running on 64-bit operating systems failed to run installer in Client Application Loader (CAL) 34366 

Resolution: Previously, when a Service Host running on 64-bit operating systems (Windows 7 or Windows Server 2008) was configured as a 
KDS Controller, the Simphony Installer failed to launch in CAL. CAL obtained all of the KDS files and the Installer, but failed 
to launch the Installer and the following Windows error was displayed when CAL tried to launch the Installer: 

Simphony Installer has stopped working
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This was caused due to Registry key errors that occurred during the installation, which resulted in the KDSController.cfg file not 
being created. This has been corrected by modifying the KdsToPosServ.dll, KdsToPosServ64.dll and 
EGatewayClientWin64CPP.dll files. 

31859 Issue: KDS Runner Chit does not update at SarOps client after runner chit device is changed 

Resolution: If the Primary Device Type in the EMC-> Property Level-> Order Device module is a Kitchen Display System (KDS), a Runner 
Chit printer can be configured to print chits. Previously, if the device assigned as the Runner Chit printer was changed, SarOps 
did not send the order to the new device, even after a full DBDownload. The local database had to be deleted in order for the 
change to be picked up by SarOps. This has been corrected by modifying the DbDownload process. 

31926 Issue: Kitchen Display System (KDS) Displays went offline when there was a gap between two configured Kitchen Theme Periods 

Resolution: Previously, if two Kitchen Theme Periods were configured with a time gap, when the first period ended, all the KDS Displays 
went offline instead of displaying the default/original configuration. It was determined that this issue only occurred in the 
Windows CE environment. This was corrected by modifying the KdsToPosServ.dll file. 

Note: Kitchen Themes no longer need to be configured for 24 hours period due 
to this fix. 

33491 Issue: Using KDS Sort Order with Dynamic Order Mode (DOM) in the Fire On Fly mode caused modified checks to move to the first 
position 

34437 

Resolution: Previously, when DOM in the Fire On Fly mode was enabled, making modifications to open checks changed the Kitchen 
Display System (KDS) sort order so that the modified check was displayed at the top of the Order Chit list, giving it the foremost 
priority. This has been corrected in KDS v2.2.5. 

36581, 
36672 

Issue: Runner Chit did not contain the Reference Entry for a parent Menu Item 34554, 
34527Resolution: Previously, when an order was sent from the Kitchen Display System (KDS), the runner chit that was printed did not contain the 

reference information for parent menu items. This was corrected in the latest version of POS Independent KDS Build_
(2.2.5.1309). 

36948 Issue: KDS Controller configuration file lost information when updated 34575 

Resolution: Previously, when the Kitchen Display System (KDS) was not in use but still communicating with the service host, information 
relating to the PhysicalDevice and KDS Layout was dropped from the KdsController.cfg file and the KDS stopped receiving 
orders. This has been corrected by modifying the KdsToPosServ.dll file. 

38171 Issue: Using the Home or End keys after calling a Summary function from the Kitchen Display System (KDS) Bump Bar caused the 
KDS to hang 

34622 

Resolution: There are three different summary functions which can be called from a Tool Bar or Bump Bar: Production Summary, Summary 
Condensed and Summary Expanded. Previously, clicking the Home or End button after calling a function from the Bump Bar 
caused the KDS to hang. The only solution was to reboot the Restaurant Display Controller (RDC) or terminate the KDS by 
calling Task Manager from the keyboard. It was reported that a keyboard is rarely used in the field to control a KDS and 
rebooting caused problems with orders and kitchen operations. This has been corrected by modifying the KDS module. 

Labor Posting Service

29319 Issue: Clock ins after a break were posted as Overtime 34174 

Resolution: Previously, when an employee clocked out for a break and clocked back in, the work hours after the break were posted as 
Overtime in the time_card_detail table in the Reporting database, even though neither the daily nor the weekly minimums for 
overtime were met. This occurred only when totalworkminutes_forthispayperiod * totalwork minutes_fortoday in the 
time_card_detail table was greater than the number of work hours an employee should work before overtime was counted. It was 
determined that the Labor Posting Service(LPS) used incorrect logic when calculating overtime if there were multiple clock 
in/out times on the same day. This has been corrected by modifying the 9700DBReader.dll file. 

39922 Issue: Context Sensitive Help (CSH) for purge jobs needed updating with Heuristic info 

Resolution: The CSH for purge jobs located in EMC-> Enterprise Parameters-> Purge History had to be updated with information on two 
new Heuristic fields: User Experience Data (90 days) and Heuristics Algorithm Data (90 days). This has been corrected by 
updating the CSH. Additionally, information on the Purge Type named, "KDS detail data must", was modified to remove the 
unnecessary word ‘must’. 

Ops

6691 Issue: Applying multiple Coupon Discounts to the same check could result in performance issues 

Resolution: Retraction: The previous Revision notes for Simphony 1.6 Maintenance Release 4 for Fix ID 6691 were incorrect and required 
updating. The Simphony 1.6 MR4 article has since been updated. The corrected Revision notes for Fix ID 6691 are as follows: 

Previously, each time a Discount was entered, the system recalculated the totals and reevaluated the check detail to 
determine Discount eligibility. The more Discounts that were applied, the time spent to determine Discount eligibility 
would grow exponentially to the point that the Workstation appeared to be unresponsive. A change has been made to 
SarOps.exe, so that the Discount engine will be allowed to calculate a Discount for 500 milliseconds (half a second). 
Currently, if the Discount calculation time exceeds 0.5 second, it will stop applying the most recently added Discount and 
the Best Deal found up to that point will be the Discount amount that will be applied.
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25322 Issue: Setting Discount 'Effectivity Settings' did not affect Discount usage 33880 

Resolution: Previously, configuring ‘Effectivity Settings’ did not have an effect when Discounts (Manual, Automatic, or Coupons) were 
applied. Discounts that were configured using the ‘Effectivity Settings’ were expected to be applicable only within the specified 
date or time range, but when a Menu Item with a discount was rung up outside the time or date range configured under the 
‘Effectivity Settings’, the discount amount was still calculated. This has been corrected by modifying the SarOps.exe. 

30008 Issue: On WS5 and WS5A clients running Windows Embedded CE 6.0, the WinHTTP timeout values set through the Windows CE 
API were being ignored 

Resolution: Previously, the WinHTTP timeout values set through the Windows CE API were being ignored on WS5 and WS5A clients 
running Windows Embedded CE 6.0. Additionally, there was a 15 second delay when an application called the Windows CE 
API ‘InternetCloseHandle’ method. This resulted in an unexpected delay of timeouts when an HTTP request was sent from 
Simphony Ops to the EGateway Enterprise or other Simphony services. This has been corrected by modifying the 
EGatewayClient*Cpp.dll, EGatewayHandlers, EMCText.xml. Currently, an internal timeout mechanism added to the 
EGatewayClient*Cpp.dll will be utilized, rather than the clients using the Windows CE API timeout value settings. 

31022 Issue: Automatic Coupon Discounts displayed twice on Guest Checks and Customer Receipts 33896 

Resolution: Previously, when an Automatic Discount EMC-> Discounts-> General-> Activation Type-> Automatic was applied to a check, 
the line detailing the discount appeared twice on the Guest Check as well the Customer Receipt. One line displayed the coupon 
discount name along with the discount amount, while the other contained only the coupon discount name. 

It was determined that this issue was due to Ops identifying a coupon and a discount as two separate items. This has been 
corrected by modifying SarOps.exe to display one discount line on the Summary Detail section of Guest Checks and Customer 
Receipts. This was further refined by removing coupons that resulted in Automatic Discounts from appearing in the Check Detail 
area on the Ops Display. 

31394 Issue: Removing an Automatic Coupon Discount from a Closed Guest Check did not remove the discount 

Resolution: Previously, when an Automatic Coupon Discount was removed from a Closed Guest Check, although the coupon was removed, 
the discount remained on the Guest Check. This has been corrected by modifying SarOps.exe. With this release, the following 
behavior is now exhibited: 

◾ The only way to remove these discounts from a Re-opened Closed Check is to remove the payment Tender/Media first and 
then use the [Remove Automatic Discounts] function. Once this is done, the discount coupon can be removed if so 
desired and Automatic Discounts can be reapplied using the [Apply Automatic Discounts] function. 

32067 Issue: Workstation prompted for installer username/password when application server used a Load Balancer 34366 

Resolution: Previously, when the Application Server used a Load Balancer, the Workstations prompted for installer credentials if rebooted. 
Upon entering the valid credentials the Ops opened. If the Workstations were rebooted again another set of Workstations 
prompted for installer credentials. This occurred because the EGatewayURL was not changed to the Load Balancing URL in the 
Web.config file of the Simphony Application Server configured with the Load Balancer. The steps to perform this manual 
change can be found at: Configuring Network Load Balancing for Simphony. 

32210 Issue: Credit Card (CC) Settlement failed because the records were generated with CC numbers that had all zeros except for the last 
four digits 

34397 

Resolution: Previously, Credit Card (CC) Settlement failed if a CC transaction was performed on a Workstation that was also a KDS 
Controller when the 'ClientAuthKeyID' registry setting located-> (HKLM\SW\Micros\POSClient\ClientAuthKeyID) was not 
available in the Workstation’s registry. It was determined that the 'ClientAuthKeyID' in the registry could not be read due to 
memory corruption when the Workstation was a KDS Controller and when the Heuristics jobs were enabled. This resulted in a 
memory leak that rendered the Workstation unusable. If a check was rung when both these conditions were present, the check 
included in a batch with the 'ClientAuthKeyID' unavailable contained only the last four digits of the CC number with zero 
values. This has been corrected in the newer version of KDS Controller by modifying the SarOpXXX.exe file so that an error 
message is returned when the EGateway is inaccessible during a CC Authorization. 

33127 Issue: OFFLINE indicators were inconsistent between the Workstation and the issued Guest Checks, Customer Receipts and Journals 

Resolution: A Workstation screen has a variety of ‘OFFLINE’ nomenclatures to indicate its current condition (e.g., OFFLINE, *OFFLINE* 
and **OFFLINE**). Previously, when option '42' was enabled from EMC-> RVC Parameters-> Format-> Format Options-> [42 
– Print “**OFFLINE**” on Offline [[[Guest Checks]]] and Receipts], if a Workstation had connectivity to the Enterprise,
but not healthy in relation to the Heuristic settings, the text ***OFFLINE*** would be printed on all issued Guest Checks, 
Customer Receipts and Journals. This same condition would be indicated in the Workstation with the text **OFFLINE**. Given 
the variety of conditions indicated by the word ‘OFFLINE’ coupled with a combination of asterisks, and the inconsistency of the 
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indicators between the Workstation and the printed Guest Checks, Customer Receipts and Journals, it was requested that a more 
descriptive and distinct nomenclature be introduced to be able to accurately determine the state of the Workstation. This has been 
corrected by modifying the EMCText.xml, EMCText.dll and the SarsOps.exe files. Currently, if a Workstation has connectivity 
to the Enterprise, but not healthy in relation to the Heuristic settings, it is indicated by the text --'-OFFLINE' on the Workstation 
display as well as the printed Guest Checks, Customer Receipts and Journals. 

35175 Issue: The [No Sale] button did not open the Cash Drawer for an employee with the required Roles privilege unless the Cash drawer 
was specifically assigned to that employee 

34491 

Resolution: The No Sale button is used to open the Cash Drawer outside of a transaction. However, only employees with the required Roles 
privilege can use this function. Also, whether a cash drawer is assigned to the Workstation or the operator is determined by the 
[4 – Assign Cash Drawer By User Workstation] option. Previously, when the [4 – Assign Cash Drawer By User 
Workstation] option was disabled for a Workstation, and an employee who had the Cash Drawer assigned permanently to its 
operator, used the [No Sale] button, the following message displayed: 

This Workstation is not programmed to allow cash drawer assignment

Additionally, the Cash Drawer did not open. This has been corrected by modifying the SarOps.exe file. 

36965 Issue: Under certain circumstances, when using the [848 – Assign Cash Drawer] function, the Workstation would lose its Cash 
Drawer assignment 

34559 

Resolution: Previously, it was reported that intermittently after performing a DBDownload or rebooting a Workstation while Offline, the 
Workstation would lose its current Cash Drawer assignment and users would be prompted to assign a Cash Drawer again. This 
has been corrected by modifying the SarOps.exe. Additionally, as stated in the Context Sensitive Help (CSH) file for 
Workstation option [4 – Assign Cash Drawer By User Workstation], option '4' should be enabled in order to utilize certain 
Cash Drawer assigning functions. The CSH text for option '4' reads as follows: 

If this option is enabled, operators must assign themselves to a Cash Drawer by using the one of the Function Keys 848, 
839, or 840 (Assign Cash Drawer, Assign Cash Drawer 1, Assign Cash Drawer 2). Then, only the operator assigned to the 
drawer will be able to open it (or a privileged manager, who can unassign a drawer from a user). If this option is 
disabled, the Operator "Cash Drawer" field determines if an operator can access a cash drawer or not. In this scenario, 
all operators with the "Cash Drawer" field set to "1" will be able to open Cash Drawer 1.

Note: Giving multiple employees access to a single cash drawer is not as secure as requiring employees to be assigned to 
a Cash Drawer! 

33546 Issue: The number of retries for replaying offline messages was increased from 5 to 10 

Resolution: Previously, Offline messages were replayed from the Offline Transaction File (OTF) when Workstations were able to contact the 
EGateway. If the connection between the Workstations and the EGateway or the EGateway and the database was poor, replaying 
the Offline messages sometimes failed. If this occurred, SarOps made four more attempts and if these attempts failed, the record 
was marked with a DRH_ERROR status. New attempts to replay the messages could only be made if it was manually reset using 
the OTFEdit tool. This solution did not prevent SarOps from replaying offline messages, just from connecting online. Therefore, 
it was possible for good messages to be marked as error messages. This has been corrected by modifying the SarOps*.exe to 
increase the number of retry attempts from 5 to 10. This should reduce the number of incorrect error messages that would need to 
be manually collected and replayed. 

38225 Issue: Context Sensitive Help (CSH) text for options related to High Amount Lock Out (HALO) in several module pages did not 
contain cross-references 

Resolution: Previously, the CSH for the following HALO configuration options did not mention the corresponding Roles options that affect 
the use of HALO: 

◾ EMC-> Property level-> Tender/Media-> Options-> Miscellaneous Options-> [18 – Enable HALO], [19 - ON=Use 
HALO on Amount Entered; OFF=Amount Overtendered], HALO Code 

◾ EMC-> Enterprise level-> Personnel: Roles-> Operations tab-> Transactions tab-> [Authorize Over HALO 
Amounts on [Tender/Media] Keys]

◾ EMC-> Enterprise level-> Personnel: Roles-> Operations tab-> Transactions tab-> [Authorize/Perform Over 
HALO Amounts on [Service Charge] Keys]

◾ EMC-> RVC level-> Menu Items: Menu Item Classes-> General tab-> HALO text box 

This has been corrected by modifying the CSH texts as follows: 

◾ EMC-> Property level-> Tender/Media-> Options-> Miscellaneous Options-> [18 – Enable HALO]

Select this option to enable the High Amount Lock Out for this Tender/Media. Users may exceed this limit only when 
associated with an Employee Role with the option, "Authorize Over HALO Amounts on [Tender/Media] Keys", enabled.

◾ EMC-> Property-> Tender/Media-> Options-> Miscellaneous Options-> [19 - ON=Use HALO on Amount 
Entered; OFF=Amount Overtendered]

This option only applies if "Enable HALO" is selected. If this option bit is selected, the HALO for this Tender/Media will 
be computed on the amount entered. (For instance, if 500 is the HALO code, this tender key will require authorization if 
an amount higher than 500 is entered.) If this option bit is not selected, the HALO applies to the overtender amount.(For 
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instance, if 500 is the HALO code, an operator will be prompted for authorization if the amount of the tender entered is 
more than 500 above the amount of the check.) Users may exceed this limit only when associated with an Employee Role 
with the option, "Authorize Over HALO Amounts on [Tender/Media] Keys", enabled. By setting the HALO Code to 0 and 
not selecting this option, you can prevent the non-privileged operator from issuing change for this Tender/Media.

User Experience Report

31838 Issue: The EMC crashed when exporting data from the EMC-> Enterprise Information-> User Experience Report module-> Detail 
Statistics tab in an Oracle® environment 

34369 

Resolution: Previously, in an Oracle environment, when exporting data from the EMC-> Enterprise Information-> User Experience Report 
module-> Detail Statistics tab, the EMC would crash and display the following error message: 

MCHandler failed: ORA-00933: SQL command not properly ended

This has been corrected by modifying the EMCHandler.dll file. 

Workstation Clients

14736 Issue: Workstation 5 Touchscreens were very sensitive, which resulted in duplicate entries and stuck buttons 32798 

Resolution: Previously, when SarOps was installed on a Workstation 5, using the Touchscreen caused double entries if a button was pressed 
only once. Pressing a button multiple times cause it to get stuck and the Workstation had to be restarted. It was determined that 
the existing multi-language code sent a message to the IME for keyboard input for possible translation. This has been corrected 
by modifying the SAROps.exe file so that alpha and numeric keys are processed on the button up click and not on the down 
click. 
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Simphony Version 1.6
General Release

Simphony 1.6 MR 1

Simphony 1.6 Maintenance Release 4 

IMPORTANT NOTICE
When Simphony v1.6 GR was released, the POS Independent KDS Components distributed with Simphony were 
upgraded. A performance issue was identified with Windows CE Clients running the KDS Controller. A decision was 
made to roll back to the earlier version of the KDS application in this release to stabilize KDS on CE devices until a 
solution to the problem can be implemented. Consequently, the KDS distributed with Simphony v1.6 MR4 does not 
contain the necessary changes for certain Simphony v1.6 KDS Layout Styles to function. The following KDS Layout 
Styles should not be selected as they contain unrecognized layout elements and will not function. If one of these KDS 
Layout Styles is selected, the KDS Controller will appear normal, but KDS Displays will not work. (TPID 29381) 

◾ 125 - Chit-Standard RCookTime 
◾ 126 - Chit-Items Only RCookTime 
◾ 127 - Chit-Standard-OT - Gst 
◾ 128 - Chit-Standard-OT w/Seat - Gst 
◾ 129 - Chit-Std-OT w/Item Status - Gst 
◾ 130 - Chit-Header-OT w/Chk - Gst 
◾ 131 - Chit-Header-OT w/Tbl - Gst 
◾ 219 - List-Standard RCookTime 
◾ 220 - List-Std-OT RCookTime 
◾ 221 - List-OT Zone RCookTime 
◾ 222 - List-Row Num RCookTime 
◾ 223 - List-Chk# Row Num RCookTime 
◾ 301 - Chit-Std-DOM 
◾ 306 - Chit-Std-DOM-11 
◾ 312 - Chit-Std-DOM-11-3 
◾ 401 - List-DOM1 
◾ 402 - List-DOM2 

Currently, this issue is being researched and once a cause has been identified, a fix will be delivered in a future release. 

This article is a quick reference guide to features, enhancements, and revisions for Simphony 1.6 Maintenance Release 4. 

Contents

◾ 1 Prerequisite Knowledge
◾ 2 Document Overview 

◾ 2.1 Terminology
◾ 3 Obtaining/Installing the Software
◾ 4 New Features
◾ 5 Enhancements
◾ 6 Revisions
◾ 7 See also

Prerequisite Knowledge 

This document assumes the reader has the following knowledge or expertise: 

◾ Understanding of basic network concepts 
◾ Experience with Microsoft Windows platforms and terminology 
◾ Familiarity with this product line and its hardware, software, and peripherals 

Document Overview 

For the printable collection for this version, see 1.6 Collection

This document includes the following sections: 

What's New
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Simphony 1.6 MR 2
Simphony 1.6 MR 4
Simphony 1.6 MR 5
Simphony 1.6 MR 6
Simphony 1.6 MR 7
Simphony 1.6 MR 8
Simphony 1.6 MR 9
Simphony 1.6 MR 10

Previous Version Next Version 
Simphony 1.5 Simphony 2.6 

This section describes new features in this software release. A new feature is one that provides capabilities that 
were not available in previous versions. 

What's Enhanced
This section describes enhancements in this software release. An enhancement is a change made to improve or 
extend an existing feature, under the following criteria: 

◾ The basic feature or functionality already exists in the previous release. 
◾ The change adds to or expands on the current process — it does not replace it. This differs from a revision 

that corrects a problem. 

What's Revised
This section describes issues that have been corrected. A revision is a correction made to an existing form, feature, 
or function, using the following criteria: 

◾ The item must be part of the previous version. 
◾ The change must replace the current item or remove it from the application. 

Terminology 

◾ A Fix ID is an internal tracking number used by R&D. This ID is primarily used by R&D personnel; it is helpful for mapping fixes to documented items. 
◾ A CR# is a "Change Request ID" that is generated during the escalations process. When a case is started at the Support Center and the issue is determined 

to be an application defect, a Change Request is created, informing R&D that an issue needs to be fixed. 

New Features 

Fix ID Feature CR #

KDS

18575 Production Items for KDS are now supported

The Production Item feature allows users to link menu items that are prepared in a similar manner (e.g., French Fries, 
Hamburger Patties) and send them to pre-selected KDS prep stations. These items can then be grouped together and 
displayed in bars either above or below the order chits. The Production Item feature was designed for the kitchen 
environment that has staff working in an assembly-line fashion. It allows the cooks to concentrate on their specialties or 
portions of an order. Production items can be used in either Dynamic Order Mode (DOM) or non-DOM environments. See 
the Production Items for KDS article for more information. 

Order Devices

18576 The Kitchen Themes feature is now supported

The Kitchen Themes feature allows a business to create multiple configuration settings for its Order Devices, which are 
stored in the database and identified by name (e.g., Breakfast Theme, Lunch Theme, Dinner Theme, Happy Hour, 
Corporate and Private Banquets etc.). With it, managers can change the order direction and output of the entire restaurant 
by simply activating a new theme. 

Warning: For those who choose to utilize the Kitchen Themes feature, it’s vital that Kitchen Themes be configured to 
account for all 24 hours of a day (even if Revenue Centers are not open for business during certain times). Failing to do so 
may result in the KDS system to discontinue working as expected. 

See the Kitchen Themes article for more information. 

Workstations

18578 Support for the mTablet and mStation (R Series) has been introduced

MICROS introduces its latest Point-of-Sale devices. They are: 
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mTablet – Is a Tablet that runs Windows CE 7 and has built-in Wi-Fi, a long lasting battery and standalone resiliency 
capabilities. mTablet users also have the option to choose between Portrait and Landscape orientation on the fly by rotating the 
Tablet on the mStation or while holding the mTablet. Ops will dynamically rotate or stay put depending on the user’s preference. 
It has a 2x20 Customer Display screen. The screen resolution of the mTablet is 1024x600 and 600x1024 depending on the 
mTablets Portrait and Landscape orientation. The mTablets touchscreen Speed Pad template will display 100 buttons (the 
Maximum allowable in the Touchscreen designer). The Speed Pad template will support a 10x10 grid, while the Sidebar 
Left/Right will support 14x24, although only 120 buttons will be visible on the mTablet touchscreen. 

mStation – Is a device that serves as a docking point for the mTablet that facilitates the use of peripheral devices such as 
Integrated Magnetic Stripe Readers, Cash Drawers, Remote printers (IDN, IP, Serial and Bluetooth devices), Serial Coin 
Dispensers and Serial Barcode Readers\Scanners. 

There are two possible methods to utilize the mTablet: 'Docked' or 'Floating'. When the mTablet is docked to the mStation, it 
can be utilized much like legacy models of Workstations. The mTablet and mStation may also be configured to be Wired 
(cabled) or Wireless. 

The following features are not currently supported, but are on the development roadmap to function on an mTablet with 
Simphony in the future: 

◾ Dynamic Switching Between Wired and Wireless States; Docked and Floating 
◾ Running as a Service Host 
◾ Running as a Kitchen Display System 
◾ Signature Capture 
◾ Kiosk Configuration 

Known Limitations

It is not possible to configure an mTablet to run any of the following services: 

◾ An mTablet that is configured for Floating operation should not be configured as an OLC/OTC. 
◾ KDS Controller 
◾ Credit Card Service Host 
◾ Interface Service Host 
◾ Property CAL Server 

To review the Hardware Specifications for these devices, please click here:[1] 
(http://www.micros.com/NR/rdonlyres/DBD63078-7D5D-4FA1-838E-7F294D67F36D/0/mStation13My16SpecsLR.pdf) 

See the mTablet and mStation and MTablet Configuration articles for more information. 

Enhancements 

Fix ID Enhancement CR #

Install

23771 Replaced a report template utilized by the MICROS Europe, Africa, Middle East (EAME) Region with a new version

The report template utilized by the MICROS EAME Region has been replaced. The replaced template name is the 
EAME_AllChecksDiscDtl.xml and is used to generate a report that displays ‘All Checks Associated with a Discount 
Type’. With this release, the new report template will be installed. 

mymicros.net

24696 Upgrades to mymicros.net v8.0.1 will be supported on Simphony v1.6 MR4

Validation for upgrading the v1.6 mymicros.net database to v8.0.1 has been completed. Simphony v1.6 MR4’s default 
mymicros.net version remains v7.2.0. 

Ops

24851 The Operations Client has been modified to support the newest User Interface Theme File format

With this release, Operations Client Theme handling has been upgraded. 

The upgrade includes: 

1. The use of the MICROS 3700 RES style *.thm file. A *.thm file is a custom MICROS file that includes all of the bitmaps,
gifs and assorted image files that comprise a Theme.

2. When SarOps loads, it will delete the old Theme files in the 'Themes'\default folder on the Workstation.
3. SarOps will then load the first *.thm file found in the 'Themes' folder. The “default” folder will no longer be used.
4. The Theme file has been enhanced to support the new resolutions of the mTablet.
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The deployment model for Theme files has not changed. Theme files can still be deployed via CAL. 

Warning! Customers currently utilizing Themes will need to deploy the new Theme file as part of the upgrade to 
Simphony v1.6 MR4. 

See the Operations Client User Interface Themes article for more information. 

SIM

24951 Support for the '@DTL_SELECTED' variable for SIM Interface Scripting Language (ISL) scripts has been added.

It was requested to add support for the SIM ISL script variable named @DTL_SELECTED. With this release, the 
@DTL_SELECTED command is now supported. 

33879 

Revisions 

Fix 
ID Revision CR #

CAL

22950 Issue: The EGateway CAL package failed to install on a Win32 PosReady 2009 Workstation (WS) 34162 

Resolution: Previously, while performing an upgrade to Simphony 1.6 Maintenance Release 2, when installing the EGateway CAL package 
on a Win32 POSREADY 2009 WS, it failed with the following error message: 

This application has failed to start because framedyn.dll was not found. Re-installing the application may fix this 
problem.

This has been corrected by modifying the Installer.exe. 

Credit Card Batch Process

16175 Issue: Responses to Credit Card (CC) Authorizations and CC Batch requests were not being written to either the EGateway or 
TiffCommsPms log files 

Resolution: Previously, when a Service Host was running a CC Driver and the log verbosity setting was set to '3' or higher, the Credit 
Authorization Request (CA_REQ) and Batch Open Request (BO_REQ) messages were logged in some detail, but the responses 
to these messages were not logged at all, at any verbosity setting. This is in contradiction to the logging specs outlined in the 
Simphony CAEDC PMS Interface Specification Manual v1.5 (on pages 14-15). This has been corrected by modifying the 
CAPMS.dll. 

Currently, using the verbosity setting of '3', the following messages are logged under LoadHandlers as shown here: 

04/16/13 15:22:26, 3, 3,LoadHandlers,35,CAPMS Driver auth response msg: 06 
CA_RSP061ABC123, 
04/16/13 15:22:26, 3, 3,LoadHandlers,35,CAPMS Driver auth response parsed data: 
MessageID: CA_RSP 
Auth Sequence Number: 06 
Authorization Status: 1 
Authorization Code: ABC123 
Message: 
PMS Discretionary Data: 
Have Avail Balance: 0 
Avail Balance: 
Is Partial Auth: 0 
Partial Auth Amount:

21239 Issue: When an attempt was made to settle a CC Batch that exceeded the ‘Maximum Batch Size’ field’s value, conflicting information 
was generated regarding the CC Settlement status 

Resolution: Previously, if the ‘Maximum Batch Size’ field located in the EMC-> Credit Card Driver module was configured to split the CC 
Batches into smaller chunks to be transferred to the CC Processor for Settlement, users received conflicting messages from the 
‘Transfer CC Batch’ tab (shown here). 
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This has been corrected by modifying the ECCServer.dll. Currently, after CC Settlement has occurred, conflicting information is 
no longer displayed. 

24864 Issue: Simultaneously transferring multiple Credit Card Batches to be settled, failed to transfer 33912 

Resolution: For large Enterprises, there can be overlapping and simultaneous transferring of CC Batches that need to be settled. In some 
instances, the ServiceHost settling the records would throw a memory exception error and the records would stop transferring. 
The EGateway log would have the following text written to it when this issue occurred: 

02/18/13 05:16:35, 2, 2,LoadHandlers, 56,CAPMS: [Interface492]: Back from 
SendSyncRequest in 
[78.144] ms, 
02/18/13 05:16:35, 2, 2,LoadHandlers, 56,CCDrvInst[268]: Updating the following 
Batch Detail IDs: [82745061], 
02/18/13 05:16:35, 2,-3,LoadHandlers, 39,ERROR! Exception caught in CAPMS while 
sending batch xfer req! 
Message:[Object reference not set to an instance of an object.] Stack: [at 
Micros.TotalsPosting.CInterfaceMessage.Serialize(Stream s) 
at Micros.TotalsPosting.CInterfaceMessageReqRetry.Serialize(Stream s) 
at Micros.LES.ECC.CAPMS.SendPMSMessage(Byte[] pmsMsg Int32 workstationID Int16 
cRetries Int32 cTimeout) 
at Micros.LES.ECC.CAPMS.SendBatchTransferRequest(CcsBatchXferMsg req 
CcsBatchXferMsg& rsp)], 
02/18/13 05:16:35, 2,-3,LoadHandlers, 39,CCDrvInst[268]: Send Batch Transfer 
Request failed with ECCDIRc 
[ECCDI_RC_APP_ERROR],

This has been corrected by modifying the CAPMS.dll and ECCServer.dll files. 

Data Transfer Service

21173 Issue: Deleting Employee Time Card records from the PMC was not updating the mymicros.net database 

Resolution: Previously, after a Time Card record had been created from either an employee Clock In or a Manager Time Card edit, it could 
be deleted from the PMC, but the record was not deleted from the mymicros.net database. This condition caused the 'Labor Stats' 
section on the mymicros.net 'Today's Operations' report to differ from the 'Labor Stats' section on the 'Daily Operations'
report. This has been corrected by modifying the 9700DBReader.dll. 

Direct Posting Service

11326 Issue: The Guest Count value was incorrectly posted to the Reporting database when adding one check to another and then editing the 
Guest Count 

32505 

Resolution: Previously, upon using the Add/Transfer Check function to combine two checks in addition to the [Number of Guests] function 
to change the Guest Count, the Guest Count totals were inflated on financial reports. This has been corrected by modifying the 
SarOps*.exe. 

21310 Issue: Service Charge option [4 - Post to Service Charges Total on Tip Reports] was always treated by the system as being enabled 

Resolution: Previously, when Service Charge option 4 was enabled, it appeared to be functioning correctly. However, when this option was 
disabled, the Service Charge still incorrectly posted to the Service Charge section on the Employee Tip Report. This has been 
corrected by modifying the MMEmployeeTip.xml and MMEmployeeTipUWS.xml report templates. Currently, Service Charge 
option 4 now performs as expected for both manually and automatically applied Service Charges. 

21410 Issue: Multiple price overrides within one service round could cause tax amount imbalances between the Reporting database 
GUEST_CHECK and GUEST_CHECK_LINE_ITEM tables 

33510 

Resolution: Previously, when tax amounts were split among check items, they were not always correctly added to a checks total taxes line. 
This has been corrected by modifying SarOpsXXX. Currently, price overrides within a service round (for either multiple or 
single price overrides) successfully apply and write the correct tax totals to the Reporting database tables. 

23878 Issue: Error Correct Totals and Counts were not getting updated in the Reporting database despite having the Property Parameters-> 
[16 – Post Error Corrects to Reporting Database] option enabled 

Resolution: Previously, when the EMC-> Property-> Property Information-> Property Parameters-> Options tab-> [16 – Post Error 
Corrects to Reporting Database] option was enabled, Error Correct Totals and Counts were not getting written to the 
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Reporting database as expected. This has been corrected by modifying the DataPostingService.exe and NewDTS.exe files. 
Currently, error correction data is now posting to the Reporting database GUEST_CHECK and GUEST_CHECK_HIST tables 
when Property Parameters option 16 is enabled. 

27246 Issue: If a Discount was applied to a transaction, Reference Entries for Menu Items (MI’s) were posting incorrectly on mymicros.net 
reports as Discount Reference Entries 

34030 

Resolution: Previously, if a transaction containing a Menu Item with a Reference Entry had a Discount applied, mymicros.net would report 
the Reference Entry as being associated with the Discount instead of the MI to which it applied. Changes have been made to 
DPS.exe so that mymicros.net reports now display Reference Entries with the correct detail type. 

28921 Issue: Upon adding a new Serving Period to a Revenue Center (RVC), the newly added Serving Period’s name was not displaying on 
mymicros.net RVC Serving Period financial reports 

34150 

Resolution: Previously, a newly added RVC Serving Period’s name was not displayed on mymicros.net RVC Serving Period financial 
reports; rather the report only displayed '---' where the new Serving Period’s name belonged. This has been corrected by 
modifying the DirectPostingService.exe. 

EGateway

27418 Issue: EGateway log files did not rotate and were filled with Printer messages a on WinCE Workstation serving as a KDS Controller 34039 

Resolution: Previously, EGateway log files grew too large too quickly, which adversely affected the Workstation’s performance. This issue 
reportedly began after upgrading to Simphony v1.6 MR2. This has been corrected by modifying the PosToKdsHandler.dll, 
PosToKdsHandlerWS.dll, SystemServices.dll and EGatewayDefs.dll files. With this release, 'PrinterID' messages are only 
logged when the verbosity setting for LoadHandlers is set to level '3' or higher. Also, the EgatewayLog folder maintains 10 
EGateway logs in addition to the current log. The Log file name matches the Registry node name specified in the Registry under 
CAL\Config\DeviceId and also uses the default name of 'WindowsCE'. 

EMC 

20806 Issue: The KDS Controller 'Database Update Frequency' setting was not being saved as expected when edited 

Resolution: Previously, in the EMC-> KDS Controller module, the General tab has a setting called ‘Database Update Frequency’. This 
settings Context Sensitive Help (CSH) text reads as follows: 

This field determines the number of seconds this KDS Controller will wait to retrieve the latest updates from the database. 
The default value for this field is 30 seconds. If this field is set to 0, this controller will use the Database Update 
Frequency field from Property Parameters.

Setting or changing this field’s value would correctly display while the module remained open, but if a screen 'Refresh' was 
performed or the module was closed and reopened, the value of the setting was reset to '0' and not properly saved in the 
Transactional database. This has been corrected by modifying the EMC.exe. Currently, any setting changes are properly saved 
and written to the database as expected. 

20853 Issue: A Credit Card (CC) Merchant Group configuration was available in the Workstations module, but when it was configured, it was 
not having any affect 

33422 

Resolution: It was determined that CC Merchant Group combo box drop-down menu should be removed from the EMC-> Workstations 
module-> Transaction tab. This change was accomplished by modifying the EMC.exe. With this release, CC Merchant Groups 
can be configured in the EMC-> Enterprise level and then can be assigned from the Property or Revenue Center levels. 

20999 Issue: When attempting to delete a Property from the EMC, users received a EMCHandler failed: Table 
"KDS_CLIENT_STATUS" is not valid for command 'delete_property' message 

33497 

Resolution: Previously, users were unable to successfully delete a Property from the EMC. This has been corrected by modifying the 
EMCHandler.dll and EMCData.dll files. Additionally, this fix applies to all supported Transactional database platforms. 

21824 Issue: The EMC’s Workstation Status Control-> Workstation '#' column only sorted in ascending order 33547 

Resolution: Previously, Table View column header sorting was not working as expected in the 'Workstation Status Control' module when 
compared to other modules in the application. The '#' column would only sort in ascending order. The other columns in this 
module were also not sorting as expected. Additionally, the same fix was also applied to the Property 'KDS Status' page. This 
has been corrected by modifying the EMCClient.exe. 

21862 Issue: The KDS 'Live Status' module did not update dynamically despite being enabled to do so 33553 

Resolution: Previously, the EMC-> Property-> 'KDS Status' module was not being updated with its “Live” status while the module was 
open despite the 'Live Status' option being enabled. It was necessary to close and reopen the ‘KDS Status’ module in order to 
refresh the status view. This has been corrected by modifying the PosToKdsHandler.dll, PosToKdsHandlerWS.dll, and 
EMCData.dll files. With this release, the KDS ‘Live Status’ updates immediately when selected, as well as the next status 
check/update following a status change in the database. 

21984 Issue: Users were unable to successfully move a Service Host from the SIM to the Offline Labor Cache (OLC) in the same instance of 
the EMC-> Property Parameters module 

33579 

Resolution: Previously, when configuring a Property to use the OLC as a service, the 'Property Parameters' module was accessed. Should 
more than one change to the 'OLC/Offline Transaction Cache (OTC)' or the 'Offline Open Check and Shift Cache' services 
be made while the module was open, the change would fail. The EMC would display a 'The Service Host you have selected 
already includes this type of Service. This change is not allowed' message. The proscribed method to work-around the error 
(the EMC toolbar’s ‘Refresh’ button would not resolve this issue) was to remove the SIM Service Host (and update the 
dropdown menu to NONE), save the changes, close out of ‘Property Parameters’ tab and re-open the tab again. This has been 
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corrected by modifying the EMC.exe, EMCHandler.dll and the EMCFramework.dll files. Currently, the reported error message 
no longer occurs when moving a Service Host from SIM to an OLC Service Host. 

22803 Issue: Configuring a mymicros.net Report user from the EMC was not allowed after an upgrade to mymicros.net v7.3 on sites utilizing 
an Oracle® database 

34232 

Resolution: Previously, after performing an upgrade to mymicros.net v7.3, adding users to the portal via the EMC-> Personnel-> Employee 
Maintenance-> Reporting tab was not possible for sites utilizing an Oracle® database. Any attempts to save a record resulted in 
an error message being returned about violating a unique constraint. This has been corrected by modifying the EMC.exe and 
EMCHandler.dll files. Currently, new mymicros.net Report users may be successfully configured from the EMC. 

23173 Issue: Touchscreen Function key code '657' (to remove Automatic Discounts from Ops) did not work as expected and Function 
'658' (to remove Automatic Coupon Discounts from Ops) was not available in the Touchscreen-> Functions drop-down menu 

33691 

Resolution: Previously, Touchscreen Function key code '657' did not work as expected. When utilized, users received an 'Error. Not 
Allowed - Must Remove Automatic Discounts' message. Additionally, a review of the EMC-> Roles-> Operations-> 
Transactions options intimated that a privilege could be assigned to remove Coupon Discounts using Function '658'. Its Context 
Sensitive Help (CSH) description is shown below: 

Authorize/Use Remove Coupon Discounts

Select this option to allow employees associated with this Role to use the Remove Coupon Discounts Function Key (658), 
and to authorize non-privileged employees to do so as well.

However, when users attempted to configure function key code '658' in the Touchscreen Design module, it was nowhere to be 
found. There was no way to remove a coupon discount from Ops. This has been corrected by modifying SarOps.exe. With this 
release, line item Voids will now allow users to remove Coupon Discounts (as long as the user has the privilege to perform 
Voids in their assigned employee Role). The ‘Roles’ option named 'Authorize/Use Remove Coupon Discounts' and its 
associated CSH file was removed from the EMC. 

25011 Issue: RVC Parameters Posting option [14 - Allow Changes to Menu Items on Closed Checks] behaved as if it was always enabled 33860 

Resolution: Previously, the system was not recognizing the setting of the RVC Parameters Posting-> Control Option-> [14 – Allow Changes 
to Menu Items on Closed Checks]. It was allowing changes to Menu Items on Closed Checks regardless of the setting of this 
option. The option name and corresponding Context Sensitive Help (CSH) has been updated to reflect that this option pertains 
only to the Voiding of Menu Items on Closed Checks. 

The option and CSH now read as follows: 

[14 - Allows Voids of Menu Items on Closed Checks]
Select this option to allow privileged operators to void menu items on a closed check in the round that the check is being 
reopened.

This has been corrected by modifying SarOps.exe and the EMCText.xml file. Currently, the system recognizes the setting of this 
option when determining whether a Menu Item can be voided from a Closed Check. 

Note: A flag is set when checks are closed with Control option [14 - Allows Voids of Menu Items on Closed Checks]
disabled. If Control option 14 is subsequently enabled, if a Closed Check with that flag set is reopened, the flag will 
disallow Menu Items from being voided from that check even though Control option 14 is now enabled. 

25333 Issue: Discount option [24 - Discount is Final] shouldn't be allowed to be configured with Manual or Coupon Discounts types 

Resolution: Previously, the Discounts-> General tab-> Options-> [24 - Discount is Final] option was incorrectly available to be enabled for 
both 'Activation Type's of [0 - Manual (Manually entered and applied)] or [2 - Coupon (Automatically applied, operator 
must enter)] discounts. Option 24 should have only been able to be enabled for [1 – Automatic (Automatically applied, 
operator cannot enter)] discounts. This has been corrected by modifying the EMC.exe. Currently, option 24 is only visible and 
available from the Discounts-> Options section for [1 – Automatic (Automatically applied, operator cannot enter)] discounts. 
See the Discount Exclusivity article for more information. 

26006 Issue: The Order Device-> KDS tab-> Order Notification section-> 'Beep On New Order' field needed to have the Context Sensitive 
Help (CSH) text updated 

33926 

Resolution: It was determined that the CSH text for the 'Beep On New Order' field wasn’t detailed enough. The new CSH text reads as 
follows: 

From the Beep on New Order drop-down list, select the sound type that will be emitted when an order is received on this order 
device. If the WAV file option is selected, the system will use the default WAV file set for the operating system. Note that RDC 
boxes do not have a speaker that can be used with this option, and Wireless Bump Bars do not have a speaker at all.

Install

21976 Issue: The KDS Media Viewer files in the CAL Package were not being copied to the target client by the Installer.exe 

Resolution: Previously, the KDS Media Viewer files in the CAL Package were not making it to the clients. This has been corrected by 
utilizing the latest version of the Installer.exe. Currently, the KDS Media Viewer files are successfully sent to the targeted clients 
via CAL. 
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31052 Issue: A clean application installation failed to create the CAL Client service on a Windows Server® 2008 R2 environment 

Resolution: Previously, when attempting to install Simphony on a Windows Server® 2008 R2 (64-bit) environment, the Simphony installer 
encountered an issue when trying to create the MICROS CAL Client service due to a missing *.dll file. The Simphony installer 
was unable to execute the process: MCRSCAL.exe -service. This issue was not seen when CAL was installed using the 
EGateway download in the same environment for Service Hosts. This has been corrected by modifying the Installer.exe. 
Currently, the Simphony installer successfully installs the MICROS CAL Client service during a new installation on a Windows 
Server® 2008 R2 environment. 

KDS

21786 Issue: A KDS Restaurant Display Controller (RDC) Platform update (to v4.2.2) caused all of the Order Devices at the Property to 
display as dots on chits 

33543 

Resolution: Previously, after upgrading the RDC platform (usually performed in preparation for a Simphony upgrade to v1.6) the RDC 
displayed a number of dots equal to the number of devices for the entire Property (up to a maximum of 32 dots). This behavior 
was only seen at locations with more than one Revenue Center (RVC) using the same KDS Controller. This has been corrected 
by modifying the DbDownloadHandler.dll and KdsToPosServ.dll files. Currently, the correct number of dots will display on 
chits based on the number of Order Devices per each RVC. 

22505 Issue: The KDS Controller's default database refresh rate was too frequent and overtaxed the KDS system 33632 

Resolution: Previously, upon upgrading to Simphony v1.6 from legacy versions, a new version of KDS was installed. A number of new 
features were made available and the new configuration options would display in the EMC. One of these fields was the 
'Database Refresh Rate' on the KDS Controller-> General tab. By default, this setting is assigned a value of '0', which would 
cause the Property's default setting of '30' seconds to be utilized. This default refresh rate caused too many checks to update the 
file which could possibly cause the KDSController.cfg file to generate incorrectly, and would require users to revert back to the 
last successfully saved one, or it could possibly generate a corrupt file that could not be used going forward. This has been 
corrected by modifying the DbDownloadHandler.dll. The previous ‘Database Refresh Rate’ default setting of '30' seconds was 
increased to '600' seconds. 

22575 Issue: When using the 'Recall' function from a KDS Bump Bar with no more chits to recall, it froze up the KDS Display application 33644 

Resolution: Previously, the 'Recall' function would work as expected from a KDS Bump bar until there were no more chits to recall. Once 
the KDS Display application froze, the Restaurant Display Controller (RDC) would have to be restarted in order to restore the 
KDS Display. This has been corrected by modifying the KDS.exe (version 2.2.5.981 or higher). 

25005 Issue: The PosToKdsHandler threads used the same EGateway client 33861 

Resolution: Previously, multiple threads in the KDS message handler used the same instance of EGatewayClient which caused contention 
problems. Additionally, there was a version mismatch between the DBDownloadHandler and the processes which were calling it 
for updates. There were no errors being displayed by this condition, however, it did cause the KDS Controller cfg file to be 
rewritten, stopping on line #41 at 'StartedColor'. This has been corrected by modifying the PosToKdsHandler.dll, 
PosToKdsHandlerWS.dll, KdsToPosServ.dll, and KdsToPosServ.dll files (for both Win32 and WinCE clients). Currently, KDS 
functions (including Kitchen Themes) work as expected. 

mymicros.net

11186 Issue: In order to have XBR configured correctly, the EMC-> Property Parameters-> Options-> [16 – Error Corrects to Transaction 
Log] option was required to be enabled. Option #16’s name and Context Sensitive Help (CSH) text was not accurate and needed 
to be updated to better communicate this requirement 

32490 

Resolution: Previously, if the EMC-> Property Parameters-> Options-> [16 – Error Corrects to Transaction Log] was not enabled, Error 
Corrections were not posted to the Reporting database and therefore were not populating the 'XBR_Statistics' table that’s needed 
for XBR reports . It was determined that option #16’s name and CSH text was not accurate and was required to be changed in 
order to better explain its purpose. This has been corrected by modifying the EMC.exe. With this release, option #16’s name and 
CSH text has been changed to: 

[16 - Post Error Corrects to Reporting Database]

Select this option to post additional error correction detail to the reporting database for use by applications such as XBR. When 
a last item void or a void of a menu item or service charge is performed in the current round, the check detail is saved as special 
detail that is not displayed on the screen or printed on a guest check or a customer receipt, but can be polled by XBR Statistics.

21184 Issue: Indirect Tips were not reported correctly on Employee Tip and Property Tip reports 33491 

Resolution: Previously, when an employee had Direct Tips (Cash tips that were declared upon clocking out) and Indirect Tips (tips paid to 
them from another employee), the tip amount(s) would both display on the Property Tip report, however the Indirect Tip amount 
was posting to both the Indirect Tip line as well as the Direct Tip line, causing the total tips to be overstated by the amount of the 
Indirect tip. The Employee Tip Report displayed the correct total, but did not break down (i.e., itemize) Indirect tips. This has 
been corrected by modifying the MMEmployeeTip.xml, MMEmployeeTipUWS.xml, MMRevCtrTip.xml and 
MMSystemTip.xml report templates. Additionally, the Tip reports lines were changed to the following: 

◾ Direct Cash Tips: 
◾ Direct Charge Tips: 
◾ Total Direct Tips: 
◾ Indirect Tips: 
◾ Total Tips: 

Page 8 of 13Simphony 1.6 Maintenance Release 4



OLC/OTC

26669 Issue: An Offline Labor Cache (OLC) Workstation also running as a Service Host did not post pending Time Card records to the 
Transactional database after being restarted 

33996 

Resolution: Previously, a Workstation designated as the OLC as well as running as a Service Host did not post Time Card records to the 
Transactional database after being restarted. This has been corrected by modifying the OfflineLaborCacheCpp.dll and 
OfflineLaborCacheCpp64.dll files. 

27634 Issue: Offline Labor Cache (OLC) and the Offline Transaction Cache (OTC) connections were sometimes hung up in a waiting or 
closing state 

Resolution: Previously, when SarOps made a call to the OLC/OTC but was interrupted (e.g., by a hung Workstation that was rebooted, in 
most circumstances), the connection was only sometimes successfully closed and reconnected. Over the course of several days, 
this could result in an accumulation of a large number of hung connections to the point that the OLC could no longer accept any 
new connections until it was rebooted or the NIC reset. This has been corrected by modifying the EgatewayClientWin32Cpp.dll 
and EgatewayClientWinCECpp.dll files. 

Ops

6507 Issue: Checks closed on Offline Workstations (WS) that have been Offline in excess of the Check purge interval (e.g., Purge interval = 
15 days, WS Offline = 20 days) will be closed to the date/time on the WS. If these checks are replayed when the WS comes back 
Online, they will post totals to the respective dates that they were closed; however, they will be immediately purged after 
posting, thus preventing editing/reopening. 

30484 

Resolution: See the example shown here: 

Situation:

◾ Check 1 (Opened/Closed on an Offline WS) was closed on Feb 1, 2013. The WS had been Offline since Jan 31, 2013 and 
connection was restored on Feb 19, 2013. The system was set to purge checks after 15 days. 

End result:

◾ Check 1 will be replayed and totals will be added to Feb 1, 2013 totals; however, since the check was older than 15 days, it 
will be purged after the checks totals are posted. 

Workaround:

◾ If a check similar to the example shown above needs to be edited/re-opened after the replay, it will not be possible. Users 
will need to create a negative check that exactly matches the original, and then create a 2nd (positive) check that reflects 
the correct order detail information. 

6589 Issue: The various possible reason(s) that a Credit Card (CC) Authorization (Auth) might not succeed were always displayed as 
‘DECLINED’ on the Workstation 

32749 

Resolution: Previously, when a CC Auth was not approved; there should have been a code that was returned that corresponded to the specific 
reason that the Auth failed. In Simphony, any Auth that was not approved always came back as 'DECLINED'. Certain other 
messages appeared correctly, such as 'Invalid Card number', or 'Card is Expired'. The VisaNet specification indicated that all 
non-approved codes should not be interpreted as ‘DECLINED’, however, since this was how it performed in a legacy MICROS 
application, this was how it was also implemented in Simphony v1.x. In the list of expected Response Codes, each two digit 
response code has a specific definition. For instance, code number '43' indicates a 'Stolen Card' pick up definition. Code '51'
indicates 'Decline due to ‘Insufficient funds’' and code '61' indicates Decline – ‘Exceeds Withdrawal limit’'. This has been 
corrected by modifying the SarOps*, CAPMS.dll and CAPMS.dll (for WinCE clients) files. 

6691 Issue: Applying multiple coupons Discounts to the same check could result in performance issues 30813 

Resolution: Previously, each time a Discount was entered, the system recalculated the totals and reevaluated the check detail to determine 
Discount eligibility. The more Discounts that were applied, the time spent to determine Discount eligibility would grow 
exponentially to the point that the Workstation appeared to be unresponsive. A change has been made to SarOps.exe so that the 
Discount engine will be allowed to calculate a Discount for 500 milliseconds (half a second). Currently, if the Discount 
calculation time exceeds 0.5 second, it will stop applying the most recently added Discount and the Best Deal found up to that 
point will be the Discount amount that will be applied. 

14376 Issue: When using the CAPMS Credit Card (CC) Driver, the Authorization (Auth) Referral Response prompted users to enter a Manual 
Auth code, but did not write the assigned Auth code to the check 

32748 

Resolution: Previously, according to the Simphony v1.5 CAEDC PMS Interface Specification Manual, when a CC Authorization was sent to 
a CC processor, there were three possible Authorization Status responses that may be returned. They are: 

Authorization Status N1 - This indicates the CC Authorization status: 

◾ 1 = Approved
◾ 2 = Declined
◾ 3 = Referral (Manual Authorization Required)

When the response was a '1' or a '2', the response was handled correctly and the Auth code was either written to the check or 
declined. When the response was a '3', SarOps would prompt users to enter a Manual Auth code, as opposed to retrieving one 
automatically. Once this code was entered, it should have been treated as a Manual Auth (Phone Auth) and written to the check. 
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However, once the Manual Auth code was entered, SarOps did not write the Auth code value to the check and returned to the 
point of the Check Detail just prior to the Auth. This has been corrected by modifying the SarOps.exe. Currently, users are 
prompted for the Auth code during an Auth attempt. The Manual Auth code is saved upon performing a Service Total and 
verified when the check is picked up. Additionally, Manual Auth codes are sent in the Auth response messages and are also 
included within a CC batch. 

14439 Issue: Credit Card (CC) Preamble length settings were ignored when the Credit Authorization (CA) amount was under the configured 
Tender Media-> 'Offline Limit' setting 

32759 

Resolution: A Credit Authorization will not be sent for a lower amount than the Tender Media-> 'Base limit' setting. Previously, in the 
instance where a CC Preamble length was set as well as a CA ‘Offline Limit’, and the CA Driver (i.e., CC Service Host) 
happened to be down, any CC number with a valid Mod-10 value and a matching Preamble, regardless of the overall length, 
would be accepted as that CC type. While this allowed the check to appear to close normally, when the CC batch was 
transmitted, it failed on that record. This has been corrected by modifying SarOps.exe (for TPID #19312). Currently, invalid CC 
numbers are not accepted if the CC Service Host becomes unavailable. CC Preambles with account number lengths are no longer 
ignored. When the CC Preamble length is configured to be 13, only 13 numbers are accepted. 

19312 Issue: Credit Card (CC) Preamble length settings were sometimes ignored under certain circumstances 33236 

Resolution: Previously, even though specific Preamble settings were used, it was still possible for some CC’s to ignore the configured 
Preamble length values. If only 2 digits were used before a wildcard entry, and the CC number in question had a '0' for the 
second digit, the Preamble length would be ignored and the CC could still be used to close the check. Eventually this CC 
transaction would end up failing during the CC Settlement process. This reported issue was occurring when either the CAPMS or 
VisaD CC drivers were being utilized. This has been corrected by modifying SarOps.exe. Currently, configured CC Preamble 
account number lengths are no longer being ignored. For example, if a CC’s Preamble length is configured to be 13, only 13 
numbers are accepted. 

20218 Issue: The Open Check SLU did not remove Closed checks on the original (check creating) Workstation (WS) when a check was 
closed from an alternate WS 

Resolution: Previously, when a check was created on a WS and the Open Check SLU was open and displayed on this same WS, when the 
check was picked up and closed from an alternate WS, the same "Closed" check continued to display in the Open check SLU on 
the original WS. This has been corrected by modifying the SarOps.exe. Currently, Open checks dynamically update on SLUs in 
either Green or Yellow modes. 

21060 Issue: An Automatic Discount Coupon with a name using over 28 characters with the [5 - Reference Entry Required] option enabled 
would crash Ops when applied 

33462 

Resolution: Previously, when configuring Discounts, a discount name could be entered using up to 32 Alpha Numeric characters. 
Additionally, the 'Name' field would allow users to use a variety of special characters. However, if a Discount/Coupon name 
exceeding 28 characters was used with the [5 - Reference Entry Required] option enabled, SarOps would crash when that 
coupon was applied due to an overlap in the buffer. This has been corrected by modifying SarOps.exe. 

Note: Longer Reference Entries are supported; however SarOps will truncate Reference Entries exceeding 19 characters 
on Guest Checks and Customer Receipts. 

21309 Issue: When Service Charge option [11 - Do Not Post to Gross Receipts] was enabled and an Autogratuity was applied, the option 
was ignored and sales would be incorrectly posted to the 'Gross F&B Receipts' section on the Employee Tip Report 

Resolution: Previously, when a Service Charge was programmed with option [11 - Do Not Post to Gross Receipts] enabled to prevent 
posting to Gross F&B Receipts, no sales from a check with that Service Charge would post to the Employee Tip Reports if the 
Service Charge was manually applied. When the same Service Charge was linked and applied as an Autogratuity, option 11 was 
being ignored. This has been corrected by modifying SarOps*.exe. Currently, option 11 now functions as expected for both 
manually and automatically applied Service Charges. 

21910 Issue: After making changes to options within a Menu Item Class record, all Menu Items (MI) associated with that class could not be 
successfully rung up and users received a 'Tax Class Not found' message 

33559 

Resolution: Previously, after making changes to a MI Class record, users were required to perform a full DBDownload on Workstations in 
order to be able to ring up MI’s that had the edited MI Class assigned to them. Automatic Partial DBDownloads on Workstations 
were not working as expected and was also affecting numerous other EMC modules. This has been corrected by modifying the 
DbDownloadHander.dll. With this release, changes made in the EMC will automatically update the WS’s (depending on the WS 
database update interval setting; the default is 60 seconds) and no longer require full DBDownloads to be on WS’s by users. 

22083 Issue: The Offline Transaction File (OTF) Edit tool was unable to open a OTF .bin record and users received the error message shown 
here: 

Additionally, no statistics were being created, no fixed file(s) were being created and no dump file(s) were being created. This 
essentially left the Offline transactions in the failed OTF records and in an unrecoverable state. 

33591 
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Resolution: Previously, for users running Simphony v1.5 MR5 or v1.6 GR and higher, any 'OTF' or 'OTF msg err' file that was attempted 
to be run through the 'OTFEdit' tool would display the 'Record version too new' message. This has been corrected by 
modifying the OtfEdit.exe. Currently the OTFEdit tool performs as expected for Simphony v1.5 MR5 and v1.6 GR and higher. 

25291 Issue: After using the [422 - Adjust Closed Check] function, Voiding a Tender payment was not allowed when a Discount had been 
applied 

Resolution: Previously, users received a Not Allowed - Must Remove Automatic Discounts message from Ops when attempting to 
Void a Tender payment after using the [422 - Adjust Closed Check] function. This has been corrected by modifying 
SarOps.exe. 

25294 Issue: Discounts were not reflected properly on a printed Guest Check until the check was tendered 

Resolution: Previously, Discounts were not appearing in the check detail of a printed Guest Check and the Discount Net amount was not 
displaying in the Summary Totals area when the check was Service Totalled. If the check was tendered, the check detail 
displayed the Discount, Summary Totals and the Discount Net amount as expected. This has been corrected by modifying 
SarOps.exe. Now when a check containing a Discount is Service Totalled, the Discount is printed in the check detail area and is 
reflected appropriately in the Summary Totals. 

25337 Issue: Coupon discounts were not working as expected when the Discounts-> General tab-> Options-> [1 – ON = Open; OFF = 
Preset] option was enabled 

33888 

Resolution: Previously, when Discount-> option [1 – ON = Open; OFF = Preset] was enabled, users were prompted to enter an amount for 
the Open discount. However, when an Open discount amount was entered, the coupon would apply to the check’s entire 
'Amount Due' up to the configured 'Max Amount' threshold setting. This has been corrected by modifying the SarOps*.exe. 

25434 Issue: Automatic Coupon Discounts printed twice on Guest Checks and Customer Receipts 33896 

Resolution: Previously, when an Automatic Coupon Discount was applied, it printed two discount lines on Guest Checks and Customer 
Receipts. One line had solely the coupon discount's name (with no discount amount adjacent to it) and the other line had both the 
coupon discount's name and the discount amount. This could have caused confusion for users. With this release, the printing of 
two discount lines has been eliminated by modifying SarOps.exe. Currently, only one coupon discount line (along with the 
discount amount) will print on the Summary Detail section of Guest Checks and Customer Receipts. 

27259 Issue: VAT lines were printed incorrectly on Customer Receipts on discounted transactions containing Menu Items posted with 
multiple quantities 

34031 

Resolution: Previously, if a quantity of Menu Items (e.g., quantity 3 Menu Item) was posted to a transaction using VAT Tax and a 100% 
Discount was applied, if the VAT Tax Lines were printed (RVC Parameters Tax option [Print VAT Line for Rate x] was 
enabled), the totals on the printed VAT Tax Line were incorrect. This has been corrected by modifying the SarOps.exe. 
Currently, the VAT Tax Line now displays the correct totals. 

27964 Issue: Automatic Service Charges on reopened closed checks (with Voids) using the [423 - Reopen Closed Check] function, posted as 
negative Non-Revenue Service Charges when the check was closed again 

34080 

Resolution: Previously, Automatic Service Charges posted as Non-Revenue Service Charges when a closed check (with Voids) was 
reopened using the [423 - Reopen Closed Check] function. This reported issue also occurred when closed checks (with Voids) 
were re-opened using the [422 - Adjust Closed Check] function. This has been corrected by modifying SarOps.exe. 

27987 Issue: When using a PMS/SIM Interface, the PMS Link always reused the most recently used PMS Link number in Ops 88013 

Resolution: Previously, when multiple [SIM Inquire] function buttons were configured, the Workstation would recall and use the most 
recently referenced SIM Inquire function despite using differing SIM ISL’s for each [SIM Inquire] button. Additionally, users 
would receive an error on the Ops client that displayed a message according to the called SIM script. A DBDownload did not 
resolve this issue. Users were forced to close and reopen SarOps and once again select the desired [SIM Inquire] button. This 
has been corrected by modifying SarOpsXXX.exe. 

30000 Issue: When the EMC-> Workstations option [7 - Use Cash Drawer 2 for Other Currency] was enabled, after assigning an employee 
to Cash Drawer 2, it would also allow them access to Cash Drawer 1 

Resolution: Previously, for sites utilizing Alternate currencies, employees assigned to Cash Drawer 2 (containing the Alternate currency) 
could also access Cash Drawer 1 (containing the Base currency) despite another employee having been assigned to Cash Drawer 
1. If the EMC-> Property-> Workstations-> Options tab-> Hardware/Cash Drawer tab-> Cash Drawer Options-> [7 - Use Cash
Drawer 2 for Other Currency] option was enabled and the EMC-> Currency-> Alternate Currency Options were also set 
accordingly, Cash Drawer 2 access should have remained limited to the employees assigned to Cash Drawer 1. This was not the 
case. This has been corrected by modifying SarOps.exe. Currently, when option 7 is enabled, SarOps will assume that the 
assigned Operator (if any) will also be assigned to Cash Drawer 2 (foreign currency). If an attempt is made to assign another 
Operator to Cash Drawer 2, they’ll receive a Cash Drawer is being used for other currency message. 

31154 Issue: Automatic Discounts doubled when a Closed check was Reopened and adjusted 

Resolution: Previously, when a closed check was reopened using either the [422 - Adjust Closed Check] or [423 - Reopen Closed Check]
functions and had an Automatic Discount applied, the discount was applied again if the check was adjusted. Once an Automatic 
Discount had been applied to a check, the Discount engine was supposed to be disabled, but it wasn’t. This has been corrected by 
modifying SarOps.exe. Currently, the closed check Reopen functions work as expected in regard to allowing users to Void Menu 
Items that had an Automatic discount applied to them. 

Note: Users cannot Void specified Discounts on reopened closed checks and if attempted, will receive a 'Void not 
Allowed' message. 
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PMC Reports

25075 Issue: PMC Cashier Financial reports had incorrect date formatting in the Rounding query which caused the reports to fail at sites 
running Oracle® 

33868 

Resolution: Previously, for Oracle sites, when users ran PMC Cashier Financial reports, the reports timed out because there was incorrect 
Oracle date formatting in the Rounding query. Users received the following error: 

General Report Error 

Failed to get report [Cashier Financial] from Mymicros.net Exception fetching report 
[The operation has timed out] 02/14/13 17:26:29, 0, 0,LoadHandlers, 12,Exception 
fetching report [The operation has timed out], 02/14/13 17:26:29, 0, 0,LoadHandlers, 
12,Failed to get report [Employee Financial] from Mymicros.net Exception fetching 
report [The operation has timed out], 02/14/13 17:26:29, 0,-2,CallHandlers, 
12,EGateway.ProcessRequest: WARNING - Long Request WsId 642 MsgType 1003. SeqNum 
275518 TimeMs 20359,

This has been corrected by adding the missing 'to_date' syntax to the Rounding query in order to format the date to meet Oracle 
requirements. 

Reports

5860 Issue: The Employee Permissions Report and the EMC both timed out when users attempted to query employee information 

Resolution: Previously, when running the Employee Permissions Report, the system was running multiple full table scans against the 
Transactional database STRING_TABLE. This resulted in the report timing out. This has been corrected by modifying the 
EMCHandler.dll. Currently, the Employee Permissions Report can be successfully generated without timing out. 

SIM

15002 Issue: The SIM script '@WSID' (Workstation ID) variable returned the Workstation (WS) Object Number instead of the ID 32828 

Resolution: Previously, when the @WSID Interface Scripting Language (ISL) variable was employed, it actually returned the Workstation’s 
Object Number, which was only unique within the Property level, but could be duplicated on the Enterprise level. Since the use 
of this variable was previously based on a legacy MICROS application (where there was no Enterprise environment support), 
herein lied the problem. This has been corrected by modifying the SarOps.exe. Currently, use of the ISL @WSID variable 
returns the system-wide unique Workstation ID value as expected. 

UER

20375 Issue: When the User Experience Report (UER) was enabled, the EGateway log would sometimes throw a 'Value too large' error 
message 

33355 

Resolution: Previously, when the User Experience Report (UER) was enabled, it was possible that some values would not post from the 
Workstation (WS) to the Transactional database , and throw a 'Value too large' error message. Furthermore, this same 
EGateway log entry was not detailed enough to assist troubleshooting efforts. This has been corrected by modifying the 
TotalPosting.dll. 

Utilities

30895 Issue: The Repost Totals tool did not include two required files upon a standard application installation which resulted in users 
receiving a database connection error message 

Resolution: Previously, the Repost Totals tool was included in a standard application installation, but any attempts to run this tool in 
Simphony v1.6 and above (fresh install), resulted in a failure to connect to the Transactional database. Users would receive the 
following error message: 

This was due to two files not being installed in the <Drive letter>:\Micros\Simphony\Tools\RepostTotals folder. These files were 
the OraDbHelper.dll and SQLDbHelper.dll. This has been corrected by ensuring that these two files are properly installed in the 
correct path to the <Drive letter>:\Micros\Simphony\Tools\RepostTotals folder. 
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Simphony 1.6 Maintenance Release 2

This article is a quick reference guide to features, enhancements, and revisions for Simphony 1.6 Maintenance Release 2. 
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◾ 7 See also

Prerequisite Knowledge 

This document assumes the reader has the following knowledge or expertise: 

◾ Understanding of basic network concepts 
◾ Experience with Microsoft Windows platforms and terminology 
◾ Familiarity with this product line and its hardware, software, and peripherals 

Document Overview 

For the printable collection for this version, see 1.6 Collection

This document includes the following sections: 

What's New
This section describes new features in this software release. A new feature is one that provides 
capabilities that were not available in previous versions. 

What's Enhanced
This section describes enhancements in this software release. An enhancement is a change 
made to improve or extend an existing feature, under the following criteria: 

◾ The basic feature or functionality already exists in the previous release. 
◾ The change adds to or expands on the current process — it does not replace it. This 

differs from a revision that corrects a problem. 

What's Revised
This section describes issues that have been corrected. A revision is a correction made to an 
existing form, feature, or function, using the following criteria: 

◾ The item must be part of the previous version. 
◾ The change must replace the current item or remove it from the application. 

Terminology 

◾ A Fix ID is an internal tracking number used by R&D. This ID is primarily used by R&D personnel; it is helpful for mapping fixes to 
documented items. 

◾ A CR# is a "Change Request ID" that is generated during the escalations process. When a case is started at the Support Center and the 
issue is determined to be an application defect, a Change Request is created, informing R&D that an issue needs to be fixed. 
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New Features 

Fix ID Feature CR #

Ops

13176 'Amount Rounding by Tender Media' is now supported

The rounding of the 'Amount Due' on checks was previously enabled only by configuring the 
'Currency' module. With this release, users can configure 'Amount Rounding by Tender Media' as 
well. To configure this feature, several option bits have been added throughout the EMC. See the 
Amount Rounding by Tender Media article for more information. 

Enhancements 

Fix ID Enhancement CR #

Credit Card Batch Process

3177 Credit Card Batch Creation performance has been optimized

It was reported that for some locations, the Credit Card (CC) Batch creation process was taking too long to 
complete. This has been corrected by modifying the ECCServer. The CC Batch creation times have been 
greatly reduced such that when batching approximately 10,000 CC records, the average time was about six 
minutes (down from an approximate average of fourteen minutes). This optimization applies to both 
Microsoft SQL Server® and Oracle® database platforms. 

DBDownload

18739 The Help Strings have been moved to a separate Transactional database table entitled 
HELP_SCREEN_STRINGS with all data in National Character Large OBject (NCLOB) format

Previously, Help Screen Strings were contained in the STRING_TABLE in NCLOB format. Queries 
performed against the table with the Help Screen Strings being in this format were highly resource 
consuming. The ‘StringText’ column in the STRING_TABLE has been converted from NCLOB to 128 
characters and an index created on this column. Since the removal of the Help Screen strings to another 
database table, queries performed on the string table will be less resource intensive. The NCLOB change 
was for Oracle® only. The Microsoft SQL Server® data type did not change, but the length was changed 
from MAX to 128 characters. Additionally, a performance improvement was made to the 
STRING_TABLE to prevent all employee names from the entire Enterprise being sent to every Property. 

Data Transfer Service (now Labor Posting Service)

11617 The former Data Transfer Service (DTS) has been renamed to the Labor Posting Service (LPS) and has 
had its performance optimized

Previously, the DTS consumed large amounts of memory and system resources. Prior to this release, DTS 
also had the limitation of only running on one Application Server and ran a separate thread for each 
Property which significantly increased system-wide messaging. This has been corrected by modifying the 
DBUpgrade.exe, EMCData.dll, Emc.exe, Installer.exe, LaborPostingService.exe and 
TranslationServiceUtils.dll files. 
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With this release, the Labor Posting Service (LPS) will be introduced. The LPS is replacing the DTS and will 
serve the same labor posting function, however now it has the ability to be installed and run from more than one 
Application Server and process each Application Server’s messages concurrently. 

Labor Posting Service Changes

◾ For new installations, the LPS will be installed (if selected to do so from the install splash screen shown 
here) as well as be set to automatically start upon booting up. 

◾ From the EMC-> Property level-> Reporting-> MyMicros-> Job tab, a new column has been added named 
'Last Posting Server' (as shown here) which will list the Application Server name that made this 
Property’s last Labor posting along with its most recent run time. 

◾ For upgrades from prior versions, the DTS will be removed and the LPS will be installed. 
◾ The executable’s name was changed from ‘DataTransferService.exe’ to ‘LaborPostingService.exe’. 
◾ The name of the log files were changed from ‘TransformationService.log’ to ‘LaborPostingService.log’. 
◾ LPS can be installed on multiple Application servers and these servers can process data concurrently. 
◾ The default number of threads will be determined automatically based upon the number of Application 

servers and the number of Properties. 
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Egateway

19622 Support has been added for installing Service Hosts on the 64-Bit Operating Systems (OS) listed below

Previously, 64-Bit OS’s were not supported for use for Service Host installation. With this release, the 
following 64-Bit OS’s now support Service Host installation: 

◾ Windows 7® 64-Bit 
◾ Windows Server® 2008 Standard 64-Bit 
◾ Windows Server® 2008 R2 

Note: Windows Server® 2003 64-Bit will not be supported for the use of Service Host installation. 
Additionally, not all Service Hosts are currently supported in 64-bit mode. With this release, Credit 
Cards, Interfaces, SIM and VSS are supported in a 64-bit environment; Offline Labor Cache (OLC) and 
KDS can be used on 64-bit machines, but will need to have 32-bit IIS enabled to do so. Their 64-bit 

versions will be supported in future releases. 

Revisions 

Fix 
ID Revision CR #

CAL

6813 Issue: Servicehost.xml(s) were not updating or downloading correctly onto Service Hosts on an intermittent basis 25483 

Resolution: Previously, after rebooting Service Host machines, sometimes the Servicehost.xml(s) updates and downloads 
were missing. This has been corrected by modifying the EMC.exe and DataTransferService.exe for alternate 
fixes. 

Credit Card Batch Process

9027 Issue: The Credit Card (CC) Batch Report results did not sort correctly when running a report for multiple days 32137 

Resolution: Previously, when the CC Batch Report was generated using a date range, the results displayed in a seemingly 
random order. This has been corrected by modifying the ECCServer file. 

19086 Issue: Credit Card Batch Transfers failed on large batches with multiple Credit Cards (CC) on the same Check 
using the same CheckID 

33191 

Resolution: Previously, when the total number of records in the CC batch exceeded the 'Max Batch Size' value, the batch 
was broken into smaller data chunks and sent one after another. When that break between chunks occurred on 
a check with more than one CC number, the transfer failed with the following message being written to the 
EGateway log of the CC Service host: 

This has been corrected by modifying the ECCServer to allow checks in this situation to be moved to the next 
grouping making the first grouping less than the Max amount. Currently, large CC batches are successfully 
created and settled without further issue. 

Data Transfer Service (now Labor Posting Service)

7056 Issue: Employee Time Card calculations were resulting in an inexact number of Regular hours worked when 
Overtime was present 

31470 

Resolution: Previously, when a time card punch was written to mymicros.net, the former Data Transfer Service (DTS) 
calculated the number of hours from the Clock-In and Clock-Out information. The number of hours was 
rounded to 2 decimal places, and due to rounding, could cause the number of Regular hours before Overtime 
to be off by one-hundredth of an hour (or 6 tenths of an hour or 36 seconds). This caused the number of 
Regular hours to display as 40.01 or 39.99 (when Overtime was present) when it should show up as exactly 
40 hours; the results of which caused Payroll issues. This has been corrected by modifying the 
LaborPostingService.exe and 9700DBReader.dll. 
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DBDownload

8703 Issue: Changing Touchscreen Bitmaps caused Bitmap distribution to apply to more than just the desired Property(s) 32096 

Resolution: Previously, it was reported that a Bitmap that was assigned to a Touchscreen for a specific Property became 
available to other Properties Touchscreens via the Workstation Status Control-> Bitmap list. With this 
release, this reported issue was not reproducible. 

11284 Issue: Changes to Service Hosts were not being picked up in background or forced DBDownloads 32502 

Resolution: Previously, when it was necessary to change which machine a service ran on (for instance, a Win32 client 
running VisaD that had a hard drive failure); these changes may be made rather easily in the EMC. The 
machine that was now currently running the service will actually run the newly assigned service, but any 
Workstation that had the value for the previous Service Host would not be updated. This has been corrected 
by modifying the EMC.exe. Currently, the background DBDownload now picks up all of the changes to 
Service Host files on both Win32 and Windows CE clients. Full DBDownloads can also be used but 
generally won't be necessary if the only change made was to the Servicehost.xml files. 

20460 Issue: A Revenue Center’s (RVC) Default Order Type configuration was replaced with invalid information after a 
partial DBDownload 

33362 

Resolution: Previously, when an Enterprise had more than one Property, and the Property that was not the first Property 
had a RVC with the RVC Parameter’s-> 'Default Order Type' was set to a value that was not assigned Object 
Number '1', and a change was made to the RVC Parameters module (such as changing the taxes that were 
active in any of the Order Types), Workstations failed to start checks and users received a 'Default Order 
Type is inactive' message. This has been corrected by modifying the Dbdownloadhandler.dll for an alternate 
fix. This reported issue can no longer be reproduced. 

Direct Posting Service

14437 Issue: Tax totals between the Simphony GUEST_CHECK and GUEST_CHECK_LINE_ITEM database tables were 
not always balancing in mymicros due to possible Amount Rounding errors 

32758 

Resolution: Previously, when posting Tax totals to mymicros.net, the Direct Posting Service (DPS) was not prorating 
taxes in the Simphony GUEST_CHECK_LINE_ITEM database table. This has been corrected by modifying 
the DirectPostingService.exe and SAROps.exe. Currently, the correct Tax totals are being posted to 
mymicros.net. 

14662 Issue: Discounts that required a Reference Entry were no longer posting correctly to the Reporting database 32785 

Resolution: After an upgrade, transactions that had a Discount that required a Reference Entry could no longer be found 
in mymicros.net using Audit & Analysis by generating a search on the Reference Entry text. It was 
determined that the Reference Entry information was not posting to the Reporting database table 
Guest_Check_Line_Item.detailtype 2 column. This has been corrected by modifying the 
DirectPostingService.exe. Currently Reference Entry text can be successfully searched using Audit & 
Analysis and the Reference Entry text now posts to the Guest_Check_Line_Item.detailtype 2 column. 

19832 Issue: When using both a Value Added Tax (VAT) and an Inclusive tax for Shared items on same check, the full 
Inclusive tax amount of the original item was posted for each shared item, rather than sharing the tax amount 
evenly 

33296 

Resolution: Previously, this reported issue only occurred with Shared items on different seats on the same check. This has 
been corrected by modifying the SarOps*. Currently, when using Seating and Shared and Split Checks that 
included transactions with Service Charges and Discounts applied; it was determined that the correct tax 
amount was being evenly applied per item. 

EGateway

6597 Issue: Removing the last Service from a ServiceHost did not successfully remove the record from the Simphony 
database SERVICE table 

30615 

Resolution: Previously, the last Service to be removed from a Workstation (not including SarOps and the Print 
Controller) would not successfully delete from the Simphony database SERVICE table and would also not 
update the ServiceHost.xml correctly. This has been corrected by modifying the DataTransferService.exe and 
EMC.exe files. 

16709 Issue: Default Workstation transmission keys were not being created during software installation 

Resolution: Previously, default Workstation transmission keys were not being written to the database during software 
installation. This has been corrected by modifying the Installer.exe. Currently, during installation, a check is 
run for existing transmission key(s) in the Transactional database. If a Workstation transmission key does not
exist, a new one is added. If a Workstation transmission key does exist, no changes are made. 
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EMC

7245 Issue: Counters for Workstations 'Status Codes' were needed in the EMC-> ‘Playback Control’ module 30765 

Resolution: Previously, when accessing the EMC-> Enterprise level-> Workstations tab-> 'Playback Control' module, 
users had to manually count each record that was returned when searched by the following Workstation 
Status Codes: 

◾ Online 
◾ Ready 
◾ Replaying 
◾ Pending 
◾ No Contact 
◾ NEVER 

This proved be a cumbersome process for larger Enterprises. This has been corrected by modifying the 
EMC.exe. Currently, (as shown below) counters will automatically calculate and display values per Status 
Code in this module. 

9006 Issue: On Oracle® systems, after users declared a starting bank and the Business Date was incremented, a Stack 
Trace error was being thrown in the Transactional database PCAQEQ_LOG table; 
IncrementBusinessDate.ResetBank 

32133 

Resolution: Previously on Oracle® systems, when the EMC-> Employee Classes-> Operator Options-> [13 - Bank 
Entry Required at Beginning of Shift] option was enabled and a user declared a starting bank, when the PC 
Autosequence incremented the business date during the Start-of-Day (SOD), a Stack Trace error was being 
thrown in the EGateway log file. This has been corrected by modifying the SequencerEngine.dll. As a side 
note, in order for starting bank declaration to work correctly, the EMC-> RVC Parameters-> General-> 
'Default Bank Loan Tender/Media' must be configured in addition to enabling the Employee Class-> 
Operator Option-> [13 - Bank Entry Required at Beginning of Shift] option. 

21539 Issue: The Context Sensitive Help (CSH) file for the EMC-> Employee Classes-> Operator Options-> [13 - Bank 
Entry Required at Beginning of Shift] option needed to be updated 

Resolution: It was determined that the CSH for Operator option #13 needed to offer more configuration assistance in 
order to successfully configure the system to require users to declare a Starting Bank prior to creating new 
checks. This has been accomplished by modifying the EMCText.dll. Currently, the CSH text for option [13 - 
Bank Entry Required at Beginning of Shift] reads as follows: 

This option bit has no effect unless you also go to "RVC Parameters - General - "Default Bank Loan 
Tender/Media" and configure a tender media.
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Import/Export Service

19197 Issue: The Import/Export Service failed when run on multiple Properties due to a Temporary file not being 
accessible simultaneously 

33202 

Resolution: Previously, changes were made to the Import/Export utility to break larger files into more manageable data 
chunks. When these chunks were created, they were done using a temporary file. The filename of the 
temporary file was the same for each instance of the Import or Export utility that was running. When running 
a series of imports or exports on multiple Properties, the temporary file (Simphony_Temp.xml.part1.xml) had 
not finished with the last one when the next one attempted to use it, causing the import to fail with the 
following message: 

Start processing data.. 
Error happened when read file to byte array 
Error - The process cannot access the file  
'C:\MICROS\SIMPHONY\Tools\ImpExp\Simphony_Temp.xml.part1.xml'  
because it is being used by another process. 

This has been corrected by modifying the ImpExp.exe. Currently, every instance of the Import or Export 
utility being run will generate the creation of unique folder names for each thread, thus avoiding any 
temporary file access conflicts. 

Install

13601 Issue: During installation, the new MCRSCACHE database tables failed to be created and did so without users 
receiving a message prompt 

32670 

Resolution: Previously, in Simphony v1.6, a new encryption scheme was put into place that did away with the SData1 
and SData2 databases; instead moving the Encryption key and Passphrase information into the 
MCRSCACHE database. This required several database tables, triggers and sequences to be created during 
the installation process. This was not part of a Database upgrade, but rather part of the Installer program. If 
the correct permissions were not present to allow database tables to be created, this portion of the install 
failed, but did so silently, only showing an error in the 'SimphonyInstallLog', which had to be manually 
accessed and reviewed. This has been corrected by modifying the Installer program. Currently, users will 
receive messages in the event of any Installation failures. 

10710 Issue: Windows Server® 2008 R2 required a number of manual changes to the system to get Simphony v1.x to run 
correctly 

32407 

Resolution: Previously, it was reported that upon installing Simphony v1.x on machines running Windows Server® 2008 
R2, that the EGateway may not have run correctly due to permissions issues. This has been corrected in 
subsequent versions of Simphony and with this release. Currently, no access or permissions errors were 
detected during either partial or full software installations. 

OLC / OTC

6590 Issue: Ops ran very slowly for employees that were clocked into a Workstation at the time the configured Offline 
Labor and Transaction Cache (OLC/OTC ) went offline 

30596 

Resolution: Previously, there was degradation of performance speed on Ops clients when the OLC was no longer 
available and employee’s attempted to 'Clock In\Out', 'Sign In' or use the 'Begin Check' functions. This has 
been corrected by modifying the SarOps*.exe, EClientWayClientWin32CPP.dll and 
EGatewayClientWinCECPP.dll files. Currently, if the OLC loses its availability, there will still be a varying 
performance lag time (depending on Workstation type) until the system can first determine that it cannot 
access the OLC (via a background PING job) and once aware of the lack of connectivity, Ops performance 
will begin to return to its usual performance speed. 

Ops

6531 Issue: The Value Added Tax (VAT) type was miscalculating taxes when the '@/For' function was used with Menu 
Items that had applied Automatic Discounts 

30505 

Resolution: Previously, when using VAT, and the ‘@/For’ function for one Menu Item (i.e., 2 @ Cold Cereal) and there 
was an applied Automatic Discount, the tax amount was calculated incorrectly on the Guest Check and on 
mymicros.net reports. When a Menu Item was entered separately, by pressing the SLU button twice or by 
specifying that the Discount was an Item Discount, the tax amount was calculated correctly. This has been 
corrected by modifying the SarOps* and DirectPostingService.exe files. 

6710 Issue: Voids of Discounts on Split checks that had Seat edits performed did not post to mymicros.net Detail reports 30844 

Resolution:
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Previously, when a Discount was Voided from a check that was begun as a Split check and then had Seat 
edits performed, it would not display the Voided amount in certain mymicros.net reports and drill down 
sections. The ‘Employee Financial’ report would display the correct Discount amount in the upper section, 
but the Detail section at the bottom would display an exaggerated Discount amount as the Voided Discount 
(positive) did not display. The same was true of the ‘Daily Ops’ report, where the Discount at the upper level 
was correct, but did not include the Void of the Discount in the ‘Sales Mix’ drill down, under ‘Sales Less 
Item Discounts’. This affected not only report balancing, but may have affected the employee’s reconciliation 
closeout amounts. 

With this release, this reported issue was not reproducible. This issue was likely resolved with another fix 
(SCR #11134 in Simphony v1.6 GR) by modifying the DirectPostingService.exe. 

6778 Issue: When the @DSCI SIM script variable was utilized, it always returned a 0.00 value 30996 

Resolution: Previously, when the @DSCI variable was used in a SIM script, it should have returned the sum of the value 
of the items on that check that belonged to that Discount Itemizer. In Simphony v2.x, it always returned a 
0.00 value. This has been corrected by modifying the SarOps.exe. 

8692 Issue: Duplicate Table numbers could be used for Fast Transactions despite an option bit configuration to the 
contrary 

32091 

Resolution: Previously, if following options were enabled: 

1. EMC-> Revenue Center-> RVC Parameters ->Posting and Control-> [9 - Allow only one Group per
Table]

2. EMC-> Personnel-> Employee Maintenance -> Operator Records -> Options-> [1 - Table Number
Entry Required to Begin/Pickup Checks]

When users picked up a check and were prompted to enter a Table number, they were able to assign the same 
Table number more than once for the same check. This has been corrected by modifying the SarOps.exe. 
Currently, Fast Transactions perform as expected; the system only allows users to enter one Table per check 
as configured in the EMC. 

17498 Issue: Bitmap files were not working as expected for any of the Touchscreen Design module’s -> ‘Background 
File’, ‘Media File’ or ‘Idle Media File’ locations 

33068 

Resolution: Previously, the use of Bitmap files were not working when assigned to touchscreens from the Touchscreen 
Design module. The Touchscreen Design module’s Context Sensitive Help (CSH) files have been updated to 
outline the supported formats for the ‘Background File’, ‘Media File’ or ‘Idle Media File’ fields. Currently, 
the ‘Background File’ field is the only field that should be configured using a .bmp format. Bitmaps will now 
display as expected when assigned from the ‘Background File’ field. The ‘Media File’ and Idle ‘Media File’ 
fields support either a .wmv or .wav format. See the ‘Touchscreen Design’ article to view the updated CSH 
text for the Touchscreen Design module’s fields. 

20708 Issue: Changing a Sub level Price using a Macro did not function as expected in Negative amount transactions 33395 

Resolution: Previously, upon utilizing a Macro to change a Menu Items Sub level price, it would not apply the correct 
Sub level price on negative transactions, particularly when attempting to use the 'Transaction Void'
function. Users would receive a 'Not allowed with Transaction Void' message on the Ops client display. 
This has been corrected by modifying SarOps*.exe. 

PMC Procedures

9195 Issue: When editing an employee's Time Card entries from the PMC, the action was written to the Audit Trail, but 
did not write the employee number or the name of the employee making the edit 

32159 

Resolution: Previously, the Audit Trail displayed 'Employee 0 – None' upon performing Time Card edits. This has been 
corrected by modifying the SarOps*.exe. Currently, employee’s who perform the Time Card edits are 
correctly reported in the Audit Trail module. This holds true for Clock-In and Clock-Out functions as well as 
Time Card adjustments. 

PMC Reports

6513 Issue: The 'Report Group' option-> [4 - Do Not Display in Blind Drop Reports] was not working as expected 24854 

Resolution: Configuring the 'Blind Drop' feature establishes the ability of users who can run Employee or Cashier 
Financial reports, the ability to view the Blind Drop tender amount on these reports. Previously, this feature 
wasn’t functioning. This has been corrected by modifying the ReportService.dll and SarOps*.exe files. 

EMC Configuration
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1. Add a 'Report Group' record from the EMC-> Property level and name it accordingly. The example
shown here is named 'Blind Cash'. Enable the [4 - Do Not Display in Blind Drop Reports] option 
and 'Save' all changes. 

2. From the EMC-> Tender/Media module, typically using the 'Cash' tender, from the ‘Report Group’
field assign the desired Report Group name; '5 - Blind Cash' in the example shown here. 'Save' all 
changes. 
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3. A new option was added to the EMC-> Employee Roles-> Operations tab-> PMC
General/Reports-> General Options-> named [Do Not Show Blind Drop Tender Groups] (shown 
below). 

◾ Enable this option on every Employee Role that has been deemed not to allow users to view the 
Blind Drop tender amount on Financial Reports. 

◾ Disable this option on those Roles that have been deemed to allow users to view the Blind Drop 
tender amount. 

This option’s Context Sensitive Help (CSH) reads as follows: 

This option prevents tenders from showing on reports. This option enables the Report Groups Tender Media 
option 4 – Do Not Display for Blind Drop Reports. An employee cannot see Blind Drop Tenders if both these 
options are enabled.

◾ The Role privilege being granted is for the employee running the report, not the employee whose sales 
totals the report is for. The Employee Financial Reports can be run for anyone (including yourself) as 
long as you have the privileges. 

◾ The only reports affected by this change are the Employee and Cashier Financial Reports (both the 
Daily and Shift Report); Off-line versions of the reports are supported as well. 

◾ The only section of the reports affected by this change is the Tender Media breakdown section. 
◾ The new Role option works in conjunction with the existing ‘Report Group’ option [4 - Do Not 

Display for Blind Drop Reports]. For the ‘Report Group’ name not to display on the report, both 
options must be enabled. 

Note: Since some users may have modified their Employee and Cashier report templates and will 
not wish to upgrade to the latest report files, ensure that the previous report templates will work 
with the latest version of the other Simphony components. Note that the reverse is not true: the new 
reports will not work with versions of Simphony prior to this release. 

NewDTS

14461 Issue: Menu Item (MI) Price changes updated an existing MI Price record in mymicros.net and did not create a new 
MI Price record and set the 'effectiveTo' date as expected 

32763 

Resolution: In legacy MICROS applications, changes made to MI Price records posted to mymicros.net as a new price 
record with the old MI Price record having an ‘effectiveTo’ value set. This allowed a customer to track the 
historical prices of MI’s, which could be important when reviewing MI Sales reports. Simphony did not 
perform that way; instead it outright overwrote the existing MI Price record. This has been corrected by 
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modifying the NewDTS.exe. Currently, MI Price records in mymicros.net are not overwritten and an 
‘effectiveTo’ date is placed within the old MI Price records. 

Reports

10988 Issue: Unable to view ‘Rounding Total’ values on mymicros.net Financial Reports 32440 

Resolution: In legacy MICROS applications, 'Rounding Total' values would display on Financial reports. Previously, 
rounding totals were not displayed on Simphony v1.x mymicros.net financial reports. This has been corrected 
by modifying the Simphony financial report template *.xml’s. A ‘Rounding Total’ line has been added to the 
financial reports. To enable rounding, refer to the Currency module and Tender/Media rounding options in 
the EMC. 

SIM

20494 Issue: When the @GUID SIM script variable was utilized, it always returned the check’s GUID in the wrong order 33368 

Resolution: The SIM Manual describes the @GUID function as follows: 

This system variable returns a string array with the GUID of the current check.

Previously, when the @GUID was used after a check was opened, it would return all the same digits that 
were in the check’s GUID, but they would be out of order, in that two numbers did not match. This prevented 
the returned GUID data from being of any use. This has been corrected by modifying the SarOps.exe. 

Workstation Clients

7069 Issue: The ServiceHost.xml never got updated when the last Service was removed from a previously configured 
ServiceHost 

29961 

Resolution: Previously, when a ServiceHost was configured to run several services and then all of the 

services were removed from that ServiceHost, its servicehost.xml file was not being updated and still had the 
old Service entries, causing the Workstation to believe it was still running these Services. This has been 
corrected by modifying the EMC.exe and DataTransferService.exe. 
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This article is a quick reference guide to features, enhancements, and revisions for Simphony 1.6 Maintenance Release 1. 
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Prerequisite Knowledge 

This document assumes the reader has the following knowledge or expertise: 

◾ Understanding of basic network concepts 
◾ Experience with Microsoft Windows platforms and terminology 
◾ Familiarity with this product line and its hardware, software, and peripherals 

Document Overview 

For the printable collection for this version, see 1.6 Collection

This document includes the following sections: 

What's New
This section describes new features in this software release. A new feature is one that provides 
capabilities that were not available in previous versions. 

What's Enhanced
This section describes enhancements in this software release. An enhancement is a change made 
to improve or extend an existing feature, under the following criteria: 

◾ The basic feature or functionality already exists in the previous release. 
◾ The change adds to or expands on the current process — it does not replace it. This differs 

from a revision that corrects a problem. 

What's Revised
This section describes issues that have been corrected. A revision is a correction made to an 
existing form, feature, or function, using the following criteria: 

◾ The item must be part of the previous version. 
◾ The change must replace the current item or remove it from the application. 

Terminology 

◾ A Fix ID is an internal tracking number used by R&D. This ID is primarily used by R&D personnel; it is helpful for mapping fixes to 
documented items. 

◾ A CR# is a "Change Request ID" that is generated during the escalations process. When a case is started at the Support Center and the 
issue is determined to be an application defect, a Change Request is created, informing R&D that an issue needs to be fixed. 
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New Features 

Fix ID Feature CR #

Reports

1512 Simphony v1.6 MR1 Financial Reports have been enhanced to lessen reporting discrepancies between 
Simphony and the legacy MICROS 9700 v3.x HMS products

With this release, the Reporting Gaps feature has been implemented to address the discrepancies in 
reporting from 9700 HMS to Simphony v1.x. This feature is not intended to add reports that are 
exactly the same as they are in 9700 HMS, but it does bridge the gap between the two products 
reports. 

The following were modified as part of the Reporting Gaps feature: 

◾ Report Groups capabilities 
◾ Report Template XMLs 
◾ Report Mail functions 

Service Charges and Discounts were added as a support type to Report Groups. This allows Report Groups 
to be created for Service Charges and Discounts and link them to individual Service Charges and Discounts, 
so that they are subtotaled on reports. This functionality was previously only supported for Tender Media 
records. 

Many report template XML files were modified to include Major Group and Family Group breakdowns on 
them. They have also been updated for use with the new Report Groups capabilities. 

Report Mail has been modified to allow reports to be generated in either a consolidated or individual manner 
for a range of records. See the Reporting Gaps article for more information. 

Enhancements 

Fix ID Enhancement CR #

Audit Trail

11562 For customers who had more than one application server, it was deemed necessary, for troubleshooting 
purposes, to update the Audit Trail module to identify which server processed a specific request or 
handled a specific operation.

Previously, for multi-application server customers, there was no way to view which application server 
performed a specific operation through the EMC. This has been corrected by modifying the EMC.exe. The 
Audit Trail module has been enhanced to now display the application server’s name that was the primary 
machine used to affect a system change. A new column named 'App Server' has been added to the Audit 
Trail search task results and will contain the name of the server which affected a database change on the 
system. 

Install

13451 A new version of mymicros.net v7.2.0 has been incorporated into Simphony v1.6 MR1

The installation of Simphony v1.6 MR1 now supports and includes the latest patches for mymicros.net 
version 7.2.0. 
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KDS

7381, 
16268 

A ‘KDS Display Status’ view from the EMC has been introduced

The ability for users to view and filter the connectivity status of a Property’s KDS Displays and Controllers 
has been introduced. This feature should assist users at larger Properties with many Revenue Centers in 
checking on the status of their KDS systems. See the KDS Display Status article for more information. 

mymicros.net

13773 64-bit values will now be utilized for IDs generated by mymicros.net for Oracle® database locations

All of the code which uses mymicros.net definitions will now use 64 integers instead of 32-bit integers. 
This allows the system to generate ID numbers up to 10 billion in an Oracle environment. Currently, this 
change only affects Oracle database locations. Limitations of the mymicros.net database will not allow 
Microsoft SQL Server® sites to utilize ID’s greater than 2 billion. When using MS SQL Server, if numbers 
higher than 2 billion are used, totals will fail to post to mymicros.net. 

OLC/OTC

11245 The Offline Labor Cache (OLC) and the Offline Transaction Cache (OTC) functions have been modified 
so that they may be configured to run from Ops clients or from separate non-Ops machines so they can 
run under IIS or from a Service Host

With this release, the formerly named 'Offline Labor Cache' and 'Offline Transaction Cache' services have 
been renamed and had some of their functionality realigned. The names of the services are now: 

1. Offline Open Check and Shift Cache
2. Offline Labor and Transaction Cache

◾ For the Off-line Open Check report to be accurate, the Offline Open Check and Shift Cache must be 
on an Ops client that supports all of the Revenue Centers in the Property. 
◾ Note: Technically, this works both ways. That is, if the ‘Offline Open Check and Shift Cache’ 

is linked to all of the RVC’s or if all of the Workstations are linked to the RVC the ‘Offline 
Open Check and Shift Cache’ is located. 

◾ For Off-line Employee and Cashier shift increments to operate correctly, the Offline Open Check 
and Shift Cache Workstation must be accessible to all of the clients in the Property. This is because 
the shift change is broadcast from the Offline Open Check and Shift Cache. 
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Note: The Offline Open Check and Shift Cache can only be configured on an Ops client running on Port 
12359. The Offline Labor and Transaction Cache can be configured running on either Port 12359 (if 
using an Ops client) or 8080 (if using a Service Host without Ops). 

Additionally, in order for the Offline Check and Shift Cache to allow shift increments, the Workstation 
designated as the cache needs to be in an Off-line state. Otherwise, users will receive an 'Offline Server 
Unavailable' message when they attempt to increment a shift from the PMC Procedure. 

Reports

14715 Support for 64 Tax Rates has been added to User Workstation (UWS) reports

With this release, support for up to 64 Tax Rates has been added. This includes posting 64 Tax Rates to an 
Opera PMS and to 3rd Party interfaces as well. Additionally, a new 'Tax Summary Report' has been 
added to the UWS reports listing. In order for Employees to be able to run the 'Tax Summary Report' the 
report must be added to the Workstation Autosequences. To enable this report, navigate to the EMC-> 
Property level-> Reporting header-> Workstation Autosequences module. Insert a new report and set the 
report number to [4 – Tax Summary]. 

The following report templates were modified to include a breakdown of the newly supported Tax Rates: 

◾ Property Financial Report 
◾ Revenue Center Financial Report 
◾ Serving Period Financial Report 

To enable printing of the Tax Rate breakdown on the above reports, navigate to the EMC-> Property Level-> 
Property Information header-> Property Parameters-> Reporting tab. Enable the [15 – Print Tax Breakdown 
Section on Financial Rpts] option. The Context Sensitive Help (CSH) for this option reads as follows: 

Select this option to print the Tax Breakdown Section on Property Financial, Revenue Center Financial and 
Serving Period Financial Reports.

Revisions 

Fix 
ID Revision CR #

CAL

13687 Issue: The CAL update packages for the Windows CE version for the Motorola MC55A Mobile MICROS Handheld 
(MMH) device was not included in the install media 

32727 

Resolution: Previously, in Simphony v1.6, the CAL update packages for the Motorola MC55A MMH devices did not include 
the Windows CE version. This has been corrected by adding the Windows CE version to the correct CAL 
packages for those MMH devices in the installation files. 

13715 Issue: When configuring a Win32 client as a new Service Host, the EGateway Package failed to install 32935 

Resolution: Previously, when performing a fresh installation of Simphony v1.6, if the user decided not to install the 
mymicros.net databases, then this reported issue could occur. When a new Service Host was configured, the 
Installer program ran a search for the mymicros.net database file path. This has been corrected by modifying the 
Installer so that this search is no longer performed when a new Service Host is added. Currently, if the 
mymicros.net databases haven’t been installed yet, the Service Host can still be added without error. 

Credit Card Batch Process

14089 Issue: It was possible to create Credit Card (CC) batches with duplicate records if multiple batch creation requests were 
received 

32708 

Resolution: Previously, it was possible to create CC batches with duplicate records if a create batch request came in more 
than once during an ongoing batch creation attempt. This could occur both if the creation request came in via the 
Sequencer Service or manually from the EMC. This has been corrected by modifying the EMC.exe. Currently, 
CC batch generation is prevented from creating more than one batch while currently batching for the same 
Property or for a Revenue Center from the same Property. 

Warning: Users should not attempt to create CC batches from multiple EMC clients while a CC Service 
Host is in the process of rebooting as this can cause duplicate CC batches to generate. 
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17678 Issue: VisaD – Credit Card Batch settlement failed with an Exception encountered! [Index was outside the bounds of 
the array.] message 

33090 

Resolution: Previously, when the VisaD Credit Card Driver was in use, all of the records in the batch must be successfully 
processed in order for the whole CC batch to succeed. Should one record fail or produce an error, the whole batch 
would fail. When an expiration date did not get converted to the correct four digit format for the Settlement 
message, it would cause the batch settlement to halt and write the 'Exception encountered! [Index was outside the 
bounds of the array]' message to the EGateway log file. This has been corrected by modifying the VisaD.dll. 

Credit Card Driver

10764 Issue: Authorized Credit Card (CC) transactions on systems with Tokenization enabled as well as a having the Tip 
amount exceed the Secondary Authorization limit setting; ultimately failed to transfer and settle for the 
authorized amount 

32413 

Resolution: Previously, recent changes were made to correct how CC Lookups would write its records to a CC Batch. After 
these changes were made, regular CC Authorization Tokenized transactions would write incorrectly to the batch; 
where each authorization would be written as a separate CC batch Detail record, rather than showing all of the 
CC authorizations on the same record with multiple entries in the CCBATCH_AUTH_DETAIL database table. 
This caused the failure of a CC Batch to successfully transfer. This has been corrected by modifying the 
SarOpsXXX.exe. 

13128 Issue: Credit Card - CAPMS – A Tokenized Credit Card (CC) system using the CC Lookup function had such 
transactions not formed correctly and ultimately settled for 0.00 

32599 

Resolution: Previously, when a CC Driver option bit to enable Tokenization was in use, the CC number is swapped out for a 
token for the remainder of the transaction and is also used during settlement. When the CC Lookup function was 
used (Authorization and Pay in one step, usually used in a Retail or Quick Service environment), the CC number 
returned from the authorization was truncated to 10 digits where the last 4 digits displayed on the Workstation 
screen as small squares. This caused the CC record to be included in the CC batch, but would display with a Sub-
total, Tip and Payment total of 0.00. Additionally, when the CC Batch was settled, the record would seem to 
successfully settle, but the amount of the transaction was for 0.00. This has been corrected by modifying the 
PosLib.dll and the CAPMS CC Driver. 

14385 Issue: When 'Shift4' messaging was enabled, the CA_REQ command sent the 'Shift4' date in an incorrect format 32750 

Resolution: Previously, when the CAPMS driver [Enable Shift 4 Messaging] option was enabled, a number of additional 
pieces of information were sent with a Credit Card (CC) authorization (CA_REQ command), such as the check 
number and the date and time of the authorization. Each of these fields should have been in a specific format in 
order to be recognized. The Shift 4 'Info - Authorization Date' field was populated with an incorrect format, 
displaying 'YYMM' instead of 'MMDD'. This incorrect date format caused an attempted authorization to fail. 
This has been corrected by modifying the ECCServer.dll. 

Database Download

7045 Issue: DBDownload improperly truncated Tax Class Object Numbers greater than 255 26984 

Resolution: Previously, DBDownload on Workstation clients truncated any Tax Classes Object Number if it exceeded 255. 
This has been corrected by modifying the PosLib.dll. With this release, the Object Number range limit has been 
increased so that the EMC will allow for a maximum value of up to 999999999 for Tax Class Object Numbers. 

Database Conversion

13452 Issue: Unable to stop SDATA Database(DB) instances/databases until the KEY_DB_INFO table was cleared 32880 

Resolution: After performing an upgrade to Simphony v1.6 and running the Key Manager Tool, there’s no longer a need for 
the SDATA DB’s. Regardless of the database platform, users should be able to shut down the SDATA DB’s to 
save system resources. However, if the SDATA DB’s were shut down, the Workstations would go Off-line and 
there would be a flood of messages written to the EGateway log file. This was occurring because after the use of 
the Key Manager Tool, the EGateway was still checking if the SDATA DB’s were up and running. This has been 
corrected by modifying the EGateway service. EGateway will no longer check on the SDATA DB’s status. 
Currently, when getting the DB status, the EGateway will only check the Transactional and MCRSCACHE DB’s 
to ensure that they’re up and running. 

Data Transfer Service

6856 Issue: An original check’s Journal detail entries were lost when a check was re-opened; only the actions performed after 
re-opening the check remained on the Journal as seen in Audit & Analysis 

25678 

Resolution: This reported issue was previously addressed in Simphony v1.5 MR3, however it was determined that an option 
located in the EMC-> Revenue Center-> Revenue Center Parameters-> Options tab-> General-> [37 – Keep The 
Same Check Number When a Check is Reopened] was not being taken into account where the Journal entries 
were concerned in such instances. This has been corrected by modifying the NewDTS.exe and 
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DirectPostingServices.exe. Now Journals for checks that have been reopened correctly reflect the check detail 
including any changes made while the check was reopened. 

14002 Issue: Employee Time Card adjustments failed to post if the UID_GENERATOR exceeded a 32-bit value 32701 

Resolution: Previously, Employee Time Card adjustments failed to post once the UID_GENERATOR was sufficiently high. 
Once the UID_GENERATOR value reached its threshold limit, an 'ERROR - 3240 - Labor - Exception thrown 
writing Timecard Detail Adjustment' message would be written to the Data Transfer Service (DTS) log. This 
has been corrected by modifying the NVPDBWriter.dll and TranslationServiceUtils.dll files. 

Direct Posting Service

7082 Issue: Checks with items that totaled up to 10 digit amount values could be rung up, Service Totalled, Cancelled or 
Tendered and would cause Direct Posting Service 'Arithmetic Overflow' errors 

31487 

Resolution: Previously, larger valued transactions would get stuck in the Transactional database Que_Checks and 
Que_Checks_Retry tables. This has been corrected by modifying mymicros.net v7.2.0. 

13423 Issue: Unable to post checks once Employee ID’s reached 2,147,483,647 32673 

Resolution: Previously, once the Employee ID’s in mymicros.net became sufficiently large (2,147,483,647), the Direct 
Posting Service (DPS) was no longer able to post checks. This issue occurred because DPS tried to insert and 
convert Employee ID’s from Int64 to Int32 when inserting them into the POS_JOURNAL_LOG table. This has 
been corrected by modifying the DirectPostingService.exe. 

14555 Issue: Menu Item totals were incorrectly applied with Discounts when the ORDERTYPEID exceeded Int32 in the 
mymicros.net database 

32777 

Resolution: Previously, the Direct Posting Service (DPS) could not identify records in the MENU_ITEM_DAILY_TOTAL 
table after converting from a 64-bit ORDERTYPE value to a 32-bit value and subsequently did not apply sales 
for that record. This caused report imbalances. This has been corrected by modifying the 
DirectPostingService.exe. 

14662 Issue: Checks that included a Discount with a 'Reference Entry' were no longer searchable in the Audit & Analysis 
report by the text of the Reference Entry 

32785 

Resolution: Previously, prior to Simphony v1.5 MR 5, a check with a Discount that required a 'Reference Entry' would post a 
GUEST_CHECK_LINE_ITEM row with a DETAILTYPE 2 that would contain the reference entry text 
previously entered in the reference information field. This reference information would also post to 
DETAILTYPE 5. After an upgrade to Simphony v1.5 MR5, the 'Reference Entry' information would post to 
DETAILTYPE 5 and DETAILTYPE 1; but no longer posted to DETAILTYPE 2. This has been corrected by 
modifying the DirectPostingService.exe. 

17309 Issue: When the Direct Posting Service (DPS) posted items that were assigned an Inclusive Value Added Tax (VAT) 
and if a Discount was used, the prorated Discount’s forgiven tax amount(s) were not posted to mymicros.net 

33036 

Resolution: Previously, when the DPS posted menu items with inclusive VAT tax to mymicros.net, the tax would be broken 
out by a prorated amount and posted to the Transactional database. When a Discount was used, the Discount 
would post, but not the discounted tax amount that was forgiven. This has been corrected by modifying the 
DirectPostingService.exe. 

EGateway

13656 Issue: Checks rung up on a Windows CE client that served as the Service Host running the KDS Controller, would be 
seen on other Workstations when users attempted to pick them up as 'Check Owned by an Offline WS' and 
required authorization to override the checks 

32677 

Resolution: Previously, in Simphony v1.5 MR5 and above, when both WS’s were online to the Enterprise and each other, but 
one ran WebServer in order to be the KDS Controller’s Service Host, any check created on the WebServer WS 
would be seen as owned by an Off-line WS when an attempt was made to pick up a check on another WS. Other 
WS’s in the same RVC would be able to pick up each other’s checks with no issue, and all of the WS’s would 
send their orders successfully to the KDS. If the WebServer was started after SarOps, the checks could all be 
shared normally. This has been corrected by modifying the Printing.dll (Win32), Printing.dll (CE), 
KdsToPosServ.dll (Win32) and KdsToPosServ.dll (CE) files. 

EMC

11626 Issue: Menu Items (MI’s) added from the Menu Item Maintenance module would not display from the Property level in 
the EMC until the toolbar refresh button was selected 

32556 

Resolution: Previously, newly added MI’s would not display automatically from the Property level after being configured and 
saved. This has been corrected by modifying the EMC.exe. Currently, newly added MI’s will display 
automatically in the EMC. 

13841 Issue: Unable to edit Tax Rates when the UID_GENERATOR exceeded a 32-bit value 32696 
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Resolution: Previously, it was not possible to edit Tax Rates on a system once the UID_GENERATOR had exceeded a 32-bit 
value. When this issue occurred the operation would fail and an 'EMCHandler failed: Value was either too 
large of too small for an Int32' message would be written to the EGateway log. This has been corrected by 
modifying the EMCHandler.dll and EMCData.dll files. 

14203 Issue: The Application Server’s Time Zone could not be set to '225 – Perth' from the EMC as it would revert to the 
'255 – Canberra' Time Zone upon refreshing the configuration module 

32717 

Resolution: Previously, on Microsoft Windows Server® 2008 R2 systems, the '225 – Perth' Time Zone could not be 
successfully saved under the Enterprise Parameters > Miscellaneous tab. Upon refreshing the same module or if a 
new Enterprise Parameters tab was opened, it would revert to the '255 – Canberra' Time Zone. This has been 
corrected by modifying the EMC.exe. 

15270 Issue: 'Sorting and Display' options for the 'Format' tab needed to have the Context Sensitive Help (CSH) updated 32847 

Resolution: From the EMC-> RVC Parameters-> Format tab Options, it was requested to improve the CSH text in order to 
provide better descriptions about the functionality for all of the available options there. Previously, upon right-
clicking on the 'Sorting and Display’ section header, nothing displayed. This has been corrected by modifying the 
EMCText.xml file. Currently, the ‘Sorting and Display’ CSH displays as follows: 

There are three sort criteria for use on WS displays and checks: seat number, print group, and consolidation.

-Seat Number will show the items in order by the seat number assigned to that item.
-Print Group will show the items in order by the print group assigned to that item.
-Consolidation combines identical items on a single line with a numeric entry. In the instance of an 
item and its void, the count would equal 0 and neither the item nor the void of the item would be 
displayed on the check or receipt where a consolidated sort type was in use.

The following types of menu item entries do not consolidate:

-Menu items with condiments or modifiers
-Menu items with Item Discounts
-Open priced menu items
-Weighed menu items
-Menu items with a decimal amount entry. 

Transaction items print on the journal in the order in which they were posted. Sort options do not affect the 
journal.

Install

10084 Issue: A machine running MicrosoftWindows Server® 2008 R2 (64-bit) had the EGateway run fine until it had an 
interface assigned to it; then the EGateway crashed repeatedly 

32283 

Resolution: Previously, a machine running Windows Server® 2008 R2 with no modifications would not run any services or 
interfaces beyond the EGateway without crashing. This has been corrected by modifying the Installer and 
EGatewayHandlers files. 

15242 Issue: The installation media for Simphony v1.6 did not include the auto-installation of a mmServer folder for the 
NewDTS folder 

32851 

Resolution: A clean installation of Simphony v1.6 didn’t include the creation of an mmServer folder within the NewDTS 
folder. Previously, the Simphony v1.5 installation media manually copied a pre-built folder from the installation 
media. When the Installer program was re-worked to utilize the mymicros.net Installer in v1.6; the mymicros.net 
response file didn't install the 'Posting Server' component. Users had to manually re-run the Installer on the disk 
to install the Posting Server component and then had to manually configure the folder and files to mimic the 
mmServer folder. This has been corrected by modifying the application Simphony and mymicros.net Installer 
programs. 

17533 Issue: Credit Card batch creation in Simphony v1.6 was not backwards compatible with records rung up in previous 
versions 

33076 

Resolution: Previously, an upgrade to Simphony v1.6 would not throw any errors, but checks tendered with Credit Cards 
prior to an upgrade would be unable to be included in a CC batch after the upgrade was completed. This has been 
corrected by modifying the EGatewayHandlerUtils.dll file. Currently, legacy CC checks are allowed to be 
batched after an upgrade to Simphony v1.6 GR or MR1. 

See the Key Manager article (Simphony v1.6 section) for more information about some recommended steps to 
take prior to upgrading to Simphony v1.6. 

KDS
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13293 Issue: When ringing up transactions, the Workstation ID (WSID) was no longer being included on Order messages to 
the KDS Controller after a Simphony v1.5 MR5 upgrade 

32641 

Resolution: Previously, in earlier versions, the WSID was included on Order messages to the KDS Controller. After 
performing an upgrade to Simphony v1.5 MR5, it was reported that if two orders were sent to the KDS 
Controller simultaneously, the orders could become combined as one order on the KDS Display. This caused 
operational problems with keeping orders organized. Incorrect items could not be split off to different orders 
once they were inserted into KDS in this fashion. This has been corrected by modifying the SarOpsXXX.exe. 

13710 Issue: For those sites running KDS, beginning with the Simphony v1.6 GR release, the Restaurant Display Controllers 
(RDC) are required to undergo an upgrade of the device platform 

32681 

Resolution: See the Upgrading a Restaurant Display Controller (RDC) for KDS v2.1 article for instructions about the RDC 
upgrade process. 

14077 Issue: When a KDS Controller was run on a Windows CE device and a 'Runner Chit Printer' was configured, 
eventually new orders would fail to appear on the KDS display 

32706 

Resolution: Previously, when a KDS Controller was run on a Windows CE device and a 'Runner Chit Printer' was 
configured, eventually new orders would fail to appear on the KDS display. This has been corrected by 
modifying the KdsHandler.dll. Currently, KDS runner chits print, however the runner chits only print correctly 
from the 'Expo Done' display. 

14078 Issue: An IDN Order Device would only print orders from the local controller when the local controller was running a 
service (KDS) through WebService 

32707 

Resolution: Previously, when a Windows CE device was acting as a SarOps client, the KDS Controller and the Print 
Controller for a locally connected Intelligent Device Network (IDN) Printer; where that printer is both a receipt 
printer and an Order Device, other Workstations (WS) would fail to print to the device, but the WS that was the 
Print Controller would successfully print. This has been corrected by modifying the Printing.dll (Win32), 
printing.dll (CE), KdsToPosServ.dll (Win32) and KdsToPosServ.dll (CE) files. 

Mobile MICROS

19171 Issue: When attempting to re-CAL a Mobile MICROS Handheld (MMH) to another application server, the MMH 
would not point to the new server 

Resolution: Previously, after a MMH (MC70 or MC55) had been pointing to an application server and received updates, if 
the same handheld was re-CAL'ed to another application server, it retained the configuration from the first 
application server. Currently, a "Clean Boot" is required before CAL can configure a MMH to a new application 
server. A clean boot occurs after StartupLdr.exe is run on the handheld and restores it to the original factory 
settings. At this time, CAL must be reinstalled to the handheld using an Active-Sync session to install the CAL 
installation program. See the Handheld’s owner’s manual for specific instructions on how to perform a 'Clean 
Boot' for specific devices. 

mymicros

5832 Issue: Needed to support the 'Maximum Number of days' setting for the Move History procedure in mymicros.net 

Resolution: Previously, the 'maxMoveHistDays' procedure was not working as expected in mymicros.net. This has been 
corrected by modifying mymicros.net v7.2.0. Currently, the Move History procedure is working as expected. 

6898 Issue: Transactions were delayed in posting to mymicros.net due to cancelled checks with large amount due totals being 
stuck in the Que_Checks and Que_Checks_Retry database tables 

31234 

Resolution: Previously, when a check was cancelled that had a 9 or 10 digit amount due figure, these checks were not able to 
be posted to mymicros.net via the Direct Posting Service (DPS). This has been corrected by modifying the 
DirectpostingService.exe and a mymicros.net v7.2.0 database schema change. 

7235 Issue: Error Correct values of over 99,999,999.99 caused checks to fail to post to mymicros.net 30324 

Resolution: Previously, it was possible to ring up transactions for large amounts (exceeding 99,999,999.99), then 'Void' the 
items from the check (Error Correct), tender the check and then note that the check would not post to 
mymicros.net. This has been corrected by modifying the DirectPostingService.exe and by upgrading to 
mymicros.net v7.2.0. 

14090 Issue: The size of the POS_AUTH_LOG.CONTEXTTEXT column was 32 in the mymicros.net database, and 50 in the 
Transactional database 

32060 

Resolution: Previously, there was a Database Schema mismatch of sorts between the mymicros.net and Transactional 
databases in the POS_AUTH_LOG.CONTEXTTEXT column size. This has been corrected by modifying the 
NewDTS.exe. Both databases now support a CONTEXTTEXT column size of 50. This fix is compliant with 
mymicros.net v7.2.0. 

15571 Issue: There’s no section called 'Currencies in Bank' on the Revenue Center Financial report 32876 
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Resolution: There’s a section called ‘Currencies in Bank’ on the Property and Employee Financial reports, but not on the 
Revenue Center Financial report. It was requested to add this section on the Revenue Center Financial report as 
well. This has been corrected by modifying the applicable *.xml report templates. 

15572 Issue: The 'Currencies in Bank' section did not display any configured Currency amounts for ‘Child’ Revenue 
Center’s (RVC) on financial reports 

32877 

Resolution: Previously, the ‘Currencies in Bank’ section was not displaying a Child RVC’s Currency amount (including 
Alternate Currencies) on Property or Employee financial reports. This has been corrected by modifying all of the 
applicable report .xml’s. 

Ops

6505 Issue: In certain instances, Off-line checks could be started and posted to a date prior to the last accurately recorded 
closed check 

30481 

Resolution: Previously, if a Workstation’s (WS) CMOS battery went bad (after years of prior use), the Date and Time 
settings on the WS may have reset to a much earlier date upon powering it up. This could have resulted in Off-
line transactions being posted to the earlier and incorrect business day and perhaps have appeared to be lost 
altogether. This has been corrected by modifying the SarOpsXXX.exe. Now, if the WS's CMOS battery fails and 
reverts to a date prior to 1/1/2008, the SarOps client will generate an error message during its loading phase: 

System time should not set before: Jan. 1, 2008

Current system date/time: <whatever time WS clock set to>

Please check the workstation date/time settings!!

When the message is acknowledged, users will receive another message: Workstation is shutting 
down!! ...followed by SarOps closing. 

If the WS's Date/Time is later than 1/1/2008, but before the current business date, the following message appears 
after SarOps loads and a transaction is started: 

Workstation time is wrong: [WS time listed], Business Date: (business date listed). The battery may need 
replacing.

This message displays each time a transaction is started until corrected. 

Note: Newer WS's (i.e. 4LX, 5, and 5A) will pull up the correct time provided they have an Internet Connection 
(even if they cannot connect to the Simphony database). These WS's have their time sync initiated by Windows 
CE (in the newer versions) and syncs with the time.windows.com web-site. 

Additionally, new functionality now has the WS check the Transactional database for the most recent Date/Time 
of On-line check closure prior to replaying transactions and then replays them to that date thus preventing posting 
to a past date (i.e. 2008 that may have been partitioned). 

There is an option bit located in the EMC-> Property Parameters-> Options-> [6 - Post Offline transactions 
with actual transaction time]. If this option is enabled, the system will not allow checks to be created if the 
Date/Time of the WS is Before the WS's business date. This measure is in place to prevent the Off-line 
transactions from getting around the last closed check Date/Time that Ops does when the sync occurs. 

6708 Issue: The Revenue Center Parameters-> Posting and Control option #6 Context Sensitive Help (CSH) description was 
misleading as to how the option was meant to perform 

30838 

Resolution: Previously, there was some confusion caused by the CSH explanation for a sales posting option. The option in 
question can be located by accessing the EMC-> Revenue Center level-> RVC Information-> Revenue Center 
Parameters -> Posting and Control tab-> Posting option-> [6 – Post Totals and Tender to Transaction 
Operator]. It’s been determined that the option is currently performing as designed, however the CSH text 
needed to be updated to provide users a visual example to better explain option #6’s function. 

The option’s new CSH text and financial report output example is shown below: 
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6862 Issue: Coupons that were Automatically applied to orders by users (using 'Combination Pricing') did not allow users 
to Service Total the check 

25978 

Resolution: Previously, after users applied a Coupon (as described above), they would receive a 'Service Total is not 
allowed with Automatic Discounts. Check must be paid in full' message. 

Note: With this release, Coupon Discounts now must be removed using a touch 'Void' key. The Function 11 - 
[658 - Remove Coupon] has been removed from the Touchscreen Design list. In case there was a previously 
configured 'Remove Coupon' button prior to the upgrade; an error message, 'This method is obsolete. Use the 
void key to remove a coupon discount.' is displayed upon its selection. This change has been affected by 
modifying the Sarops*.exe, EMC.exe, DbUpgrade.exe, EMCHandler.dll, Totalposting.dll, SimSVCHandler.dll 
and DirectPostingService.dll files. 

6961 Issue: There were Off-line reporting issues if a Workstation (WS) had an incorrect Local business date 29644 

Resolution: Previously if a WS went Off-line for a significant period of time (during a Start-of-Day) and was then brought 
back On-line, the PMC Off-line reports would sometimes be on an incorrect business date. Off-line checks would 
have the correct date, but the PMC Reports would not be able to report on them as the WS remained on an 
incorrect business date due to not being automatically updated from the Application Server. Once the WS was 
brought back On-line, the business date would remain incorrect until a forced DBDownload (or a WS reboot) 
was performed. This has been corrected by modifying the SarOpsXXX.exe. Currently, Ops will now 
automatically look for any database updates as part of the process of coming back On-line. 

7280 Issue: No data displayed on WS client’s Check Detail when users rang up Menu Items that required a Reference Entry 
and then attempted to swipe a Hotel Magnetic card to capture and display the Line 3 data 

31776 

Resolution: Previously, this functionality existed, but currently is no longer supported for PCI compliancy security reasons. 
The recommended work-around is to create an Interface Scripting Language (ISL) script that reads a Mag Cards 
Track 3 data and displays that data on the Guest Check Info lines on Guest Checks. Program a touchscreen button 
to allow users to invoke the script. 

Users need to enable option bits for displaying the Guest Check Info lines on Guest Checks. 

Access the EMC-> Revenue Center-> RVC Information-> RVC Parameters-> Format tab-> Print Output 
section-> enter the desired ‘Number of Guest Check Information Lines’ 

Access the EMC-> Revenue Center-> RVC Information-> RVC Parameters-> Format tab-> Format Options-> 
Check Info lines on the Guest Check -> options 24-29. 

Access the EMC-> Revenue Center-> RVC Information-> Order Devices-> Options tab-> Check Info lines on 
the Guest Check -> options 13-15. 
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Here is a sample ISL script that would read a card’s Track 3 data: 

//////////////////////////////////////////////////////////////////////////////////// 

// 

// Swipe Room Card and Store in Check Header 

//////////////////////////////////////////////////////////////////////////////////// 

var MagCardTrack  : A80 

//////////////////////////////////////////////////////////////////////////////////// 

Event Inq : 1 

// read track 3 

input MagCardTrack {m3, *}, "Swipe Room Card" 
ClearChkInfo 
SaveChkInfo MagCardTrack 

EndEvent 

13229 Issue: The Menu Item Classes Default Menu Level setting was not being honored for Fast Transactions 32623 

Resolution: Previously, when a Menu Item Class was set to automatically utilize a Default Menu Level setting, it appeared 
that for Fast Transactions, that it was treating the incorrect Menu Level it was started under as the Default and 
ignoring the configured Default Menu Level. This has been corrected by modifying the SarOpsXXX.exe file. 

Note: Menu item Classes that allow for a Menu Level change (Main Level Pop-Up / Sub Level Popup set to a 
value other than 'Stay-Down') will still ring in the initial item under the current Menu Level; all subsequent rung 
up items will be on the Menu Level the item is set to 'Pop-Up' to. This is by design. 

13235 Issue: Intermittently, a manually entered numeric Sign-In command would be non-responsive if the Workstation 
Display option 'Do Not Clear Screen After Transaction' was enabled 

32627 

Resolution: Previously, it was reported that a numeric Sign-In would be non-responsive if the Workstation Display option 
'Do Not Clear Screen After Transaction' was enabled. Notably, if a DBDownload was performed during one 
of these non-responsive times, the numeric Sign-In would work. Additionally, if the 'Clear' key was used prior to 
attempting Sign-In, the issue was also not seen. This has been corrected by modifying the SarOpsXXX.exe file. 

14115 Issue: Ops became non responsive (frozen) after stressing a ViVOpay® 4800 Reader using the 'Tap ‘n Pay' functions 32738 

Resolution: Previously, in some instances, a ViVOpay® 4800 Reader switched between 'Poll mode' and 'Burst mode' and 
slowed the payment process and caused Ops to lockup or crash when the device was tapped again while it was 
switching between modes. This has been corrected by modifying the EMC.exe and SarOpsXXX.exe. 

A new option has been added to the EMC-> Property level-> Property Hardware-> Workstations-> Devices tab-> 
under the 'Peripheral Device Configuration' header and select the 'Add' link. The option is named 'Enable 
E-Wallet' and should be enabled to set the ViVOpay® 4800 Reader to exclusively ‘Poll mode’ in order to help 
avoid an approximate 20 second delay reported by users. This option must also be enabled in order to use the 
‘Tap And Pay’ and ‘Tap And Auth’ function keys. 
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See the ViVOpay 4800 Reader Setup article for more information. 

14858 Issue: The void of a Discount in the same round as Seat edits followed by Splitting a check resulted in the incorrect 
posting of the Void to the mymicros.net transaction detail 

32813 

Resolution: Previously, a Discount that was voided in the same round as Seat edits followed by Splitting the check posted 
only the Discount amount for the item(s) left on the check but posted the Void for the entire amount, which 
caused a report imbalance. This has been corrected by modifying the SarOps.exe. 

14860 Issue: Shared items with a Voided Discount and Seat edits caused an imbalance in mymicros.net reports 32814 

Resolution: Previously, in a transaction that had Shared items, a Discount Void and Seat edits caused mymicros.net reports 
imbalances because the Shared item(s) posted the full item Discount for each item, inflating the reported 
Discount amount. This has been corrected by modifying the SarOps.exe. 

16412 Issue: When using the CCard Lookup function on a KWS270, it caused SarOps to exit unexpectedly 32993 

Resolution: Previously, when using the CCard Lookup function on a KWS270, it caused SarOps to exit unexpectedly. A 
Credit Card (CC) Authorization was sent, but SarOps exited with no error message. This has been corrected by 
modifying the CxImage.dll, McrsUtils.dll, MicrosDevices.dll, Printing.dll, SarOpsXXX.exe, SPC.dll, 
EGatewayClientWin32CPP.dll, and Security.dll files. 

17308 Issue: Large checks with hundreds of ordered items had Sales posting issues. 28408 

Resolution: Previously, a timeout on the Workstation (WS) could occur when larger checks (with hundreds of items rung up) 
attempted to post to the Server. After timing out, if the Workstation subsequently went Off-line, the replay of the 
check details would not successfully complete and the WS would appear "stuck". This has been corrected by 
modifying the SarOps.exe. The WS to Server timeout limit will now automatically increase for every 200 items 
that require posting. Currently, for checks with hundreds of ordered items, Ops will now display a progress bar 
when posting items to the Server. 

NewDTS

11033 Issue: The NewDTS did not account for the new 'Move History’ stored procedure in mymicros.net v7.2.0 32450 

Resolution: Previously, a new 'Move History' Stored Procedure was added to mymicros.net v7.2.0 called 
'sp_move_loc_date_check_history'. This functions similarly to the older procedure 
"sp_move_location_check_history", but allows for an extra parameter to be set for the 'Maximum Number of 
Days' to look back before moving the check history. Users may view, but not edit, the current ‘Maximum 
Number of Days’ setting from the EMC. A script (provided below) must be manually run against the 
Transactional database to enable the new mymicros.net stored procedure. 

Execute this script (where 180 equals the ‘Maximum Number of Days’ setting as it can be seen from the EMC-> 
Enterprise Parameters-> MyMicros tab-> Move History header): 

insert into microsdb.GLOBAL_PARAMETER(ParamCode, ParamType, IntVal) values
('MM_MOVE_HIST_MAX_DAYS','I',180) 
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12836 Issue: The Credit Card Purging job was running two full table scans of the CCBATCH_DETAIL table during the query 32657 

Resolution: Previously, two full table scans were being run against the CCBATCH_DETAIL table during the CC Purge job 
that were very resource expensive. When there were a very large number of records, this could lock up the table 
during CC settlement or affect performance during the CC batch creation process. This has been corrected by 
adding the new index CCBATCH_DETAIL.XIF_CCBATCH_DETAIL_2 and a new column 
AUDIT_TRAIL.AppServer, which changed full table scans to index scans. 

15873 Issue: The Transactional database XFER_DB_RVC table was populated with incorrect values if the 
UID_GENERATOR exceeded 32-bit values 

32918 

Resolution: Previously, if the nextIntValue and nextInt64Value columns for the location_activity in the UID_GENERATOR 
table of the mymicros.net database exceeded 32-bit values, the XFER_DB_RVC table would be populated with 
an incorrect value on newly created Revenue Centers. This caused reports to not work as expected for these new 
Revenue Centers. This has been corrected by modifying the NewDTS.exe. 

16165 Issue: MC55 Mobile MICROS Handhelds (MMH) crashed when starting SarOpsMM.exe 32959 

Resolution: Previously, when using an MC55 as a Workstation, it must be CAL'd to the Application server. When this was 
done in Simphony v1.6, the CAL process would move all the files down, but once SarOps tried to start; it would 
crash after trying to initialize communication with the following message: 

'A problem has occurred with SarOpsMM.exe'

This has been corrected by modifying the SarOpsXXX.exe files. 

Reports

6532 Issue: Cashier Financial reports did not display 'Void', 'Discount', or 'Returns' 'Counts' or 'Totals' 23876 

Resolution: Previously, the Cashier Financial report template did not include 'Counts' or 'Totals' for Voids, Discounts or 
Returns. This has been corrected by modifying the MMCashierFinXtra.xml report template to now include these 
values on a Cashier Financial report. 

6606 Issue: Employee Tip reports did not display the percentage figure of the Tips claimed by the Employee as they do when 
run on legacy MICROS applications 

24494 

Resolution: Previously, MICROS 8700 HMS and 9700 HMS Employee Tip reports included a '%' amount which reflected 
the percentage of the check that was entered as a tip. This same percentage breakdown was not displayed on the 
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mymicros.net Employee Tip Report for Simphony v1.x since the Employee Tip report templates did not include 
the percentage value of tips claimed. This has been corrected by modifying the MMEmployeeTip.xml and 
MMEmployeeTipUWS.xml report templates to now include this value on an Employee Tip report run in 
mymicros.net or from the Workstation. 

6739 Issue: Report Mail e-mailed a JDOM error when Simphonized Financial reports were e-mailed to users 29050 

Resolution: Previously, when a Simphonized Financial report was e-mailed using the Report Mail functionality in 
mymicros.net, an e-mail with the error 'The data 'null' is not legal for a JDOM attribute: A null is not a legal 
XML value.' was received. This was due to the Simphonized report templates not being compatible with Report 
Mail. This has been corrected by creating three new Report Mail specific report templates: MMRevCtrFin-
ReportMail.xml, MMCashierFin-ReportMail.xml and the MMEmpFin-ReportMail.xml. 

7006 Issue: Gift Cards were not separated or otherwise identifiable on either mymicros.net or Workstation reports 26585 

Resolution: Previously, there was no way to have Gift Cards display on reports in their own section. This caused Gift Card 
issuing functions to be grouped with all other Service Charges, since that was how they were required to be 
programmed. This has been corrected by adding 'Report Group' functionality for Service Charges. Report 
Groups Subtotal Service Charges are based off of the Report Group they are assigned to on reports. 

To configure Report Groups for Service Charges: In the EMC, navigate to the Property Level-> under the 
'Reporting' header-> Report Groups 

1. Insert a new Report Group clicking on the green plus symbol icon located on the toolbar
2. Assign an Object Number for the new Report Group
3. Choose to use a template or not; if using a template, select the template
4. Assign a Record Name
5. Click 'OK' to add the Report Group
6. 'Save' all changes

There are now three options to choose from in the 'Type' drop-down field: 

◾ Tender/Media, 
◾ Discount 
◾ Service Charge 

Select the 'Type' of Service Charge for the newly created Report Group To link a newly created Report Group to 
a Service Charge: 

1. In the EMC, navigate to Property Level-> under the 'Sales' header-> Service Charges
2. Now a ‘Report Group’ drop-down field should contain and display the configured Report Groups for

Service Charges.
3. Select the Report Group of choice
4. 'Save' all changes

7019 Issue: Revenue Center Financial reports e-mailed to a user via the Report Mail function in mymicros.net, did not send 
separate reports for each applicable Revenue Center 

28841 

Resolution: Previously, when attempting to send multiple Revenue Center (RVC) Financial reports to one user via Report 
Mail, that user did not receive a separate report for each RVC. They would receive one report that consolidated 
all sales data for that Property into a single report. This has been corrected by adding a new Report Mail specific 
template for RVC Financial reports. In order to receive separate reports for each RVC, the 'By Revenue Center'
option on the report mail job must be enabled. Additionally, enabling the [Zip multiple files] option will have 
the system Zip up separate RVC Financial reports per RVC and import them into a single Zip file that’s attached 
to the e-mails sent to users. 

7020 Issue: Individual Cashier Financial reports were unable to be sent using the Report Mail functionality in mymicros.net 28839 

Resolution: Previously, it was not possible to e-mail an individual Cashier Financial report via Report Mail. It was only 
possible to receive a 'Cashier List'. This has been corrected by creating a new Report Mail specific report 
template: 'MMCashierFin-ReportMail.xml'. It is now possible to e-mail reports with breakouts of each Cashier 
by enabling the option bit [By Cashier ID] on the Report Mail job and then by selecting each applicable Cashier 
for whom a report is required. 

7273 Issue: Open Priced Menu Items without Sales 'Count' values were not displaying on either Family Group or Major 
Group reports despite having Sales totals 

30371 

Resolution: Previously, when Open Priced Menu Items were rung up and then subsequently voided; when the same Open 
Priced Item was rung up for a different price than the original, those items would not display on the Family 
Group or Major Group Sales reports. This has been corrected by modifying the queries in the 
MMFamGrpSales.xml and MMMajGrpSales.xml report templates. 
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8704 Issue: Tax Totals were displaying incorrect totals on the Daily Ops report; 'Taxable Sales', 'Tax Exempt Sales', and '% 
of Taxable Sales Collected' 

32098 

Resolution: Previously, the drill-down Tax Totals on the Daily Ops report were not accurate, particularly if there were Tax 
Exempt sales reported. This has been corrected by modifying the SarOpsXXX.exe and with changes made to the 
mymicros.net report template. 

Currently, the breakdown of the 'Taxes' section of the Daily Ops report should resemble the following: 

SIM

16336 Issue: SAROpsCE (on KWS270, HHT devices only) crashed when the 'queuemsg' function was used in SIM scripts 32989 

Resolution: Previously, an 'Application SAROpsCE.exe encountered a serious error and must shut down' error message 
displayed on KWS270 and Mobile MICROS Handheld (MMH) devices when the 'queuemsg' function was used 
in SIM scripts. KWS270 Workstations crashed when the 'queuemsg' function was used in a script, either from a 
SIM Inquiry event or a TNDR event. MMH devices crashed only from a TNDR event. This has been corrected 
by modifying the SarOps.exe. 

Taxes

7282 Issue: Tax Rates '9-64' could be enabled, but would not use those Tax Rates configured '%' value 28420 

Resolution: Previously, Tax Rates 1-8 worked correctly, but Tax Rates 9-64 would not use the correct configurated rate. Tax 
Rate #9 would use the Tax Rate% of Rate #1; Tax Rate #10 would use the Tax Rate% of #2, etc. This reported 
issue was occurring for either 'Add-On' or 'Inclusive' Tax Rates. This has been corrected by modifying the 
DirectPostingService.exe, NewDTS.exe and SarOpsXXX.dll files. 

11137 Issue: Tax Classes configuration allowed more Tax Rates to be assigned than could possibly post to mymicros.net 32473 

Resolution: Previously, it was possible to enable more than 8 taxes per Tax Class (the limit is 8), even if they couldn’t be 
posted to mymicros.net. The EMC needed to be limited to allow only 8 Tax Rates per class in order to align the 
tax configuration in Simphony to the available tax columns in the mymicros.net database tables. This has been 
corrected by modifying the EMC.exe. 

Additionally, the 'Taxes Enabled (Maximum 8)' heading’s Context Sensitive Help (CSH) text has been updated 
as shown below: 
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Simphony Version 1.6
General Release

Simphony 1.6 MR 1

Simphony 1.6

IMPORTANT NOTICE
Prior to performing an upgrade from an earlier application version (e.g., from Simphony v1.5 to Simphony v1.6) or
running the Key Manager Tool, it is strongly recommended that: 

◾ All existing Credit Card records have been batched and settled. 
◾ The existing database has been backed up. 
◾ It is also recommended that all open checks be closed before performing the upgrade. 

For those sites running KDS, please see the Upgrading a Restaurant Display Controller (RDC) for KDS v2.1 article 
for important information about Restaurant Display Controller update requirements after upgrading to Simphony 
v1.6. 

This article is a quick reference guide to features, enhancements, and revisions for Simphony 1.6. 

Contents

◾ 1 Prerequisite Knowledge
◾ 2 Document Overview 

◾ 2.1 Terminology
◾ 3 Obtaining/Installing the Software
◾ 4 New Features
◾ 5 Enhancements
◾ 6 Revisions
◾ 7 See also

Prerequisite Knowledge 

This document assumes the reader has the following knowledge or expertise: 

◾ Understanding of basic network concepts 
◾ Experience with Microsoft Windows platforms and terminology 
◾ Familiarity with this product line and its hardware, software, and peripherals 

Document Overview 

For the printable collection for this version, see 1.6 Collection

This document includes the following sections: 

What's New
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Simphony 1.6 MR 2
Simphony 1.6 MR 4
Simphony 1.6 MR 5
Simphony 1.6 MR 6
Simphony 1.6 MR 7
Simphony 1.6 MR 8
Simphony 1.6 MR 9

Simphony 1.6 MR 10

Previous Version Next Version 
Simphony 1.5 Simphony 2.6 

This section describes new features in this software release. A new feature is 
one that provides capabilities that were not available in previous versions. 

What's Enhanced
This section describes enhancements in this software release. An 
enhancement is a change made to improve or extend an existing feature, 
under the following criteria: 

◾ The basic feature or functionality already exists in the previous release. 
◾ The change adds to or expands on the current process — it does not 

replace it. This differs from a revision that corrects a problem. 

What's Revised
This section describes issues that have been corrected. A revision is a correction made to an existing form, feature, or 
function, using the following criteria: 

◾ The item must be part of the previous version. 
◾ The change must replace the current item or remove it from the application. 

Terminology 

◾ A Fix ID is an internal tracking number used by R&D. This ID is primarily used by R&D personnel; it is helpful for 
mapping fixes to documented items. 

◾ A CR# is a "Change Request ID" that is generated during the escalations process. When a case is started at the Support 
Center and the issue is determined to be an application defect, a Change Request is created, informing R&D that an 
issue needs to be fixed. 

New Features 

Fix ID Feature CR #

Peripheral Device

10082 Added support for E-Wallet applications with the ViVOpay® 4800 Reader

With this release, support has been added for E-Wallet applications with the 
ViVOpay® 4800 Reader. The ViVOpay® 4800 is a Radio-frequency identification 
(RFID) reader and supports contactless Credit Cards (CC) as well as Near Field 
Communication (NFC) capable smart phones. Customers may use one of several 
capable smart phones to submit discount coupons and payments to the POS System. 
The customer’s phone must support NFC. Only one ViVOpay® 4800 Reader may be 
configured as a peripheral device for each workstation. See the ViVOpay 4800 Reader 
Setup article for more information. 

30607 
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User Experience Report

1365 A customizable 'User Experience Report' is now available in the EMC

There was a need for a tool in Simphony in order to identify potential bottlenecks in 
the system. The ability to collect timed statistics from the Workstations and post them 
to the Enterprise was integrated into the core product. Since everything is now being 
posted to the Enterprise, the data that is posted can be parsed, aggregated and 
analyzed. 

See the User Experience 1.6, User Experience Report and User Experience Report Settings 
articles for more information. 

Enhancements 

Fix ID Enhancement CR #

Direct Posting Service

7262, 
7511 

It was requested to allow for parallel posting from the Direct Posting Service (DPS) to 
allow for real-time depletions for MyInventory

Parallel posting from the DPS will enhance its performance speed via multiple DPS 
services running concurrently. This feature will bring about faster totals posting on 
mymicros.net Reports and MyInventory real-time depletions. This change was brought 
about by modifying the EMCHandler.dll, TotalPosting.dll, 
MicrosPerformanceLibrary.dll and the DirectPostingService.exe. 

29360 

KDS

5697 Requested support for Wrapping Condiments on Prep Screens – also known as 
Multiple Condiments Per Line

Enabling the 'Multiple Condiments Per Line' option displays condiments in a 
continuous line on each order chit. Disabling the option to print each condiment on a 
separate line shows them on a separate line beneath the parent/referenced menu item. 
To enable the option, navigate to the EMC-> Revenue Center-> Setup tab-> under the 
RVC Information header-> Order Devices-> Options tab-> KDS Options-> [14 - 
Multiple Condiments Per Line]. 

This option’s Context Sensitive Help (CSH) reads as follows: 

Enable this option to display condiments in a continuous line on each order chit. Disable 
this option to print each condiment on a separate line beneath the referenced menu item. 
Note: To compress the condiments into a single line, the condiments must NOT be printed in 
red.

5699 Have provided a way to configure Columns on KDS Prep Screens

Previously, there were a limited number of list layouts which did not provide or 
support the needed configuration of columns on KDS Prep screens. The following list 
layout styles were added: 

◾ 203 List-Check Number 
◾ 204 List-Table Number 
◾ 205 List-ChkNum-OT 
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◾ 206 List-Tbl-OT 
◾ 210 List-Std Row Num 
◾ 211 List-Std OT Row Num 
◾ 212 List-Chk# OT Row Num 
◾ 214 List-Standard CookTime 
◾ 215 List-Std-OT CookTime 
◾ 217 List-Row Num CookTime 
◾ 218 List-Chk# Row Num CookTime 
◾ 401 List-DOM1 
◾ 402 List-DOM2 
◾ 403 List-DOM3 
◾ 404 List-DOM Row Num 
◾ 405 List-DOM3 CookTime 

The following Chit Layout Styles were also added: 

◾ 107 Chit-Std. w/Item Status 
◾ 108 Chit-Header w/Chk 
◾ 109 Chit-Header w/Tbl 
◾ 110 Chit-Items Only 
◾ 111 Chit-Std-OT w/Item Status 
◾ 112 Chit-Header-OT w/Chk 
◾ 113 Chit-Header-OT w/Tbl 
◾ 114 Chit-Items-OT Only 
◾ 116 Chit-Standard-OT-1 
◾ 117 Chit-Standard-OT-3 
◾ 121 Chit-Standard CookTime 
◾ 122 Chit-Items Only CookTime 
◾ 123 Chit-Standard w/Hdr 
◾ 127 Chit-Standard-OT - Gst 
◾ 128 Chit-Standard-OT w/Seat - Gst 
◾ 129 Chit-Std-OT w/Item Status - Gst 
◾ 130 Chit-Header-OT w/Chk - Gst 
◾ 131 Chit-Header-OT w/Tbl - Gst 
◾ 301 Chit-Std-DOM 
◾ 302 Chit-Std-DOM2 
◾ 303 Chit-Std-DOM3 
◾ 306 Chit-Std-DOM-11 
◾ 307 Chit-Std-DOM-12 
◾ 308 Chit-Std-DOM-13 
◾ 311 Chit-Std-DOM3-3 
◾ 312 Chit-Std-DOM-11-3 
◾ 313 Chit-Std-DOM-12-3 
◾ 314 Chit-Std-DOM-13-3 
◾ 318 Chit-Std-DOM2 w/Hdr 
◾ 501 SE-Standard 
◾ 502 SE-Standard-OT 
◾ 503 SE-Standard-3 
◾ 504 SE-Standard-OT-3 
◾ 505 SE-Standard-2 
◾ 506 SE-Standard-OT-2 
◾ 602 SE-Std-DOM-1 
◾ 604 SE-Std-DOM-2 
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◾ 605 SE-Std-DOM-3 
◾ 608 SE-Std-DOM-1-3 
◾ 610 SE-Std-DOM-2-3 
◾ 611 SE-Std-DOM-3-3 
◾ 614 SE-Std-DOM-1-2 
◾ 616 SE-Std-DOM-2-2 

The layout styles can be accessed from the EMC-> Property level-> under the Property 
Hardware header-> KDS Displays module-> Chit Display Options-> KDS Chit Layout 
Style. 

5703 'Single Item Per Sub-Order' is now supported

Support has been added for ‘Single Item per Sub-Order’ for KDS Displays. The [3 - 
Single Item Per Sub-Order] option allows the system to split an order sent to the 
KDS prep station into individual suborders. This option is typically enabled for prep 
stations and works in both table service and quick service restaurant environments 
where KDS operators need to bump items individually off the screen. To enable this 
option bit, navigate to the EMC-> Revenue Center level-> under the RVC Information 
header->Order Devices-> Options tab-> KDS Options-> and enable the [3 – Single 
Item Per Sub-Order] option. 

Note: It is recommended that the Expo station(s) be set up to display orders using one of the 
chit or list mode layouts that show the menu item status. This will cause the status to update 
on the Expo station when each item is bumped from its respective prep station. Additionally, 
this option must be enabled for KDS 'Menu Item Prep Timing' to function properly. 

5707 'Dynamic Speed of Service' is now supported

Added support for Dynamic Speed of Service (SOS) KDS functionality. This feature 
makes the KDS Display more customizable and helps streamline operations. The KDS 
Speed of Service (SOS) feature allows employees to view the status of each table and 
in turn improves food service. 

The following option bits are now fully supported: 

EMC-> Property Level-> under Property Hardware header-> KDS Displays-> Display tab-> 
Display Screen Options-> Display Type-> set to [1 – SOS]

EMC-> Property Level-> under Property Hardware header-> KDS Displays-> General tab-> 
Options-> [3 – Dynamic Display]

This option’s Context Sensitive Help (CSH) reads as follows: 

Enable this option to turn on the Dynamic Display feature on an SOS display.

EMC-> Property Level-> under Property Hardware header-> KDS Displays-> Display tab-> 
SOS Display Options-> Configure option bits to site specifications 

5709 A 'Menu Item Prep Countdown Timer' is now supported

Added support for Menu Item Prep Countdown Timer. This feature allows Item start 
times to be adjusted based on when the menu item with the longest prep time is 
started, not when it was fired from the POS. With this feature, KDS can manage the 
orders that are sent to the kitchen based on when the cook starts the first item on the 
order versus when the POS sent the order. This allows the kitchen to maintain 
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efficiency even when extremely busy. This feature only affects item timings for menu 
items in the same Course. 

The following option bits should be enabled to configure this feature: 

EMC-> Property level-> under Property Hardware header-> KDS Controllers-> General 
tab-> Option [6 – Enable Item Started Timings]. 

This option’s Context Sensitive Help (CSH) reads as follows: 

Check this option to have the system recalculate an order’s target done time (TDT) when the 
item with the longest prep time is started. Once the TDT is recalculated, the system will 
adjust all of the fire times for the remaining items (based on individual prep times) to ensure 
that all items are completed at the new TDT. Note: This option is limited to non-DOM mode 
with 'Single Item Per Suborder' (Devices-> Order Devices-> KDS-> Options) enabled. An 
[Order Started] button must also be programmed on the KDS toolbar or bump bar.

EMC-> Property level-> under Property Hardware header-> KDS Tool Bars-> Add an 
[Order Started] button to the tool bar. 

EMC-> Property level-> under Property Hardware header-> KDS Displays-> Display tab-> 
Select a KDS Chit Layout Style that includes CookTime. 

EMC-> Property Level-> Menu Item Maintenance-> Set menu item definitions to have a 
KDS Prep Time 

5711 ‘Item Started Border' is now supported

Added support for an 'Item Started' Border. This feature allows the KDS Display to 
show chits that have been started with a Blue colored border. This feature makes it 
easier for the kitchen to identify chits that have been started and to track their progress 
as they prepare an order. To use this feature, the [3 - Single Item Per Sub-Order]
option must be enabled. If this option is disabled, the items will not display with a 
Blue border. 

To enable the 'Single Item Per Sub-Order' option, navigate to EMC-> Revenue Center 
level-> under the RVC Information header-> Order Devices-> Options tab-> KDS Options-> 
and enable the [3 – Single Item Per Sub-Order] option. 

5713 KDS: 'New Item Notification' is now supported

Added support for ‘New Item Notification’. This feature will produce a sound to 
provide audible notification that an order is “New”, or a visual indication (flashing) 
where the order is toggled between normal and inverse colors for a configurable 
duration of time (in seconds). To enable this feature, navigate to EMC-> Revenue 
Center level-> under the RVC Information header-> Order Devices module-> KDS 
tab-> ‘Order Notification’ settings. The New Item Notification options are shown 
below: 

Order Devices-> KDS-> Order Notification settings
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Beep On New Order

From the Beep on New Order drop-down list, select the sound type that will be emitted when 
an order is received on this order device. If the WAV file option is selected, the system will 
use the default WAV file set for the operating system.

The choices for the ’Beep On New Order’ dropdown menu are as shown below: 

Order Devices-> KDS-> 'Beep On New Order' options

New Order Notification Timeout (sec.)

The Context Sensitive Help (CSH) text for this field is as follows: 

Use this value to determine the length of time in seconds that the newly added items will 
flash on the screen. Once this threshold is reached, items will display normally.

5716 'New Order Flash' Function has been added

This feature will produce a visual indicator that an order is "New". The New Order 
Flash function will cause new orders on the KDS Displays to flash, toggling the order 
between normal and inverse colors for a configurable duration of time (in seconds). To 
enable this functionality, navigate to: EMC-> Revenue Center level-> under RVC 
Information header-> Order Devices-> KDS tab 

Display New Order Notification

Order Devices-> KDS-> enable Display New Order Notification checkbox

The Context Sensitive Help (CSH) text for this field is as follows: 

Enable this option for new orders to flash when they appear on the KDS Display.

5720 'Expo Only Item Status' is now supported

Added support for Expo Only Item Status feature. This feature automatically changes 
the status color of Expo only items to the bumped color status. This allows users to 
easily determine which orders have a completed status at a glance. To enable this 
feature, navigate to EMC-> Property Level-> Setup tab-> under the 
Hardware/Interfaces header-> under the KDS sub-header-> KDS Controllers 
module-> option [4 – Expo-only Items Display as Done]. 

This option’s context sensitive help (CSH) reads as follows: 

When this option is enabled, any items displaying ONLY on the Expo display (not destined 
for a Prep device) will have the Item Status set to DONE immediately when fired.
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5722 “Fired” Flag has been added to set an order 'Started' status color

Added support for set status started color. The KDS Display System now allows the 
flagging of a menu item as 'preparing' on a local KDS display. When the item status 
is changed to 'Started', the item’s background color will change based on the 
configuration. This option works in conjunction with the existing 'Started Status 
Indicator', indicated by an open circle to the left of the menu item on the chit. The 
color and icon change will not affect any other Prep Stations, but will be reflected on 
Expo devices, to indicate that at least one Prep station is ‘preparing’ an item. Note that 
this feature will only function with KDS Prep stations, in non-Dynamic Order Mode 
(DOM), and with 'Item Started Timings' disabled, and thus, will not affect any item 
timings. Also, if no 'Start Color' is configured, only the status icon will be changed, 
but no background colors will change. 

To enable this feature, navigate to EMC-> Property Level-> under Property Hardware 
header-> KDS Controllers module-> Item Status Colors tab-> Set the Item Status Colors 
according to site specifications 

5725 'Outside/Inside Expo' is now supported

Added support for Outside and Inside Expo stations. This feature allows An Expo 
Station to be configured to not bump a sub-order when it is bumped on another Expo 
station. This feature streamlines kitchen operations by allowing a site to configure and 
manage multiple expediter stations. This will improve speed of service and increase 
guest satisfaction. To enable this feature, navigate to EMC-> Revenue Center level-> 
under RVC Information header-> Order Devices module-> Options tab-> KDS 
Options-> and enable the [16 – Expo Done Exempt] option. 

This options Context Sensitive Help (CSH) reads as follows: 

Enable this option to configure an Expo Station to NOT done a sub-order when it is done on 
another Expo station.

5727 'Recall/Review List Styles' is now supported

Previously, information displayed in the Recall or Review List Dialogs were populated 
with a Check #, Table #, RVC and Time (Done Time) with fixed data and column 
widths. Added support that now allows the Recall or Review List Dialogs to be 
configurable with up to 6 columns, with any of 9 specific types of data, and 
configurable widths. To configure this feature, navigate to the EMC-> Property level-> 
under Property Hardware header-> KDS Displays module-> Recall/Review List tab. 

5730 'Item Highlight' is now supported

Added support for the KDS 'Item Highlight' function. This feature will allow the user 
the ability to bump or mark single items in Chit or List mode without using the 'Single 
Item Per Sub-Order' option. This feature works in Dynamic Order Mode (DOM). 

To configure this feature, navigate to: EMC-> Property level-> under Property Hardware 
header-> KDS Display module-> General tab-> enable the [1 – Enable Item Select] option. 

This option’s Context Sensitive Help (CSH) reads as follows: 

Enable this option to select an item on the chit. Once the item is “Item Selected”, the 
selected items can be set as “Item Prep Done” and hidden from the display. It can also be 
“Item Marked” and displayed with a different background color.
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Also access the EMC-> Property level-> under the Hardware/Interfaces header-> under the 
KDS sub header-> KDS Tool Bar module-> and add the desired functions related to an Item 
– Select Next Item, Select Previous Item, Done Item, Recall Item or Mark Item.

5732 'Course Timing' is now supported

Added support for the 'Course Timing' functionality. This feature is used in table 
service restaurants as a way to control the order in which menu items are prepared and 
served during a meal. Course preparation times (minimum and maximum) can also be 
specified using this feature. Maximum prep times ensure that the next course of items 
is sent to the kitchen, in the event that the KDS operator fails to bump the current 
course selections. Minimum prep times are generally not used unless the system is also 
programmed for item timings. Otherwise, the minimum prep times simply extend the 
maximum number of minutes that the system will wait before sending the next course, 
if the current course is not bumped from the KDS Display. 

To enable this functionality, navigate to and configure the following settings: 

EMC-> Revenue Center level-> under RVC Information header-> RVC Parameters 
module-> Options tab-> option [50 – Enable Dynamic Order Mode (DOM)] – verify that 
this option is DISABLED. 

EMC-> Revenue Center level-> under RVC Information header-> Order Devices module-> 
Options tab-> KDS Options-> enable options [3 – Single Item Per Sub-Order] and [17 – 
Print Course Header]. 

EMC-> Property level -> under Property Hardware header-> KDS Controller-> General 
tab-> set the 'Wait for Prep Suborder' setting to = 2. 

EMC-> Property level-> under Property Hardware header-> KDS Controller-> General tab-> 
enable the [2 – Display Next Course after Previous Course Complete] option. 

EMC-> Any level-> Descriptors tab-> under the Groups header-> Dining Courses module-> 
Set a 'Min and Max Prep Time' for each course. 

EMC-> Revenue Center level-> under the Menu Items header-> Menu Item Classes 
module-> Options tab-> enable the [45 – Use KDS Course Number] option. 

EMC-> Revenue Center level-> under the Menu Items header-> Menu Item Classes 
module-> General tab-> set the 'KDS Course'. 

5735 'Routing by Order Type' is now supported

Added functionality to allow orders to be routed to specific order devices depending 
on what their Order Type is. 

To enable this functionality, navigate to: EMC-> Revenue Center Level-> under the RVC 
Information header-> RVC Parameters module-> Order Types tab-> General Options-> [8 - 
Enable Routing Order by Order Type]

This option's Context Sensitive Help (CSH) reads as follows: 

Select this option to control order routing by the order type. The workstation order devices 
must be set for all possiblities and use this as an override to disable order devices.

If this option is enabled, the order will be routed using the Order Types' Order Device 
settings. 
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Order Device Output-> enable the order devices to print to based on the order type. 

The options to configure the Order Device output for a specific Order Type are shown 
below: 

'RVC Parameters-> Order Types tab-> [ Enable Routing Order by Order Type]'

Mobile Micros

1616 'DT Research 430' and 'Motorola MC55A' Mobile MICROS Handhelds (MMH) are 
now supported

Support for both of these handheld devices has been added. There are a number of 
similarities between these handhelds as shown below: 

◾ Both devices run Windows CE 6.0. 
◾ The Processor types of both devices are ARMV4I 
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◾ Both devices support Mag Cards, Barcode Scanners and Bluetooth Printing 
◾ Each device now supports 'Signature Capture' for Credit Card (CC) transactions 
◾ The 'DT Research 430' MMH has a screen resolution of 272 x 480. Therefore, this 

resolution setting is also available for all other MMH devices. 

See the Mobile MICROS article (specifically the MMH's supported in Simphony v1.6
section) for more information. 

MyMicros

1673 A new version of mymicros.net v7.1.0 has been incorporated into Simphony v1.6.

Support for upgrading the mymicros.net database has been introduced. 

Offline Labor Cache

1493, 
6512 

The Offline Labor Cache and the Offline Transaction Cache can now be configured 
separately and are supported on Service Hosts

On previous versions of Simphony v1.x, when a Workstation was programmed as the 
Offline Cache Service Host, its two primary functions were to act as both the Offline 
Labor Cache (OLC) and the Offline Transaction Cache (OTC). This release (v1.6) 
separates those functions (from the Ops clients too) so that the OLC and OTC can 
communicate separately to the Enterprise. 

The following changes have been made: 

◾ Changes were made to the EMC to allow users to configure the OLC and the OTC to 
run on different Service Hosts. 

◾ The OLC can be configured to run on either a Service Host or a Workstation. 
◾ The OLC has been removed from Ops and there is a now an OLC Handler Service 

value in the ServiceHost.xml. 
◾ The OLC Handler runs on a Service Host as an EGateway Handler using IIS. 
◾ The OLC should run at the Property level. 
◾ The OTC still requires Ops to run. 

See the Offline Cache Service Host article (specifically the 'Simphony v1.6' section) for 
more information.) 

30607 

Security

2302 The ‘Key Manager’ utility has been updated to incorporate a new Key Rotation scheme

With this release, a new Key Rotation scheme will be in use. The SDATA1 and 
SDATA2 databases will no longer be used. The keys and passphrase will now be 
stored in MCRSCACHE. During an upgrade to Simphony v1.6, the Key Manager tool 
will be automatically run. 

It will perform the following operations: 

◾ Create the new key DB schema (in MCRSCACHE) 
◾ Extract the encryption keys and passphrase from SDATAs (if they were formerly in 

use). 

In order to run the Key Rotation, access the EMC (Enterprise level)-> Tasks-> ‘Key 
Manager’ utility to change the passphrase and perform a Key Rotation. 
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Note: Users need to have the old passphrase in order to 
perform a Key Rotation from EMC. If they’re coming from a 
system that did not use the SDATA databases, the default 
passphrase is DEFSIMP1.0. 

Warning: Prior to performing an upgrade from an earlier 
application version (e.g., from Simphony v1.5 to Simphony 
v1.6) or running the Key Manager Tool, it is strongly
recommended that: 

- All existing Credit Card records have been batched and settled. 

- The existing database has been backed up. 

- It is also recommended that all open checks be closed before 
performing the upgrade. 

See the Key Manager article for more information. 

Revisions 

Fix ID Revision CR #

Autofire

10133 Issue: When an Autofire order fired to the output devices, the 'Guest Count' value was 
always '0' on the order chits 

32291 

Resolution: Previously, in prior versions of Simphony 1.5, when the Autofire feature was 
in use, the Guest Count value that was printed on order device chits was always 
'0'. When an Autofire check was started, users would be prompted to input the 
number of guests, which correctly printed on the Guest Check. This has been 
corrected by modifying the PosLib.lib. Currently, Autofire order device chits 
print the correct number of guests that were originally entered when the order 
was placed. 

CAL

5891 Issue: A Win32 CAL client did not allow for the selection of KDS displays 28818 

Resolution: Previously, Win32 CAL clients only allowed users to select a Workstation or 
Service Host. This meant that the only way to get a KDS display working on a 
Win32 client was to copy the files manually or to configure the client as a KDS 
Controller, thereby downloading the KDS Display files. This has been 
corrected by modifying the Win32 CAL package. Currently, a Win32 Service 
Host can be configured to receive a KDS display package in CAL Packages. 
After the package has been installed, the KDS Display can be started and have 
orders sent to it from Property workstations. 

9570 Issue: The KDSDisplay.exe would not successfully start after upgrading to Simphony 
v1.6 

Resolution: Previously, after upgrading to Simphony v1.6, the KDSDisplay.exe would not 
successfully start and displayed the following message on the KDS Restaurant 
Display Controller (RDC): 

'Error: This application (KDSDisplay.exe) requires a newer version of the 
Microsoft .NET Compact Framework then the version installed on this 
device.'
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It’s been determined that in order to resolve this reported issue, users are 
required to manually update the KDS RDC to .NET Compact Framework 2.0 
in order to run KDS v2.1. Moving forward, consider this .NET upgrade as a 
pre-requisite for future Simphony v1.6 upgrades for existing Simphony v1.x 
KDS installations. See the Upgrading a Restaurant Display Controller (RDC) 
for KDS v2.1 article for more information. 

Credit Card Driver

6319 Issue: The backup Credit Card (CC) Authorization driver was not being used when 
the Primary CC Authorization service was unavailable 

28171 

Resolution: Previously, the configured backup CC Authorization driver was not performing 
as expected. This has been corrected by modifying the PosLib.lib file. 

The Ops CC Authorization process should perform as follows: 

1. If the primary CC driver fails, but the backup driver works, Ops starts a
timer and at that point begins trying the backup CC driver first. The Ops
log will contain the message, 'CCs Client connecting to secondary
credit card server'.

2. After 10 minutes (actually the next time an authorization is attempted or
after 10 minutes), the flags are reset and the primary CC driver is tried
first. If the primary CC driver is still not available, the process repeats.
When a driver fails there is a noticeable delay for it to time out, but if the
driver is up and running, there’s no timeout delay. When Ops goes back
to try the primary CC driver the Ops log will contain the message, 'CCs
Client re-attempting to connect to primary credit card server'.

3. If the backup CC driver is currently being used and it subsequently fails,
the primary CC driver will be tried before failing.

4. If neither CC driver works, the flags are reset to try using the primary
CC driver first.

5. Since these settings are all internal to Ops, resetting Ops reinitializes the
process to try using the primary CC driver first.

For CC settlement, the primary CC driver is attempted first and if it fails, the 
secondary CC driver is tried. If another CC settlement is performed, again the 
primary CC driver is attempted first. 

10377 Issue: CAPMS: The BX_REQ message was not conforming to the documented 
messaging specifications during Credit Card Settlement 

32341 

Resolution: Previously, upon using the CAPMS Credit Card (CC) Driver, the CC Batch 
Settlement transfer request messaging (BX_REQ) was incorrectly populating 
the 'Guest Check Number' field with a truncated 'CheckID' value. This has 
been corrected by modifying the ECCServer and CGwCc.xml. Currently; the 
Guest Check Number is correctly supplied in the BX_REQ message instead of 
the truncated CheckID value. 

Database

8461 Issue: DBUpgrade: Existence checks in Oracle® used "all" views; should use "user" 
views instead 

32050 

Resolution: Previously, an existence check in the DbUpgrade script used the "all" tables 
(for example, all_indexes or all_sequences). In multi-tenanted instances, some 
objects would not get created because their existence in another schema would 
be detected by DbUpgrade. This has been corrected by modifying the 
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DbUpgrade.xml. Currently, a DbUpgrade can be run without error on the 
Oracle® database platform. 

Direct Posting Service

6663 Issue: Check Posting was notably slower when 'OraDbHelper' was being utilized 30747 

Resolution: Previously, on larger databases and for those sites utilizing OraDbHelper, 
check posting was slower than expected. Upon further investigation, it was 
revealed that we were no longer using the businessdate information in indices; 
it appears that we use datetime objects in our code which had been previously 
handled by the Microsoft provider incorrectly as just date values. The new 
provider was parsing them as timestamps, which could not be used with the 
index. Now, OraDbHelper explicitly uses OracleDbType.Date with date type 
parameters. 

6804 Issue: 'Tax Exempt' amounts were posting as 'Charged Tip' amounts on mymicros.net 
reports 

29184 

Resolution: Previously, when the Tender Media-> Options-> Taxing Options-> Payment 
Tax Options-> [14 -Tax Exempt Coupon] option was enabled and a 'Charge 
Tip' was configured too, the mymicros.net Check Detail displayed the amount 
of the 'Tax Exemption' as the 'Charged Tip' amount. This has been corrected by 
modifying the DirectPostingService.exe. 

7309 Issue: Unexpected behavior occurred when adding a Service Charge to a check after 
reopening it 

31826 

Resolution: Previously, a reopened check with a Voided payment that had a prior Auto-
Service Charge applied to it and then had another Service Charge added and 
then was tendered (closed) again; on the Audit & Analysis Transaction Detail 
report, the Auto-Service Charge line displayed as Check Number '0'. This has 
been corrected by modifying the DirectPostingService.exe. 

10504 Issue: The ‘MaxRetryErrCount’ value in the ‘DirectPostingService.exe.config’ was 
ignored, thus the default of 50 retries was always used 

32359 

Resolution: In Simphony v1.5 MR 5 Hot Fix (HF) 5, several changes to the DPS were 
introduced, one of which was a maximum number of times to retry posting a 
record. The 'DirectPostingService.exe.config' file was created or updated with 
the HF and a line was added to define the maximum error count; with a default 
setting of 50 retry attempts. If the 'MaxRetryErrCount' value was changed to 
anything greater than or less than 50, it still resulted in only 50 tries. This has 
been corrected by modifying the 'DirectPostingService.exe' to utilize the 
configured ‘MaxRetryErrCount’ value upon reading the 
‘DirectPostingService.exe.config’ file. 

11133 Issue: The ‘posTransRef’ column was no longer populated in the 
GUEST_CHECK_LINE_ITEM table when the line item was a Discount 

32444 

Resolution: In the GUEST_CHECK_LINE_ITEM table, there is a column called 
'posTransRef' which should be populated with various object numbers from 
the POS system. For Discounts, this is the object number in the EMC. Prior to 
upgrading to Simphony v1.5 MR 5, this field was successfully populated. After 
upgrading, this field was no longer populated. The 'recordID' column was still 
populated and allowed the unique Discount to be mapped to that line item, but 
not the ‘posTransRef’ column. This has been corrected by modifying the 
DirectPostingService.exe to set the guest check line item ‘posRef’ to a 
Discount’s object number. 

11134 Issue: Tax 2 through Tax 8 amounts in the GUEST_CHECK_LINE_ITEM table, 
posted the entire check's discounted taxes for each line item with a Discount 

32451 
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Resolution: Previously, in Simphony v1.5 MR5, changes were made to the Direct Posting 
Service (DPS) to post Inclusive tax amounts that were prorated for each line 
item. This displayed correctly for menu items, but had mixed results when a 
line item was a Discount that also discounted the tax. When only Tax Rate 1 
was in use in the tax class used for the items, and a discount applied to those 
items, the prorated tax amounts would display correctly. When Tax Rates 2-8 
(or a combination including any or all of Tax Rates 2-8) were used, those 
discounted tax amounts would show the amount equal to the entire check on 
each line item that received the discount. This has been corrected by modifying 
the DirectPostingService.exe to prorate taxes for all 8 Tax Rates. This solution 
also includes a fix for a rounding error caused by tax proration. 

11321 Issue: It’s been determined that the reporting database was using too many 
Transaction ID values in multiple tables which could eventually affect system 
totals posting performance 

28750 

Resolution: Previously, at site’s utilizing Oracle® for their mymicros.net database 
platform, many of the totals and check tables in the mymicros.net database had 
a 'transactionID' column. For the mymicros.net posting server, this was used 
to identify an emailed result set, so it could be backed out later. For 
compatibility, the Direct Posting Service (DPS) also set this column, 
generating the numbers the same way as the posting server; doing it every time 
DPS ran. DPS also used up one number for every Property in the Enterprise 
every time it ran. This could eventually cause the ‘transactionID’ values to 
wrap around to negative numbers, since this value was only a 32-bit integer. 
This has been corrected (for Oracle® mymicros.net installations only) by 
modifying the DirectPostingService.exe to support 64-bit integers. 

EGateway

10244 Issue: After an upgrade, newly added Employees were unable to Clock In and 
received either of two error messages 

32292 

Resolution: Previously, when an Enterprise upgraded the Simphony Application servers to 
v1.5 MR 5, but left the Ops clients on an earlier version (for example v1.5 MR 
4) the Workstations were able to operate normally, but only for any previously
existing employees. If an employee that was added after the upgrade attempted 
to Clock In, that employee would receive an Unspecified Gateway Error
message if they were added to the EMC using an existing Employee as a 
template. If the new Employee was added without the use of a template, upon 
attempting to Clock In, they’d receive an Employee class definition not
found message. It was determined that the errors were caused by changed error 
codes. The solution was to rollback the changes, and change the Ops.exe to 
understand both the original error codes and the changed error codes. 

EMC

6985 Issue: For Oracle® sites, when Remote Distributing a large number of menu items, it 
was possible to receive an 'ORA-01460: unimplemented or unreasonable 
conversion requested' error message 

31410 

Resolution: Previously, when attempting to Remote Distribute up to 1000 menu items, 
users could receive the aforementioned Oracle® error message. This has been 
corrected by modifying the EMC.exe. 

9586 Issue: Remote Distribute failed and displayed a 'EMC EXCEPTION: 
SendSyncRequest returned with error code: RC_COMM_ERROR'
message 

32202 

Resolution: After upgrading to Simphony v1.5 MR5, Remote Distribution no longer 
successfully completed. The items to be distributed could be selected and the 
target destination could be selected, but once the distribution began, it 
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displayed an error message. This has been corrected by modifying the 
EMC.exe. With this release, Remote Distribute is performing as expected. 

10594 Issue: Remote Distribution of Menu Item (MI) Definitions was not working as 
expected after deploying Simphony v1.5 MR5 Hot Fix (HF)6 

32375 

Resolution: Previously, after deploying Simphony v1.5 MR5 HF6, users were unable to 
Remote Distribute specific MI Definitions either individually or attached to a 
MI Master record. With this release, this reported issue has not been 
reproducible. 

10646 Issue: SRM: Tender Media option [84 – Quebec SRM Duplicate] had its Context 
Sensitive Help (CSH) text modified 

Resolution: It was recommended to edit the CSH for the option located along the following 
path: EMC-> Configuration tab-> Sales-> Tender Media-> option [84 - 
Quebec SRM Duplicate]. There needed to be a stronger warning to prevent 
users from enabling this option for every Tender Media, thus causing SRM 
Device reporting issues. 

The current CSH text reads as follows; 

Enable this option for this tender to print a receipt that the merchant keeps for 
themselves, and does not include a barcode. DO NOT enable for Key Type 
'Payment'; ONLY use for Key Type 'Service Total'. This should be associated 
with a separate tender media that is exclusively used for printing merchant 
copies. This option bit is used alongside Quebec SRM Printer type.

Install

6499 Issue: Install was not completely installing the mymicros.net shell database 30466 

Resolution: Previously, the Install was not successfully completing the installation of the 
mymicros.net shell database. This has been corrected with the addition of the 
mymicros.net v7.1.0 installer with this release. 

6963 Issue: For installations on Windows Server® 2008 R2, IIS v7.5 Application Pool 
privileges were not getting set correctly 

31431 

Resolution: Previously, the default web site was not being created by the NETWORK 
SERVER user anymore. This has been corrected by modifying the Installer to 
set the correct IIS Application Pool privileges. Additionally, the Registry 
permissions on the UserData key were adjusted to allow the 'Network Service' 
to have full permissions on the key. 

7075 Issue: When installing on Oracle®, the username and password were displayed in 
plain text 

29990 

Resolution: Previously, when installing on an Oracle® database platform, both the 'System 
Admin' user name and password were displayed in plain text on the screen as 
well as the SimphonyInstallLog file. This has been corrected by modifying the 
Oracle® database installation scripts. 

7081 Issue: For installations on 64-bit Operating Systems, when using the Import/Export 
(Imp/Exp) utility, the 'SiSecurity64.dll' was missing from multiple required 
installation folders 

31484 

Resolution: Previously, when using the Imp/Exp utility on a 64-bit machine, users received 
a 'Error - Unable to load DLL 'SiSecurity64.dll': The specified module 
could not be found.' message. This has been corrected by modifying the 
EGateway package for Win32 Clients. 
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7823 Issue: The 64-bit Installer didn't install the required components during a clean install 32000 

Resolution: Previously, during a clean install of Simphony v1.5 MR5 on a Windows 
Server® 2008 R2 Operating System using an Oracle® database platform, the 
response file was missing key Oracle® components that prevented the product 
from being installed. The missing components were SQLPLUS, IMP, 
TNSPING. 

This has been corrected by modifying the Installer for 64-bit Operating 
Systems. 

9765 Issue: The EGateway failed to load the CAPMS CC driver on machines running 
Windows Server® 2008 32-bit as a Service Host 

32239 

Resolution: Previously, when a machine running the Windows Server® 2008 32-bit 
Operating System was used as a Service Host, CAL could be loaded and would 
pull down the appropriate packages. The Gateway would seem to be running, 
and could be connected to from other machines, however the CAPMS Credit 
Card (CC) driver, if configured, would not start and errors were present in the 
EGateway log of the Service Host. Currently, this reported issue cannot be 
reproduced. A CAL deployment that worked for a Windows Server® 2003 32-
bit machine has fully functional CAPMS CC’s on a Windows Server® 2008 
32-bit machine. The EGateway was deployed as well as the KDS handler files. 
A CC transaction could be run from a Workstation and sent to the Service 
Host. The transaction closed normally on the Workstation. CC Batching also 
worked when the Service Host accepted the batch. 

KDS

6861 Issue: Intermittently, some Suborders would not show up on certain KDS Displays 31157 

Resolution: Previously, on occasion, some Suborders would not show up on certain KDS 
Displays. With this release and the reworking of the KDS feature, this reported 
issue has not been reproducible. 

MyInventory

6940 Issue: It was requested to update the MyInventory daily job to update the 
'latestDefinitions' column in the 'location_hierarchy_item' table 

29627 

Resolution: Previously, when mymicros.net tried to run its inventory jobs for Simphony 
sites, it continually reflagged the jobs with a status to repost every hour. The 
reason that this occurred was because mymicros.net waited for the definitions 
flag prior to running the job. This has been corrected by modifying the 
NewDTS.exe. 

7176 Issue: The MyInventory cost changes were not used in the calculation of the 'Daily 
Cost of Goods' report from the Direct Posting Service (DPS) and the New 
Data Transfer Service (NewDTS) 

30257 

Resolution: Previously, the NewDTS did not post the prep cost for MyInventory properties; 
the DPS read the prep cost from directly from the mymicros.net database. This 
has been corrected by modifying the DirectPostingService.exe and 
NewDTS.exe. 

MyMicros

6595 Issue: The 'Error Correct' totals drilldown on the 'Adjustments Report' was not 
working as expected 

28874 

Resolution: Previously, the drilldown capability on the 'Error Correct' totals in the 
'Adjustments Report' returned no data. This has been corrected by modifying 
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the DirectPostingService.exe. Currently, all applicable ‘Error Correct’ 
adjustments (i.e. Returns, Voids, Error Corrects and Cancels) display on the 
report as expected. 

6679 Issue: The Drill down totals from the 'Daily' and 'Today’s Ops' Sales/Service 
Performance Summary reports did not balance to the prior page 

28917 

Resolution: Previously, this reported issue was believed to be based upon the Simphony 
Serving Periods being written to the mymicros.net Day_Part database table. 
With this release and with the reworking of the mymicros.net database (now 
running v7.1.0); this reported issue has not been reproducible. 

6682 Issue: When upgrading mymicros.net from v5.22 to v6.22 an error message was 
received that indicated that the ‘ORGANIZATIONID "100"’ and 
‘REPORTCATEGORYID "21"’ entries were not present in the Simphony 
Sample PortalDB. 

31034 

Resolution: Previously, the mymicros.net upgrade would fail without the aforementioned 
entries in the PortalDB. This has been corrected by modifying the 
mymicros.net installer. 

7016 Issue: The Standard Export failed due to a NULL ‘businessDates’ column in the 
GUEST_CHECK_HIST table 

29826 

Resolution: Previously, when the MoveHistory job ran, it created a copy of all of the open 
checks in the GUEST_CHECK_HIST table in addition to completely moving 
the closed ones. This caused the Standard Export to fail. This has been 
corrected by modifying mymicros.net. With this release, the updated version of 
mymicros.net is available (v7.1.0). 

7140 Issue: mymicros.net reports were showing incorrect values for the Day Parts 27706 

Resolution: Previously, issues that seemed to be related to Serving Period changes in 
Simphony were causing incorrect values for the Day Parts to display on 
mymicros.net reports. This has been corrected by modifying the reports in 
mymicros.net v7.1.0. With this release, the mymicros.net version will be 
upgraded to v7.1.0. 

Ops

7129 Issue: When a Workstation (WS) had Offline transactions, and a second WS tried to 
pick up one of those transactions while the first WS was in the process of 
coming back Online, the Offline Replay got hung up and displayed an 
'Uploading 0%' message 

31544 

Resolution: Previously, the aforementioned message would display on the second WS until 
it was rebooted. This has been corrected by modifying the PosLib.lib. 
Currently, the secondary WS does not display the ‘Uploading 0%’ message as 
the check is either picked up correctly from the peer or, if closed offline, 
correctly displays the 'Check is already Closed' message. Additionally, no 
‘dead’ check headers are now left in the Open Check Screen Lookup (SLU) 
after these actions. 

7145 Issue: The wrong employee's name was printing on Autofire Guest Checks 31579 

Resolution: Previously, Autofire checks printed with the name of the employee currently 
signed onto the Autofire Workstation, not the employee who created the check. 
This has been corrected by modifying the PosLib.dll. 

7221 Issue: Tax Exempt Coupons did not calculate correctly with Canadian GST and PST 
taxes and Compound Rates 

31683 

Resolution: Previously, Tax Exempt transactions were not calculating correctly for sites 
utilizing Canadian GST and PST taxes in tandem with Compound Rates. This 
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has been corrected. Currently, when using Canadian Tax with GST and PST, 
where Tax Rate 2 compounds on Tax Rate 1, tax is now being calculated 
correctly on checks with Tax Exempt coupon tenders. When the Tax Exempt 
coupon tender pays the full amount of the check, 100% of the taxes are 
forgiven. If only a portion of a check is paid with the Tax Exempt coupon 
tender, only a portion of the taxes are forgiven. 

7316 Issue: Performing a [63 – Transaction Void] on a negative transaction with a Stored 
Value Card (SVC) function caused SAR to close unexpectedly 

30442 

Resolution: Previously, from a SAR client when there was a negative transaction and a 
'Transaction Void' with a SVC function, users received a 'Application 
SarOpsCE.exe encountered a serious error and must shut down.' message 
and SAR crashed. This has been corrected by modifying the PosLib.lib. 
Currently, the reported scenario does not crash SarOps. 

7899 Issue: Tips Paid validation chits were not printing the name of the Employee who 
received the tip 

31932 

Resolution: Previously, when a Tips Paid Tender Media was configured to require a 
validation chit to print, it printed, but the Employee’s name and Employee 
number was not printed. This has been corrected by modifying the PosLib.dll. 
Currently, the Tips Paid validation chits are correctly displaying the 
Employee’s name (who received the tip) as well as their Employee number. 

8083 Issue: SarOps exited when trying to pick up a check with a menu item with a percent 
symbol (%) in the 'Name1' field 

Resolution: Previously, in Simphony v1.5 MR5, a menu item with a percent symbol (%) in 
its MI Definition 'Name1' field would cause SarOps to exit without error when 
trying to perform a pickup check function on a check that contained that menu 
item. This was seen to only happen when a SarOps Log file’s verbosity setting 
was set to 6 or higher (where SRM check detail logging takes place). Setting 
the SarOps log file’s verbosity to a setting of 5 or lower allowed the check to 
be picked up normally without crashing SarOps. 

PMC Reports

7897 Issue: The PMC Tip Report could show an incorrect Revenue Center (RVC) 31934 

Resolution: Previously, when configuring 'Workstation Autosequences', certain options 
were available depending on the previous configuration selections. With the 
'View' set to 'Property', it should not be possible to select a RVC. This was 
behaving correctly in 'Table View', where 'Revenue Center' was grayed out. 
However, when the 'Configure' button was selected to open 'Form View', the 
Revenue Center drop down was available, which was incorrect. If a RVC was 
selected, then each time this report was run, it would always generate for that 
RVC as opposed to the signed in Employee's current RVC. This has been 
corrected by modifying the EMC.exe. Currently, the PMC Tip Report displays 
the correct RVC when it’s selected or is included amongst the 'ALL' selection 
of the RVC’s when the Tip Report is run for a Property. 

Printing

8844 Issue: Guest Checks and Customer Receipts had more blank Trailer lines than 
expected which caused the use of more printer paper 

32308 

Resolution: Previously, particularly for site’s utilizing the Sales Recording Module (SRM) 
feature, Guest Checks and Customer Receipts were too long because they were 
also printing the combined number of blank Guest Check and Canadian Tax 
Trailer lines. This has been corrected by modifying the PosLib.lib file. 
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Additionally, there a few roll printer printing options throughout the EMC that 
can affect Guest Check and Customer Receipt receipt length. 

The applicable printing output options are shown below: 

◾ EMC-> Revenue Center-> RVC Information-> RVC Parameters-> 
Format-> Print Output-> [Minimum Lines Per Roll Check/Receipt]. 
◾ This field allows users to establish the minimum length for printed 

Check/Receipt output. 

◾ EMC-> Revenue Center-> RVC Information-> RVC Parameters-> 
Format-> Format Options-> [6 – Eliminate Blank Lines from Guest 
Checks]. 
◾ It’s recommended to enable this option to reduce printed output 

length. 

◾ EMC-> Revenue Center-> RVC Information-> RVC Parameters-> 
Format-> Format Options-> [24 - Skip Blank Lines When Print or 
Display Guest Check Info Lines]. 
◾ It’s recommended to enable this option to reduce printed output 

length. 
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